


Introduction (English)
This Concise User’s Guide introduces the main features
of your computer. The English version of this guide be-
gins on page 1. The expanded User’s Manual is on the
Device Drivers & Utilities + User’s Manual disc.

Einführung (Deutsch)
Dieses Ausführliche Benutzerhandbuch führt Sie in die
Hauptfunktionen des Computers ein. Die deutsche Ver-
sion des Handbuchs beginnt auf Seite 29. Das erweiterte
Benutzerhandbuch finden Sie auf der Disc für die Gerä-
tetreiber und Hilfsprogramme (Disc Device Drivers &
Utilities + User's Manual).

Présentation (Français)
Ce Guide Utilisateur Concis présente les fonctionnalités
principales de votre ordinateur. La version française de
ce guide commence à la page 57. Le Manuel de l'Utilisa-
teur étendu se trouve sur le disque de Pilotes & Utili-
taires + Manuel de l'Utilisateur (disque Device Drivers
& Utilities + User's Manual).

Introducción (Español)
Esta Guía del Usuario Concisa le presenta las caracterís-
ticas principales de su ordenador. La versión española de
esta guía comienza en la página 85. El Manual del usua-
rio completo se encuentra en el disco de Controladores
del dispositivo y Utilidades + Manual del usuario (disco
Device Drivers & Utilities + User's Manual).

Introduzione (Italiano)
La presente Guida Rapida per l'Utente introduce le carat-
teristiche principali del computer. La versione italiana di
questa guida inizia da pagina 113. Il Manuale utente
completo si trova nel disco contenente driver e utilità +
Manuale utente (disco Device Drivers & Utilities +
User's Manual).
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About this Concise User Guide
This quick guide is a brief introduction to getting your system started. This is a supplement, and not a substitute for the
expanded English language User’s Manual in Adobe Acrobat format on the Device Drivers & Utilities + User’s Manual
disc supplied with your computer. This disc also contains the drivers and utilities necessary for the proper operation of
the computer (Note: The company reserves the right to revise this publication or to change its contents without notice).

Some or all of the computer’s features may already have been setup. If they aren’t, or you are planning to re-configure
(or re-install) portions of the system, refer to the expanded User’s Manual. The Device Drivers & Utilities + User’s
Manual disc does not contain an operating system.

Regulatory and Safety Information
Please pay careful attention to the full regulatory notices and safety information contained in the expanded User’s Man-
ual on the Device Drivers & Utilities + User’s Manual disc.

©August 2012

Trademarks
Intel  and Intel Core are trademarks/registered trademarks of Intel Corporation.


FCC Statement

This device complies with Part
15 of the FCC Rules. Operation
is subject to the following two
conditions: 

1. This device may not cause
harmful interference. 

2. This device must accept any
interference received, includ-
ing interference that may
cause undesired operation.
 1
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Instructions for Care and Oper-
ation
The computer is quite rugged, but it can be damaged. To
prevent this, follow these suggestions:

• Don’t drop it, or expose it to shock. If the computer falls, the 
case and the components could be damaged.

• Keep it dry, and don’t overheat it. Keep the computer and 
power supply away from any kind of heating element. This is an 
electrical appliance. If water or any other liquid gets into it, the 
computer could be badly damaged.

• Avoid interference. Keep the computer away from high capacity 
transformers, electric motors, and other strong magnetic fields. 
These can hinder proper performance and damage your data.

• Follow the proper working procedures for the computer. Shut 
the computer down properly and don’t forget to save your work. 
Remember to periodically save your data as data may be lost if 
the battery is depleted.

• Note that in computer’s featuring a raised LCD electro-plated 
logo, the logo is covered by a protective adhesive. Due to general 
wear and tear, this adhesive may deteriorate over time and the 
exposed logo may develop sharp edges. Be careful when handling 
the computer in this case, and avoid touching the raised LCD 
electro-plated logo. If any such wear and tear develops contact 
your service center.

Power & Battery Safety
• Only use an AC/DC adapter approved for use with this computer.
• Use only the power cord and batteries indicated in this manual. 
• Your AC/DC adapter may be designed for international travel but 

it still requires a steady, uninterrupted power supply. If you are 
unsure of your local power specifications, consult your service 
representative or local power company.

• The AC/DC adapter may have either a 2-prong or a 3-prong 
grounded plug. The third prong is an important safety feature; do 
not defeat its purpose. If you do not have access to a compatible 
outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it 
by the plug head, not by its wire.

• Make sure the socket and any extension cord(s) you use can sup-
port the total current load of all the connected devices.

• Only use batteries designed for this computer. The wrong battery 
type may explode, leak or damage the computer.

• Do not continue to use a battery that has been dropped, or that 
appears damaged (e.g. bent or twisted) in any way. Even if the 
computer continues to work with a damaged battery in place, it 
may cause circuit damage, which may possibly result in fire.

• Recharge the batteries using the computer’s system. Incorrect 
recharging may make the battery explode.

• Do not try to repair a battery pack. Refer any battery pack repair 
or replacement to your service representative or qualified service 
personnel.

• Keep children away from, and promptly dispose of a damaged 
battery. Always dispose of batteries carefully. Batteries may 
explode or leak if exposed to fire, or improperly handled or dis-
carded.

• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not dispose of batteries in a fire. They may explode. Check 

with local codes for possible special disposal instructions.
• Do not touch the battery contacts with your hands or metal 

objects.
2 
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Polymer Battery Precautions
Note the following information which is specific to poly-
mer batteries only, and where applicable, this overrides
the general battery precaution information.

• Polymer batteries may experience a slight expansion or swelling, 
however this is part of the battery’s safety mechanism and is not a 
cause for concern.

• Use proper handling procedures when using polymer batteries. 
Do not use polymer batteries in high ambient temperature envi-
ronments, and do not store unused batteries for extended periods.

Cleaning
• Use a soft clean cloth to clean the computer, but do not apply 

cleaner directly to the computer.
• Do not use volatile (petroleum distillates) or abrasive cleaners on 

any part of the computer.
• Before cleaning the computer remove the battery and make sure 

the computer is disconnected from any external power supplies, 
peripherals and cables (including telephone lines).

Servicing
Attempting to service the computer yourself may violate
your warranty and expose you and the computer to electric
shock. Refer all servicing to qualified service personnel,
particularly under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to any liquids.
• If the computer does not work normally when you follow the 

operating instructions.
• If the computer has been dropped or damaged (do not touch the 

poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your com-

puter.


Battery Disposal & Caution

The product that you have purchased contains a recharge-
able battery. The battery is recyclable. At the end of its use-
ful life, under various state and local laws, it may be illegal
to dispose of this battery into the municipal waste stream.
Check with your local solid waste officials for details in your
area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Re-
place only with the same or equivalent type recommended
by the manufacturer. Discard used battery according to the
manufacturer’s instructions.
3
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System Startup
1. Remove all packing materials.

2. Place the computer on a stable surface.

3. Securely attach any peripherals you want to use with the computer (e.g. keyboard and mouse) to their ports.

4. Attach the AC/DC adapter to the DC-In jack at the rear of  the LCD, then plug the AC power cord into an outlet, and connect the AC 
power cord to the AC/DC adapter.

5. Push the power button at the front of the computer to turn the computer “on”.

Figure 1 - Computer with AC/DC Adapter Plugged-In/Power Button

System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-
configuring your computer for a different system, you will find this manual refers to Microsoft Windows 7.


Shut Down

Note that you should always shut your computer down
by choosing Shut Down from the Start Menu.

This will help prevent hard disk or system problems.

Power Button
4
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System Map: Front View

Figura 2 - Front View

1. Microphone

2. PC Camera (Optional)

3. PC Camera LED

4. LCD

5. Power Button

6. Function Buttons

7. LED Indicators

8. Speakers

4

3 1

5

2

7 6 88

57 6
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LED Indicators
The LED indicators on the computer display helpful infor-
mation about the current status of the computer.

Table 1 - LED Indicators

Function Buttons

Table 2 - Function Buttons 

Icon Color Description

Green The computer is On

Blinking Green The computer is in Sleep Mode

Orange
The AC/DC Adapter is Plugged in 
& the Computer is Powered Off

Orange The Battery is Charging

Blank The Battery is Fully Charged

Blinking Orange
The Battery Has Reached Criti-

cally Low Power Status

Green
HDMI Cable Plugged-In (if the 
computer is off) - see  page 15

Green System Activity

Green
The Wireless LAN Module is 

Powered On

Orange
The Bluetooth Module is Pow-

ered On

Icon Description

Decrease/Increase Buttons - Use the buttons to 
decrease/increase the brightness/volume

Menu Toggle - Use this button to switch between 
the brightness or audio menus and use the but-

tons above to adjust

Mode Toggle - Use this button to toggle between 
the computer and HDMI Input modes 
6 
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On Screen Display Indicators
Press the function menu button for about two seconds (see Table 2 on page 6) to bring up the On Screen Display. The
OSD provides visual indicators for brightness, volume, camera power toggle and WLAN/Bluetooth power toggle (the
camera, WLAN and Bluetooth power indicators will only display if the modules are included in your purchase config-
uration) when the Hotkey AP is installed (see Hotkey AP on page 18).

Table 3 - On Screen Display Indicators

The indicators will appear when the computer boots up, or resumes from a power saving state, in order to display the
current power status of the camera and/or Bluetooth module. If you adjust the brightness or volume the OSD indicators
will appear, and will also allow you to adjust the power status of the camera and/or Bluetooth module using the mouse
to click on the icon.

OSD Icon Description

Brightness Decrease/Increase

Volume Decrease/Increase

WLAN Module Power Toggle

Bluetooth Power Toggle

Camera Power Toggle
 7
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Optional Wireless Keyboard & Mouse Kit
There is an optional RF wireless USB keyboard and
mouse kit available for this computer series. A USB port
located at the bottom of the rear cover is designed to house
the transceiver for the USB wireless keyboard & mouse
kit. 

Figure 3
 Optional 

Wireless Key-
board & 

Mouse Kit


Dongle & USB Ports

A single USB dongle (which acts as a trans-
ceiver for the keyboard and mouse) is provid-
ed with the keyboard and mouse kit. This
dongle may be inserted into any of the USB
ports. However, it is recommended that you
use the USB port specifically provided for this.


USB Port for Wireless Transceiver

Note that the USB port for the wireless transceiver  is
designed specifically for the optional RF keyboard and
mouse kit supplied with this model only. 

Do not use any other USB devices in this port.

1

Figure 4 -  USB Port for 
Wireless Keyboard & 

Mouse Kit

1

8 
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System Map: Left View Figure 5
Left View

1. Stand
2. Multi-in-1 Card Reader 

3. ExpressCard Slot /
54(34)

4. 2 * USB 3.0 Port

5. HDMI-In Port

6. HDMI-Out Port

1


USB 3.0 Port

The USB 3.0 ports  are col-
ored blue.  USB 3.0 will transfer
data much faster than USB 2.0,
and is backwards-compatible
with USB 2.0.

Multi-in-1 Card Reader

The card reader allows you to
use the most popular digital stor-
age card formats:

MMC (MultiMedia Card) / 
RSMMC

SD (Secure Digital) / Mini SD / 
SDHC / SDXC

MS (Memory Stick) / MS Pro / MS 
Duo

4

1

2

3

4

5

6

4
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HDMI-In Port
This computer features an HDMI (High-Definition Multimedia Interface) input port that allows you to display external
sources such as Blu-ray players, DVDs, set top boxes and games consoles etc. on your computer screen.

The computer itself does not need to be powered on to display video and audio from external sources. As long as the
computer is plugged-in to a power source through the AC/DC adapter (the LED indicator  will be orange if the com-
puter is plugged-in but powered off), simply plug-in the HDMI cable from the external device to the computer’s HDMI-
In port and the computer will act as the display device. If the computer is powered by battery then press the power button
on the computer to turn the computer on to use the HDMI-In port.

Mode Toggle
Press & Hold the mode toggle button  to switch between the computer and HDMI input modes. When the “Input
Source HDMI” is displayed you can use any HDMI device plugged in to the computer’s HDMI-In port. A quick press
of the button will toggle the display on/off.

The following table indicates the functions when an HDMI cable is plugged in to the HDMI-In port.

Table 4 - Mode Toggle Functions when HDMI Cable is Plugged-In

Computer Power 
Status HDMI Icon Mode Toggle Button 

(Press & Hold)

Mode Toggle Button 

(Quick Press)

The computer is powered on 
(using the AC/DC adapter/BAT-

TERY)

Indicates battery charge status 
only

Toggles between computer 
display and HDMI input

Toggles the display on/off

The computer is powered off (but 
is plugged in to the AC/DC adapter)

Green (when HDMI cable is 
plugged-in and the Mode Toggle 

Button has been pressed and held 
to select HDMI input)

Toggles between computer 
display and HDMI input

Toggles the display on/off
10
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System Map: Right View

3

1

2

Figure 6
Right View

1. Emergency Eject Hole
2. Optical Device Drive Bay

3. Headphone-Out Jack

4. Microphone-In Jack

5. 2 * USB 2.0 Port

6. Stand


Disc Emergency Eject

If you need to manually eject a
disc (e.g. due to an unexpected
power interruption) you may
push the end of a straightened
paper clip into the emergency
eject hole. Do not use a sharp-
ened pencil or similar object
that may break and become
lodged in the hole.

4


Moving the Computer

We strongly recommend using both hands to move the computer.
You can use one hand to grip the computer by the stand, and the
other to hold the top of the LCD screen. 

It is recommended that you carry the computer with the LCD facing
your body to avoid scratching the surface against other objects.
However take care not to scratch the LCD with any personal items,
belt fittings or jewelry etc.(one hand gripping the stand and the other
gripping the top of the computer to avoid accidentally dropping it).

5

5

6
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Tilting the Screen
It is possible to tilt the LCD screen in order to get the best
possible viewing angle of the screen without glare etc. 

1. Place one hand at the top of the computer , and use the 
other to open the stand  to an angle of around 15 degrees 
from the vertical position (the stand will allow you to adjust to 
the appropriate angle if you pull it out and let it spring back).

Figure 7 - Adjust the Stand

2. Apply pressure with one hand at the top (at point ) of the 
computer (while holding on to the side with the other hand) to 
carefully push the LCD screen down in order to tilt it to the 
appropriate viewing angle (up to 50 degrees from the vertical 
position).

3. Use one hand at the top of the computer (while holding on to 
the side with the other hand) to move the computer back to the 
original position.

Figure 8 - Tilting the Screen

1
2

Adjust the stand to
tilt the computer to
15° from the vertical
position. 

15°

1

2

3


DVD Operation

Note that although the com-
puter may be tilted up to an
angle of 50 degrees from
the vertical position, the
DVD-ROM drive will only
work (i.e continue to spin
and read DVDs) up until an
angle of around 35 degrees
from the vertical position. 

If you have any problems
with the system reading
DVDs, adjust the tillt angle
accordingly.

Apply pressure
from the top of
the screen to ad-
just the stand
outwards (up to
50° from the ver-
tical position). 

50°

50°

3

12 
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System Map: Rear View

1

3

2

8

3

4

5


Wall Mounting Information

The computer may be mount-
ed on a wall for display. The
system meets VESA (FDMI)
Standard (100mm * 100mm)
for wall mounting. However if
you intend to wall mount the
system please contact your
service center for information
in order to avoid personal in-
jury, or damage to the com-
puter.

CPU

The CPU is not a user ser-
viceable part. Accessing the
CPU in any way may violate
your warranty.

Overheating

To prevent your computer
from overheating make sure
nothing blocks the vent while
the computer is in use.

Figure 9 -  Rear View

1. Rear Component Cover
2. Stand

3. Vent

4. Carrying Handle Area

5. USB Wireless Transceiver 
Cover (for Optional RF 
Keyboard & Mouse Kit)

6. Security Lock Slot

7. Battery (Optional)

8. 2 * Serial (COM) Ports

9. PS/2 Port (keyboard)

10. PS/2 Port (mouse)

11. DC-In Jack

12. 2 * USB 2.0 Ports

13. RJ-45 LAN Jack

8

7

10

11

6

12 13

9
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Video Features
You can switch display devices, and configure display op-
tions, from the Display control panel in Windows and/or
the Intel Graphics and Media Control Panel as long as
the video dirver is installed.

To access Display control panel:
1. Click Start, and click Control Panel (or point to Settings and 

click Control Panel).

2. Click Display (icon) - in the Appearances and 
Personalization category.

3. Click Adjust Screen Resolution/Adjust resolution.

OR
4. Alternatively you can right-click the desktop and select Screen 

resolution.

5. Use the dropbox to select the screen resolution .

6. Click Advanced settings .

To access the Intel® Graphics and Media Control Pan-
el:
1. Click Start, and click Control Panel (or point to Settings and 

click Control Panel).

2. Click Intel(R) Graphics and Media in the icon view.

OR
3. Right-click the desktop and select Graphics Properties from 

the menu.

OR
4. Click the icon   in the notification area of the taskbar and 

select Graphics Properties from the menu.

5. Choose the application mode (Basic, Advanced or Wizard) 
and click OK.

1
2

2
1

Figure 10 - Display Control Panel 

3

3

Figure 11
Intel Graphics 

and Media Con-
trol Panel 
14 
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Audio Features
You can configure the audio options on your computer
from the Sound  control panel in Windows, or from the
Realtek HD Audio Manager /  icon in the notifica-
tion area/control panel (right-click the notification area
icon  to bring up an audio menu).

The volume may also be adjusted by means of the Speaker
icon in the taskbar or the On Screen Display Indicators
(see  page 7).

Setup for Audio Recording
To record audio sources on your computer at optimum
quality follow the instructions below:

1. Click Start, and click Control Panel (or point to Settings and 
click Control Panel).

2. Click Realtek HD Audio Manager (or right-click the notification 
area icon  and select Sound Manager).

3. Click Microphone Effects (tab) in Microphone (tab), and then 
click to select Noise Suppression (button), or adjust the 
Recording Volume level to around 60, to obtain the optimum 
recording quality.

4. Click OK to close the Sound  control panel.

Audio Setup for HDMI
HDMI supports video and audio signals. In some cases it
will be necessary to go to the Sound control panel and
manually configure the HDMI audio output.

1. Click Start, and click Control Panel (or point to Settings and 
click Control Panel).

2. Click Sound  (Hardware and Sound).

3. Click Playback (tab).

4. The playback device will be selected.

5. In some cases you may need to select the audio device and 
click Set Default (button).

6. Double-click the device to access the control panel tabs.

7. Adjust the HDMI settings from the control panel tabs.

8. Click OK to close the Sound  control panel.

Figure 12 
Realtek HD 
Audio Man-
ager - Re-
cording 
Setup

Figure 13 
Sound Playback 

Options
15
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Power Management Features
The Power Options (Hardware and Sound menu) control panel icon in Windows allows you to configure power man-
agement features for your computer. You can conserve power by means of power plans and configure the options for
the power button, sleep button, display and sleep mode from the left menu. Note that the Power saver plan may have
an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to create
a new plan. Click Change Plan Settings and click Change advanced power settings to access further configuration
options.

Figure 14 - Power Options
16
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Driver Installation
The Device Drivers & Utilities + User’s Manual disc con-
tains the drivers and utilities necessary for the proper op-
eration of the computer. Insert the disc and click Install
Drivers (button), or Option Drivers (button) to access
the Optional driver menu. Install the drivers in the order
indicated in Table 5. Click to select the drivers you wish
to install (you should note down the drivers as you install
them). Note: If you need to reinstall any driver, you
should uninstall the driver first.

Manual Driver Installation
Click the Browse CD/DVD button in the Drivers Install-
er application and browse to the executable file in the ap-
propriate driver folder. If a Found New Hardware wizard
appears during the installation procedure, click Cancel,
and follow the installation procedure as directed.

Windows Update
After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security updates
etc. (all updates will include the latest hotfixes from Mi-
crosoft).

Table 5 - Driver Installation

Driver (Windows 7 with SP1)* Page#

Chipset page 18

Video page 18

LAN page 18

ExpressCard/Card Reader page 18

Hot-Key page 18

USB 3.0 page 18

Intel MEI page 18

Audio page 18

PC Camera (Optional) page 19

Wireless LAN Module (Optional) page 21

WiDi page 22

Bluetooth Module (Optional) page 23

TPM page 24

Enable Windows Update (see left)

*Note all drivers provided are for Windows 7 with Service Pack 1.
17
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Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

LAN
1. Click 3.Install LAN Driver > Yes.
2. Click Install > Finish.
3. The network settings can now be configured.

ExpressCard/Card Reader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Install > Finish.

Hotkey AP
1. Click 5.Install Hotkey AP > Yes.
2. Click Next > Next.
3. Click Finish > Finish to restart your computer.

USB 3.0
1. Click 6.Install USB 3.0 Driver > Yes. 
2. Click Next.
3. Click the button to accept the license and then click 

Next.
4. Click Next > Install.
5. Click Finish.

Intel MEI Driver
1. Click 7.Install MEI Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish.

Audio
1. Click 8.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.


Driver Installation & Power

When installing drivers make sure your computer is
powered by the AC/DC adapter connected to a working
power source. Some drivers draw a significant amount
of power during the installation procedure, and if the re-
maining battery capacity is not adequate this may cause
the system to shut down and cause system problems
(note that there is no safety issue involved here, and the
battery will be rechargeable within 1 minute).
18 
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PC Camera (Option)
Make sure the camera module is on before beginning the
driver installation process (use the On Screen Display to
toggle power to the camera module - see  page 7).

When the PC Camera application is run the LED indicator
to the left of the camera will be illuminated in red (see Sys-
tem Map: Front View on page 5).

PC Camera Driver Installation
1. Click Option Drivers (button).
2. Click 1.Install Webcam Driver > Yes.
3. Click Finish to restart the computer.

OR
Click Next > Finish.

4. Run the camera application from the desktop shortcut.

PC Camera Audio Setup
If you wish to capture video & audio with your camera, it
is necessary to setup the audio recording options in Win-
dows.

1. Click Start, and click Control Panel (or point to Settings and 
click Control Panel).

2. Click Sound  (Hardware and Sound).

3. Click Recording (tab).

4. Right-click Microphone (Realtek High Definition Audio) and 
make sure the item is not disabled.

5. Double-click Microphone (or select Properties from the right-
click menu).

6. Click Levels (tab), and adjust the Microphone and 
Microphone Boost sliders to the level required.

7. Click OK and close the control panels.

8. Run the camera application from the desktop shortcut.

9. Go to the Devices menu heading and select Microphone 
(Realtek....) (it should have a tick alongside it).

10. Go to the Capture menu heading and select Capture Audio (it 
should have a tick alongside it).

11. To obtain the best sound recording quality enable Noise 
Supression in the Realtek HD Audio Manager control panel 
(see Setup for Audio Recording on page 15).


PC Camera Application and Power-Saving States

If the computer enters Sleep or Hibernate mode while
running the camera application, the program will stop
running, and will need to be restarted when the system
resumes from the power-saving state.
19
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Camera Application
The camera application is a video viewer useful for gener-
al purpose video viewing and testing, and can capture vid-
eo files to .avi format.

1. Run the camera application from the desktop shortcut (it is rec-
ommended that you Set Capture File before the capture pro-
cess - see “Set Capture File” below).

2. Go to the Capture menu heading (if you wish to capture audio 
check PC Camera Audio Setup on page 19) and select Start 
Capture.

3. Click OK (the file location will be displayed in the pop-up box) to 
start capturing the video, and press Esc to stop the capture 
(you can view the file using the Windows Media Player).

Set Capture File
Prior to capturing video files you may select the Set Cap-
ture File... option in the File menu, and set the file name
and location before capture (this will help avoid acciden-
tally overwriting files). Set the name and location then
click Open, then set the “Capture file size:” and click OK.
You can then start the capture process as above.

Reducing Video File Size
Note that capturing high resolution video files requires a
substantial amount of disk space for each file. After re-
cording video, check the video file size (right-click the file
and select Properties) and the remaining free space on
your hard disk (go to Computer, right-click the hard disk,
and select Properties). If necessary you can remove the
recorded video file to a removable medium e.g. CD, DVD
or USB Flash drive.

Note that the Windows system requires a minimum of
15GB of free space on the C: drive system partition. In
order to prevent system problems it is recommended that
you save the captured video file to a location other than
the C: drive, limit the file size of the captured video or re-
duce video resolution.

To Reduce Video Resolution Output Size:
1. Run the camera application from the desktop shortcut.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution 
size in order to reduce the captured file size.
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Wireless LAN Module (Option)
Make sure the wireless LAN module is on before begin-
ning the driver installation process (use the On Screen
Display to toggle power to the wireless LAN module - see
page 7).

WLAN Driver Installation
Follow the instructions below:

WLAN and Bluetooth Combo (Intel)
1. Click Option Drivers (button).
2. Click 2.Install WLAN Driver > Yes.
3. Click Next > Next.
4. Click the button to accept the license and click Next.
5. Click Typical (buttom) or Custom (buttom).
6. Click Install > Finish.

WLAN (Third Party)
1. Click Option Drivers (button).
2. Click 2.Install WLAN Driver > Yes.
3. Choose the language you prefer and click Next > Next 

> Install.
4. Click Finish to restart the computer.

WLAN and Bluetooth 4.0 Combo (Third Party)
1. Click Option Drivers (button).
2. Click 2.Install WLAN Driver > Yes.
3. Click Next.
4. Click Finish to restart the computer.

Connecting to a Wireless Network
The operating system is the default setting for Wireless
LAN control in Windows. Make sure the Wireless LAN
module is turned on.

1. Click the taskbar wireless icon , and then double-click an 
access point to connect to or click to Open Network and Shar-
ing Center if you do not see a network you want to connect to 
in the taskbar menu (a list of options will appear allowing setting 
changes, and creating a new network).

2. You may need to enter a security key for any access point to 
which you are trying to connect.

3. Click to selct a network location (e.g. Home, Work or Public).

4. Click “View or change settings in Network and Sharing 
Center” to access further options for the connection.

5. Click the taskbar icon  to see any currently connected 
networks.

6. To disconnect from the wireless network you can click the 
taskbar wireless icon , click the active connection and then 
click Disconnect (button).
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Intel® Wireless Display Appli-
cation
The Intel® Wireless Display Application (requires In-
tel® Centrino WLAN/Combo module), in conjunction
with a compatible video adapter (purchased separately),
allows you to display the contents of the notebook display
on another display (e.g. HDTV) without the need to have
cables stretching across a room. You can then play games,
browse the internet, display videos or photo slide shows
on your TV/external display without using HDMI or A/V
cables.

Before configuring the Intel® WiDi application you will
need to set up your compatible adapter with your dis-
play/speakers. Connect the adapter using an HDMI or A/
V cable and turn on the display (or in the case of speakers
connect them to the wireless speaker adapter with the ca-
bles provided with the adapter), and then set the display to
the appropriate input channel (see the documentation sup-
plied with your compatible adapter for full details).

Intel® WiDi also incorporates Intel® Wireless Music
which allows you to wirelessly stream audio from your
computer to speakers connected to a compatible wireless
speaker adapter (purchased separately).

Intel® WiDi Application Installation
1.  Click Option Drivers (button).
2. Click 3.Install WiDi AP > Yes.
3. Click Next.
4. Click the button to accept the license and click Next.
5. Click Finish.

Intel® WiDi Application Configuration
1. Click Start > All Programs > Intel Corporation > Intel(R) 

Wireless Display > Intel(R) Wireless Display, or double click 
the icon  on the desktop.

2. Click I agree to the terms of this license (button).

3. The application will scan for any connected compatible 
adapters (or you can click the Scan for available adapters 
button to enable Intel My WiFi Technology).

4. Click to select any detected adapters, and click Connect.

5. The system will then prompt you to enter the 4-digit security 
code which will be displayed on the external TV Screen.

6. Enter the code for the video adapter and click Continue.

7. You will then be prompted to enter a name for the video adapter 
and click Continue.

8. Click Finished to complete the setup.
22 



E
n

g
lish
Bluetooth Module (Option)
Make sure the Bluetooth module is on before beginning
the driver installation process (use the On Screen Display
to toggle power to the Bluetooth module - see  page 7).

Bluetooth Driver Installation
Follow the instructions below:

WLAN and Bluetooth Combo (Intel) 
1. Click Option Drivers (button).
2. Click 4.Install Combo BT Driver > Yes.
3. Click Next > Next.
4. Click the button to accept the license and click Next.
5. Click Next > Finish.

WLAN and Bluetooth 4.0 Combo (Third Party) 
1. Click Option Drivers (button).
2. Click 4.Install Combo BT Driver > Yes.
3. Click Next.
4. Click Finish to restart the computer.

Bluetooth Configuration

Setup your Bluetooth Device so the Com-
puter Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.

2. Make the device discoverable (to do this check your device 
documentation).

To Turn the Bluetooth Module on
1. Use the On Screen Display to power on the Bluetooth module. 

2. A Bluetooth icon  will appear in the taskbar. 

3. You can then do any of the following to access the Bluetooth 
Devices control panel.

• Double-click the icon  to access the Bluetooth Devices 
control panel.

• Click/Right-click the icon  and choose an option from the 
menu.

Bluetooth Help
Click Start and select Help & Support and then type
Bluetooth in the Search Help box, and then click the
magnifying glass icon to find more information on Blue-
tooth transfer.
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Trusted Platform Module
Before setting up the TPM functions you must initialize
the security platform.

Activating TPM
1. Restart the computer.

2. Enter the Aptio Setup Utility pressing F2 during the POST.

3. Use the arrow keys to select the Security menu.

4. Select TPM Configuration and press Enter.

5. Select TPM Support and press Enter. Select Enable and press 
Enter.

6. Select TPM State, press Enter and select Enable to change the 
TPM state to enabled. You will then need to press F4 to save 
the changes and restart the computer.

7. As the computer restarts press F2 to enter the BIOS again and 
go to the TPM Configuration menu.

8. Select Pending TPM operation, press Enter and select the 
option you require (if you are initializing TPM you should select 
Enable Take Ownership). You will then need to press F4 to 
save the changes and restart the computer.

9. You can now  install the TPM driver and then initialize the 
TPM.

TPM Driver Installation
1. Click Option Drivers (button).
2. Click 5.Install TPM Driver > Yes.
3. Click Install > Next.
4. Click the button to accept the license and click Next.
5. Click Next > Next > Install.
6. Click Finish > Yes to restart the computer.
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Initializing TPM
1. Run the application from the Infineon Security Platform Solu-

tion > Manage Security Platform item in the Start > Pro-
grams/All Programs menu.

2. Click User Settings (tab) and click Yes, or right-click the icon 
 in the notification area of the taskbar, and select Security 

Platform Initialization (or click the Security Platform State 
taskbar bubble).

3. The Quick Initialization method will automatically be selected 
for you (if you need to use advanced settings provided by your 
network administrator then select Advanced Initialization).

4. You will need to use a removable media (e.g. a USB Flash 
Drive) to store passwords and data (keep the media in a safe 
place until required).

5. Select the drive you want to use from the drop-down menu and 
click Next.

6. Choose the Security Platform Features you want to use by 
clicking the appropriate tickbox.

7. Enter a Basic User Password (and re-type to confirm it) and 
click Next.

8. Click Next to confirm the settings.

9. The computer will then initialize the settings.

10. Click Finish.

11. Click the tabs and control panels to adjust the settings.

12. Double-click the taskbar icon  to access the Infineon 
Security Platform Settings Tool, or right-click the taskbar icon 

 and select a menu item.

Infineon Security Platform Settings 
Tool
The Infineon Security Platform Settings Tool allows you
to manage and check the TPM state, manage your pass-
word information, and to backup and restore the TPM da-
ta. As TPM is usually administered within large
enterprises and organizations, your system administrator
will need to assist you in managing the information here.Figure 15 

 Security 
Platform 

Quick Initial-
ization Wiz-

ard

Figure 16 
 Infineon Secu-

rity Platform 
Settings
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Troubleshooting

Problem Possible Cause - Solution

The PC Camera/Wireless 
LAN/Bluetooth modules 
cannot be detected.

The modules are off. Press the function menu button for about two seconds (see Table 3 on page 7) 
to bring up the On Screen Display. Check the appropriate OSD to see if it is on or
off.

No sound can be heard 
through an HDMI 
connected display device.

You have not configured the HDMI audio output. See Audio Setup for HDMI on page 15.

The captured video files 
from the PC Camera are 
taking up too much disk 
space.

Note that capturing high resolution video files requires a substantial amount of disk space for each file.

Note that the Windows system requires a minimum of 15GB of free space on the C: drive system
partition. It is recommended that you save the capture video file to a location other than the C:drive,
limit the file size of the captured video or reduce video resolution (Options > Video Capture Pin... >
Output Size).
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Specifications


Latest Specification Information

The specifications listed in this section
are correct at the time of going to press.
Certain items (particularly processor
types/speeds) may be changed, de-
layed or updated due to the manufac-
turer's release schedule. Check with
your service center for details.

Processor Options

Intel® Core™ i7 Processor

i7-3770S (3.10GHz)

8MB L3 Cache, 22nm, DDR3-1600MHz, 
TDP 65W

i7-3570S (3.10GHz)

6MB L3 Cache, 22nm, DDR3-1600MHz, 
TDP 65W

Intel® Core™ i5 Processor

i5-3550S (3.00GHz), i5-3475S (2.90GHz), 
i5-3470S (2.90GHz), i5-3450S (2.80GHz), 
i5-3570T (2.30GHz)

6MB L3 Cache, 22nm, DDR3-1600MHz, 
TDP 65W

Intel® Pentium® Processor

G640 (2.80GHz)

3MB L3 Cache, 22nm, DDR3-1066MHz, 
TDP 65W

Intel® Celeron® Processor

G540 (2.50GHz)

2MB L3 Cache, 22nm, DDR3-1066MHz, 
TDP 65W

Core Logic

Intel® HM61 Chipset

BIOS

One 48Mb SPI Flash ROM

AMI BIOS

Memory

Two 204 Pin SO-DIMM Sockets Supporting 
DDR3 1333/1600MHz Memory

Memory Expandable up to 8GB

Video Adapter

Intel Integrated GPU 
(GPU is Dependent on Processor)

Intel® HD Graphics

Dynamic Frequency (Intel Dynamic Video 
Memory Technology for up to 1.7GB)

Microsoft DirectX®10 Compatible

Intel® HD Graphics 2500

Dynamic Frequency (Intel Dynamic Video 
Memory Technology for up to 1.7GB)

Microsoft DirectX®11 Compatible

Intel® HD Graphics 4000

Dynamic Frequency (Intel Dynamic Video 
Memory Technology for up to 1.7GB)

Microsoft DirectX®11 Compatible

LCD

21.5" (54,61cm) FHD

Storage

(Factory Option) One Changeable 
12.7mm(h) Optical Device Type Drive 
(Super Multi Drive Module or

Blu-Ray Combo Drive Module)

One Changeable 2.5" 9.5mm (h) SATA 
(Serial) HDD

One Changeable 3.5" 25mm (h) SATA 
(Serial) HDD
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Audio

High Definition Audio Compliant Interface

Built-In Microphone

2 * Built-In Speakers 

Security

BIOS Password

Security (Kensington® Type) Lock Slot

TPM 1.2

Interface

Four USB 2.0 Ports 

Two USB 3.0 Ports

One HDMI-In Port

One HDMI-Out Port

One Headphone-Out Jack

One Microphone-In Jack

Two RS232 Serial (COM) Ports

Two PS Ports

One RJ-45 LAN Jack

One DC-in Jack

Slots

One Slot for WLAN Module or Combo 
WLAN and Bluetooth Module

One ExpressCard/34(54) Slot

Card Reader

Embedded Multi-in-1 Card Reader 

MMC (MultiMedia Card) / RS MMC

SD (Secure Digital) / Mini SD / SDHC/ 
SDXC

MS (Memory Stick) / MS Pro / MS Duo

Keyboard & Pointing Device

(Factory Option) RF USB Keyboard/
Mouse with Transceiver 

Communication

Built-In Gigabit Ethernet LAN 

(Factory Option) 2.0M FHD PC Camera 
Module

WLAN/ Bluetooth Half Mini-Card 
Modules:

(Factory Option) Intel® Centrino® Wire-
less-N 2230 Wireless LAN (802.11b/g/n) + 
Bluetooth 4.0

(Factory Option) Third-Party Wireless LAN 
(802.11b/g/n) 

(Factory Option) Third-Party Wireless LAN 
(802.11b/g/n) + Bluetooth 4.0

Power

Full Range AC/DC Adapter

AC Input: 100 - 240V, 50 - 60Hz

DC Output: 19V, 6.3A (120W)

(Factory Option) 6 Cell Smart Lithium-Ion 
Battery Pack, 62.16WH

Envionmental Spec

Temperature 

Operating: 5°C - 35°C

Non-Operating: -20°C - 60°C

Relative Humidity

Operating: 20% - 80%

Non-Operating: 10% - 90%

Dimensions & Weight

525mm (w) * 49mm (d) * 418mm (h))

Around 7kg (with ODD)
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Über das Ausführliche Benutzerhandbuch
Diese Kurzanleitung soll einen Überblick über die Schritte geben, die dazu notwendig sind, das System zu starten. Dieses ist
nur eine Ergänzung und kein Ersatz für das erweiterte englischsprachige Benutzerhandbuch, das auf der mitgelieferten Disc
Device Drivers & Utilities + User's Manual im Adobe-Acrobat-Format vorliegt. Diese Disc enthält auch die Treiber und
Utility-Programme, die für einen einwandfreien Betrieb des Computers notwendig sind (Hinweis: Das Unternehmen behält
sich das Recht vor, diese Publikation ohne Vorankündigung zu überarbeiten und den Inhalt zu verändern). 

Einige oder alle Funktionen des Computers sind bereits eingerichtet worden. Falls das nicht der Fall ist oder wenn Sie ein-
zelne Teile des Systems neu konfigurieren (oder neu installieren) möchten, finden Sie eine Anleitung im erweiterten Benut-
zerhandbuch. Die Disc Device Drivers & Utilities + User's Manual enthält nicht das Betriebssystem.

Einhaltung gesetzlicher Vorschriften und Sicherheitshinweise
Beachten Sie sorgfältig die Hinweise zu gesetzlichen Vorschriften und zu Sicherheitshinweisen im erweiterten Benutzer-
handbuch auf der Disc Device Drivers & Utilities + User's Manual.

© Juli 2012

Warenzeichen
Intel und Intel Core sind warenzeichen/eingetragenes warenzeichen der Intel Corporation.
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Hinweise zu Pflege und Betrieb
Der Computer ist zwar sehr stabil, kann aber dennoch beschä-
digt werden. Damit es nicht dazu kommt, sollten Sie die folgen-
den Hinweise beachten:

• Das Gerät darf nicht herunterfallen und in anderer Form Stößen 
ausgesetzt werden. Wenn der Computer fällt, können das Gehäuse 
und andere Komponenten beschädigt werden.

• Das Gerät darf nicht nass werden und sich nicht überhitzen. Der 
Computer und das Netzteil dürfen nicht in der Nähe einer Wärmequelle 
stehen. Dies ist ein elektrisches Gerät. Wenn Wasser oder andere Flüs-
sigkeiten eindringen, kann der Computer stark beschädigt werden.

• Vermeiden Sie Interferenzen mit anderen Geräten. Halten Sie den 
Computer fern von magnetischen Feldern, die von Stromquellen, 
Monitoren, Magneten etc. erzeugt werden. Die können die Leistung 
beeinträchtigen und Ihre Daten beschädigen.

• Achten Sie auf die richtige Bedienung des Computers. Schalten Sie 
ihn erst aus,  wenn alle Programme geschlossen wurden (speichern Sie 
Ihre Daten!). Speichern Sie regelmäßig Ihre Daten, da diese verloren 
gehen können, wenn der Akku verbraucht ist.

• Beachten Sie, dass das Logo bei den Computern, die über ein galvanisch 
beschichtetes LCD-Logo verfügen, von einer Schutzfolie bedeckt ist. 
Durch die natürliche Abnutzung kann diese Schutzfolie beschädigt wer-
den oder abgehen und die scharfen Kanten des frei liegenden Logos 
freigeben. Seien Sie in solch einem Fall vorsichtig bei der Handhabung 
des Computers, und vermeiden Sie es, das herausstehende beschichtete 
LCD-Logo zu berühren. Wenden Sie sich in einem solchen Fall von 
Abnutzung an Ihr Service Center.

Strom- und Akkusicherheit
• Verwenden Sie nur einen AC/DC-Adapter, der für die Verwendung mit 

diesem Computer zugelassen ist. 
• Verwenden Sie nur das Netzkabel und die Akkus, die in diesem Benut-

zerhandbuch spezifiziert sind.
• Der AC/DC-Adapter kann zwar für internationale Benutzung vorge-

sehen sein, benötigt aber trotzdem eine gleichmäßige, ununterbro-
chene Stromversorgung. Wenn Sie sich über Ihre lokalen 
Stromspezifikationen nicht im klaren sind, wenden Sie sich an Ihren 

Servicevertreter oder Ihre lokale Stromgellschaft.
• Der AC/DC-Adapter kann einen zwei- oder dreipoligen geerdeten 

Netzstecker haben.  Der dritte Pol hat eine wichtige Sicherheitsfunk-
tion. Setzen Sie die nicht außer Kraft. Wenn Sie keinen Zugang zu 
einer passenden Steckdose haben, lassen Sie von einem qualifizierten 
Elektriker eine solche einbauen. 

• Fassen Sie das Netzkabel am Stecker und nicht am Kabel an, wenn Sie 
es vom Stromnetz trennen möchten. 

• Achten Sie darauf, daß die Steckdose und alle verwendeten Ver-
längerungskabel die Gesamtstromlast aller angeschlossenen Geräte 
trägt.

• Verwenden Sie nur Akkus, die für diesen Computer entwickelt 
wurden. Ein falscher Akku-Typ kann explodieren, auslaufen oder den 
Computer beschädigen.

• Verwenden Sie den Akku nicht mehr, wenn er heruntergefallen ist oder 
in anderer Weise beschädigt (z.B. verzogen) ist. Auch wenn der Com-
puter mit dem beschädigten Akku zu funktionieren schein, können 
dadurch Stromkreise beschädigt werden, die schließlich einen Brand 
verursachen können.

• Laden Sie die Akkus über den Computer auf. Durch falsches Laden 
kann der Akku explodieren.

• Versuchen Sie nicht, Akkus zu reparieren. Lassen Sie die Akkupacks 
durch den Servicevertreter oder qualifiziertes Fachpersonal reparieren 
oder austauschen.

• Halten Sie Kinder vom Akku fern und entsorgen Sie beschädigte 
Akkus sofort. Seien Sie vorsichtig bei der Entsorgung der Akkus. 
Akkus können explodieren oder auslaufen, wenn sie Feuer ausgesetzt 
sind oder unsachgemäß behandelt oder entsorgt werden.

• Halten Sie den Akku von Metallgeräten fern.
• Bringen Sie Klebeband auf den Akkukontakten an, bevor Sie den 

Akku entsorgen.
• Entsorgen Sie die Akkus nicht in Feuer. Sie können explodieren. 

Richten Sie sich nach den regional gültigen Entsorgungsvorschriften. 
• Berühren Sie die Akkukontakte nicht mit Ihren Händen oder mit 

metallenen Gegenständen.
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Polymer Akku Sicherheitshinweise
Beachten Sie die folgenden Hinweise, die sich speziell auf Poly-
mer Akkus beziehen. Diese Hinweise haben zudem Vorrang ge-
genüber den Allgemeinen Akku Sicherheitshinweisen.

• Polymer Akkus können sich etwas ausdehnen oder anschwellen. Dies 
ist Teil des Sicherheitsmechanismus des Akkus und kein Anlass zur 
Sorge.

• Seien Sie vernünftig im Umgang mit Polymer Akkus. Verwenden Sie 
keine Polymer Akkus in Umgebungen mit hohen Temperaturen und 
lagern Sie keine ungenutzten Akkus über längere Zeiträume.

Reparatur
Nehmen Sie vor dem Reinigen des Wenn Sie versuchen, den
Computer selbst zu reparieren, können Ihre Garantieansprüche
verloren gehen. Außerdem besteht Stromschlaggefahr für Ihre
Gesundheit und das Gerät durch frei liegende Teile. Lassen Sie
Reparaturarbeiten nur von qualifizierten Reparaturfachleuten
durchführen, insbesondere wenn folgende Umstände vorliegen:

• Wenn das Netzkabel oder der AC/DC-Adapter beschädigt oder zer-
schlissen sind.

• Wenn der Computer Regen ausgesetzt war oder mit Flüssigkeiten in 
Berührung gekommen ist.

• Wenn der Computer unter Beachtung der Bedienungsanweisungen 
nicht korrekt arbeitet.

• Wenn der Computer heruntergefallen ist oder beschädigt wurde 
(berühren Sie nicht die giftige Flüssigkeit des LCD-Bildschirms).

• Wenn ein ungewöhnlicher Geruch, Hitze oder Rauch aus dem Compu-
ter entweicht.

Reinigung
• Reinigen Sie den Computer mit einem weichen, sauberen Tuch. 

Tragen Sie das Reinigungsmittel nicht direkt auf den Computer auf. 
• Verwenden Sie keine flüchtigen Reinigungsmittel (Petroleumdes-

tillate) oder Scheuermittel zum Reinigen des Computers.
• Nehmen Sie vor dem Reinigen des Computers den Akku heraus, und 

trennen Sie es von allen externen Stromquellen, Peripheriegeräten und 
Kabeln (einschließlich Telefonkabel) ab.


Entsorgen der Akkus/Batterien & Achtung

Das von Ihnen gekaufte Produkt enthält einen aufladbaren
Akku. Dier Akku ist wiederverwertbar. Nach verschiedenen
nationalen und regionalen Getzgebungen kann es verboten in,
einen nicht mehr gebrauchsfähigen Akku in den normalen
Hausmüll zu werfen. Informieren Sie sich bei Ihrem regionalen
Entsorgungsunternehmen über Recycling-Möglichkeiten oder
korrekte Entsorgung.

Wenn ein falscher Akku eingesetzt wird, besteht Explosions-
gefahr. Tauschen Sie den Akku nur durch den gleichen oder
einen baugleichen  Typ aus, der vom Hersteller empfohlen
wird. Entsorgen Sie den verbrauchten Akku entsprechend der
Anweisungen des Herstellers.
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Schnellstart
1. Entfernen Sie das gesamte Verpackungsmaterial.

2. Legen Sie den Computer auf eine stabile Unterlage.

3. Schließen Sie alle Peripheriegeräte, die Sie mit dem computer verwenden wollen (z. B. Tastatur und Maus), an die entsprechenden 
Schnittstellen an.

4. Schließen Sie den AC/DC-Adapter an die DC-Eingangsbuchse an der Rückseite des LCD-Bildschirm an. Verbinden Sie dann das Netzkabel 
mit einer Netzsteckdose und dem AC/DC-Adapter.

5. Drücken Sie auf den Netzschalter des Computers, um das Gerät einzuschalten.

Abb. 1 - Computer mit angeschlossenem AC/DC-Adapter/Netzschalter

Systemsoftware
Möglicherweise wurde Ihr Computer bereits mit vorinstallierter Software ausgeliefert. Ist das nicht der Fall, oder wenn Sie
Ihren Computer für ein anderes System neu konfigurieren möchten, finden Sie dazu eine Anleitung in diesem Handbuch zu
Microsoft Windows 7.


Herunterfahren 

Bitte beachten Sie, daß der Computer immer mit dem
Befehl Herunterfahren im Menü Start heruntergefahren
werden muß.
Dadurch werden Festplatten- bzw. Systemprobleme ver-
mieden.

Netzschalter
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Systemübersicht: Ansicht von vorne

Abb. 2 - Ansicht von vorne

1. Mikrofon

2. PC-Kamera (optional)

3. LED-Anzeige der PC-Kamera

4. LCD-Bildschirm

5. Netzschalter

6. Funktionstasten 

7. LED-Anzeigen

8. Lautsprecher

4

3 1

5

2

7 6 88

57 6
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LED-Anzeigen
Die LED-Anzeigen auf dem Computer zeigen wichtige
Informationen über den aktuellen Status des Computers.

Tabelle 1 - LED-Anzeigen

Funktionstasten

Tabelle 2 - Funktionstasten 

Symbol Farbe Beschreibung

Orange
Der AC/DC-Adapter ist ange-

schlossen

Grün Der Computer ist angeschaltet

Lampe blinkt 
grün

Das System ist im konfigurierten 
Energiesparmodus 

Orange Der Akku wird geladen

Leer Der Akku ist voll geladen

Lampe blinkt 
orange

Der Akku hat einen kritisch niedri-
gen Stromstatus erreicht

Grün
Angeschlossenes HDMI-Kabel 

(wenn der Computer ausgeschal-
tet ist) - siehe Seite 38

Grün
Es wird auf die Festplatte 

zugegriffen

Grün
Das WLAN-Modul ist eingeschal-

tet

Orange
Das Bluetooth-Modul ist einge-

schaltet

Symbol Beschreibung

Erhöhen/Verringern-Taste – Mit diesen Tasten 
können Sie die Helligkeit/Lautstärke erhöhen/ver-

ringern

Menü-Taste – Mit dieser Taste können Sie zwischen 
dem Helligkeits- und Audiomenü wechseln; mit den 

oben genannten Tasten können Sie die Ein-
stellungen ändern

Modus-Taste – Mit dieser Taste können Sie zwi-
schen dem Computer- und HDMI-Eingangsmodus 

wechseln 
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OSD-Anzeigen
Drücken Sie etwa 2 Sekunden lang (siehe Tabelle 2 auf Seite 34) auf die Funktionsmenütaste, um das OSD-Menü zu öffnen.
Wenn das Hotkey AP installiert ist (siehe "Hotkey AP" auf Seite 46), erscheinen auf dem Bildschirm Anzeigen für die
Helligkeit, Lautstärke, Kamera-, WLAN- und Bluetoothaktivität (die Anzeigen für die Kamera-, WLAN- und Bluetoothak-
tivität erscheinen nur, wenn diese bei Ihrer Modellkonfiguration enthalten sind).

Tabelle 3 - OSD-Anzeigen

Die Anzeigen erscheinen beim Hochfahren des Computers und wenn der Computer aus einem Stromsparmodus wieder akti-
viert wird, um den aktuellen Aktivitätszustand der Kamera und/oder des Bluetooth-Moduls anzuzeigen. Wenn Sie die
Helligkeit oder Lautstärke einstellen, erscheinen die Bildschirmanzeigen. Sie können auch den Aktivitätsstatus der Kamera
und/oder des Bluetooth-Moduls durch Anklicken des Moduls ändern.

OSD-Symbol Beschreibung

LCD-Helligkeit verringern/erhöhen

Audio-Lautstärke verringern/erhöhen

Wireless-LAN-Modul aktivieren/deaktivieren

Bluetooth-Modul aktivieren/deaktivieren

PC-Kamera aktivieren/deaktivieren
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Optionale Funk-Tastatur/Maus
Für diese Computer-Serie ist optional eine drahtlose USB-
Tastatur/Maus verfügbar. Am unteren Rand der Gehäu-
serückseite befindet sich ein USB-Anschluss, an den der
Dongle für die drahtlose USB-Tastatur/Maus angeschlossen
wird.

Abb. 4 - Optionale Drahtlostastatur mit Maus

 

Abb. 3
Optionale 

Drahtlosta-
statur mit 

Maus


Dongle und USB-Anschlüsse

Für die Tastatur- und Mauskombination wird
nur ein Dongle zur Verfügung gestellt. Er ist der
Sender/Empfänger für die Tastatur und die
Maus. Dieser Dongle kann an einem beliebigen
USB-Anschluss eingesteckt werden. Es wird
empfohlen, diesen USB-Anschluss nur für den
Tastatur/Maus-Dongle zu verwenden.


USB-Anschluss für den drahtlosen Sender/Empfänger

Der USB-Anschluss für den drahtlosen Sender/Empfänger
 funktioniert nur für die optionale drahtlose Tastatur/

Maus-Kombination, die Sie mit diesem Modell zusammen er-
halten. 

Verwenden Sie keine anderen USB-Geräte an diesem An-
schluss.

1

Abb. 5 -  USB-Anschluss 
für Funk-Tastatur/Maus

1
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Systemübersicht: Ansicht von links Abb. 6

Ansicht von links

1. Fuß

2. Multi-in-1 Kartenleser

3. ExpressCard/54(34)-
Steckplatz

4. 2 USB 3.0-Anschlüsse

5. HDMI-Eingangsan-
schluss

6. HDMI-Ausgangsan-
schluss


USB 3.0-Anschluss

Die USB 3.0-Anschlüsse 
sind blau. Die Datenübertragung
ist bei USB 3.0 viel schneller als
bei USB 2.0, und USB 3.0 ist
rückwärts kompatibel mit USB
2.0.

Multi-in-1 Kartenleser

Mit dem Kartenleser können
einige der neuesten digitalen
Speicherkarten gelesen werden. 

MMC (MultiMedia Card) / RS 
MMC

SD (Secure Digital) / Mini SD / 
SDHC/ SDXC

MS (Memory Stick) / MS Pro / 
MS Duo

4

1

2

3

4

5

6

4
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HDMI-Eingangsanschluss
Dieser Computer verfügt über einen HDMI-Eingangsanschluss, an dem Sie externe Geräte wie Blu-ray-Player, DVD-Player,
Set-top-Boxen, Spielekonsolen usw. anschließen und auf dem Computerbildschirm wiedergeben können.

Für die Wiedergabe von Video- und Audiodateien externer Geräte muss der Computer selbst nicht eingeschaltet werden.
Schließen Sie zuerst den Computer über den AC/DC-Adapter an eine Netzsteckdose (die LED-Anzeige  leuchtet
orangefarben, wenn der Computer angeschlossen aber ausgeschaltet ist) und dann das externe Gerät mit einem HDMI-Kabel
an den HDMI-Eingangsanschluss des Computers an. Der Computer ist dann das Anzeigegerät. Wenn der Computer mit
Akkustrom läuft, drücken Sie auf die Netztaste des Computers, um den Computer einzuschalten und den HDMI-In-Anschluss
zu verwenden.

Modus-Taste
Drücken und halten Sie auf die Modus-Taste , um zwischen dem Computer- und HDMI-Eingangsmodus zu wechseln.
Wenn “Input Source HDMI” (Signalquelle HDMI) angezeigt wird, können Sie ein beliebiges HDMI-Gerät an den HDMI-
Eingangsanschluss anschließen. Wenn Sie jeweils kurz auf die Taste drücken, schaltet sich der Bildschirm ein/aus.

Die folgende Tabelle zeigt die Funktionen, wenn ein HDMI-Kabel an den HDMI-In-Anschluss angeschlossen ist.

Tabelle 4 - Funktionen der Modus-Taste wenn ein HDMI-Kabel angeschlossen ist

Energiestatus des Computers HDMI-Symbol Modus-Taste  

(Drücken und halten)

Modus-Taste 

 (Kurz drücken)

Der Computer ist eingeschaltet (läuft 
mit Netz-/Akkustrom)

Zeigt nur den Akkuladestand an
Wechseln zwischen Computer-
Bildschirm und HDMI-Eingang

Schaltet Bildschirm ein/aus

Der Computer ist ausgeschaltet (er 
ist aber an mit dem Stromnetz ver-

bunden)

Grün (bei angeschlossenem HDMI-
Kabel und HDMI-Eingang wurde mit 

Modus-Taste gewählt)

Wechseln zwischen Computer-
Bildschirm und HDMI-Eingang

Schaltet Bildschirm ein/aus
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Systemübersicht: Ansicht von rechts

Abb. 7
Ansicht von recht

1. Notauswurfloch

2. Schacht für optisches 
Laufwerk

3. Kopfhörer-Ausgangsbuchse

4. Mikrofon-Eingangsbuchse

5. 2 * USB 2.0 Anschlüsse

6. Fuß


Disc-Notauswurf

Wenn eine Disc manuell entnommen
werden muß (z.B. wegen eines
Stromausfalls) können Sie mit dem
Ende einer geradegebogenen Büro-
klammer in das Notauswurfloch drü-
kken. Verwenden Sie hierzu aber
keinen spitzen Bleistift oder ähnliche
Objekte, die im Loch abbrechen und
darin stekkenbleiben könnten.


Transportieren des Computers

Es wird empfohlen, den Computer beim Transport mit
beiden Händen anzufassen. Fassen Sie den Computer
mit einer Hand am Fuß an und mit der anderen am obe-
ren Rand des LCD-Bildschirms.

Es wird empfohlen, den Computer mit dem LCD-Bild-
schirm zu Ihnen zeigend zu tragen, um zu vermeiden,
dass er verkratzt wird.  Achten Sie darauf, dass der
LCD-Bildschirm dann nicht von einer Gürtelschnalle,
Knöpfen, Schmuck o. ä. verkratzt wird.  (Fassen Sie
das Gerät mit einer Hand am Fuß und mit der anderen
Hand oben am Bildschirm fest, damit Sie ihn sicher
halten können).

3

1

2

4
5

5

6
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Neigen des Bildschirms
Es ist möglich, den LCD-Monitor zu neigen, um auf diese
Weise den bestmöglichen Sichtwinkel ohne Licht-
spiegelungen einzustellen. 

1. Legen Sie eine Hand oben auf den Computer , während Sie 
mit der anderen Hand den Fuß  auf einen Winkel von etwa 
15° aus der vertikalen Position herausklappen (wenn Sie den 
Fuß herausziehen und zurückschnappen lassen, wird der pas-
sende Winkel eingestellt).

Abb. 8 - Einstellung des Fuß

2. Üben Sie oben (an Punkt ) am Computer Druck aus (mit der 
anderen Hand halten Sie seitlich dagegen), um den LCD-
Bildschirm auf den gewünschten Sichtwinkel zu neigen (bis zu 
50° von der vertikalen Position).

3. Halten Sie den Computer mit einer Hand oben fest (mit der 
anderen Hand halten Sie seitlich dagegen), und drücken Sie den 
Computer zurück in seine Ursprungsposition.

Abb. 9 - Neigen des Bildschirms

1
2

Stellen Sie den Fuß so
ein, dass der Compu-
ter um 15° aus der ver-
tikalen Position
geneigt ist. 

15°

1

2

3


DVD-Betrieb

Auch wenn der Computer um
50° aus der vertikalen Posi-
tion geneigt werden kann,
funktioniert das DVD-ROM-
Laufwerk nur (d. h. es dreht
sich und liest DVDs) bis zu
einem Winkel von etwa 35°
aus der vertikalen Position.

Wenn das System Probleme
beim Lesen von DVDs hat,
müssen Sie also den
Neigungswinkel ent-
sprechend anpassen.

Drücken Sie von
oben auf den
Bildschirm, um
den Fuß nach au-
ßen zu drücken
(bis zu 50° aus
der vertikalen Po-
sition). 

50°

3

50°
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Systemübersicht: Rückansicht


CPU

Die CPU darf nicht vom An-
wender repariert werden.
Jeglicher Zugriff auf die
CPU führt zum Verlust der
Garantieansprüche.

Überhitzung

Zum Schutz vor Überhitzung
Ihres Computers dürfen die
Luftungsoffnung(en) nicht
während der Computer in
Betrieb ist verdeckt werden.

Informationen zur 
Wandmontage

Der Computer kann an einer
Wand befestigt werden. Das
System entspricht dem
VESA-Standard (FDMI) für
die Wandmontage (100 x
100 mm). Wenden Sie sich
diesbezüglich an ein Ser-
vice-Center, um Verlet-
zungen und
Beschädigungen am Com-
puter zu vermeiden.

Abb. 10 - Rückansicht

1. Rückwärtige Abdeckung des Kom-
ponentenfachs

2. Fuß

3. Luftungsoffnung

4. Transportöffnung

5. Abdeckung, hinter der sich der 
Anschluss für den drahtlosen USB-
Sender/Empfänger (für die optionale 
Funk-Tastatur/Maus) verbirgt

6. Sicherheitsschloß-Buchse

7. Akku (Optional)

8. Zwei serielle (COM) 
Schnittstellen

9. PS/2-Schnittstelle 
(Tastatur)

10. PS/2-Schnittstelle (Maus)

11. DC-Eingangsbuchse

12. 2 * USB 2.0 Anschlüsse

13. RJ-45 LAN-Buchse

1

3

2

8

3

4

5

8

7

10

11

6

12 13

9
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Grafikfunktionen
Wenn der Grafiktreiber installiert ist, können Sie bei
Windows im Einstellfenster Anzeige und/oder in der Intel®
Steuerung für Grafik und Medien die Anzeigegeräte
wechseln und Anzeigeoptionen konfigurieren.

So öffnen Sie in Windows das Einstellfenster Anzeige:
1. Klicken Sie Start (Menü) und klicken Sie Systemsteuerung (oder 

zeigen auf Einstellungen und klicken Systemsteuerung).

2. Klicken Sie auf Anzeige (Symbol) - im Kategorie Darstellung und 
Anpassung.

3. Klicken Sie auf Bildschirmauflösung anpassen/Auflösung 
anpassen.

Oder
4. Sie können auch mit der rechten Maustaste auf den Arbeitsplatz 

klicken und dann die Option Bildschirmauflösung wählen.

5. Wählen Sie aus dem Drop-down-Menü die Bildschirmauflösung 
.

6. Klicken Sie auf Erweiterte Einstellungen .

So rufen Sie die Intel® Steuerung für Grafik und Medien
auf:
1. Klicken Sie Start (Menü) und klicken Sie Systemsteuerung (oder 

zeigen auf Einstellungen und klikken Systemsteuerung).

2. Klicken Sie auf  Intel® Grafik und Medien (Symbol) in der 
Klassischen Ansicht.

Oder
3. Klicken Sie mit der rechten Maustaste auf den Desktop und dann 

aus dem Menü die Option Grafikeigenschaften wählen.

Oder
4. Klicken Sie auf das Symbol   im Infobereich auf der 

Taskleiste und dann aus dem Menü die Option 
Grafikeigenschaften wählen.

5. Wählen Sie den Anwendungsmodus (Standardmodus, 
Erweiterter Modus oder Assistentenmodus) und klicken Sie auf 
OK.

1
2

2
1

Abb. 11 - Einstellfenster Anzeige 

3

3

Abb. 12
Intel® Steuerung für 
Grafik und Medien 
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Audiofunktionen
Die Audioeinstellungen können Sie bei Windows durch An-
klicken des Soundsymbols  oder des Realtek HD Audio
Manager -Symbols /  im Infobereich/in der System-
steuerung aufrufen (wenn Sie mit der rechten Maustaste auf
das Symbol  im Infobereich klikken, wird das Audiomenü
aufgerufen).

Die Lautstärke kann auch über das Lautstärke-Symbol in der
Taskleiste oder mit den Bildschirmtasten eingestellt werden
(siehe Seite 35).

Einrichten der Audioaufnahme
Wenn Sie auf Ihrem Computer Audioaufnahmen mit optimaler
Qualität machen möchten, führen Sie die folgenden Schritte aus:

1. Klicken Sie auf Start (Menü) und klicken Sie auf Systemsteue-
rung (oder zeigen Sie auf Einstellungen und klicken Sie auf Sys-
temsteuerung).

2. Klicken Sie auf Realtek HD Audio-Manager (oder klicken Sie mit 
der rechten Maustaste auf das Symbol  im Infobereich, und 
wählen Sie Sound-Manager).

3. Klicken Sie bei Mikrofon (Registerkarte) auf Mikrofoneffekt. 
Klicken Sie dann auf Rauschunterdrückung (Schaltfläche), oder 
regeln Sie die Lautstärke bei Aufnahmelautstärke auf ca. 60. So 
erhalten Sie eine optimale Aufnahmequalität.

4. Klicken Sie auf OK, um das Fenster Sound  zu schließen.

Audio-Setup für HDMI
HDMI unterstützt Video- und Audiosignale. Es gibt Fälle, in
denen Sie in der Systemsteuerung bei Sound manuell die
HDMI-Audioausgabe konfigurieren müssen.

1. Klicken Sie auf Start (Menü) und klicken Sie auf Systemsteue-
rung (oder zeigen Sie auf Einstellungen und klicken Sie auf Sys-
temsteuerung).

2. Klicken Sie auf Sound  (Hardware und Sound).

3. Klicken Sie auf Wiedergabe (Registerkarte).

4. Das Wiedergabegerät wird ausgewählt.

5. In manchen Fällen muss das Audiogerät ausgewählt werden und 
klicken Sie Als Standard (Schaltfläche).

6. Klicken Sie doppelt auf das Gerät, um die Registerkarten 
aufzurufen.

7. Konfigurieren Sie in den Registerkarten die HDMI-Einstellungen.

8. Klicken Sie auf OK, um das Fenster Sound  zu schließen.

Abb. 13 
Realtek HD Au-
dio-Manager - 

Aufnahmekonfi
guration

Abb. 14
Klangwieder-
gabeoptionen
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Energieverwaltungsfunktionen
Die Energieoptionen von Windows ermöglichen Ihnen die Konfiguration der Optionen für das Energiemanagement des Com-
puters. Sie können Strom sparen, indem Sie Energiesparpläne erstellen, die Netzschalter-, Energiespartasten- und im lin-
ken Menü den Anzeige- und Energiesparmodus festlegen. Beachten Sie, dass sich die Energiesparpläne
(Energiesparmodus) auf die Computerleistung auswirken.

Wählen Sie einen bestehenden Plan aus, oder klicken Sie im linken Menü auf Energiesparplan erstellen, und wählen Sie
die Optionen, um einen neuen Plan zu erstellen. Klicken Sie auf Energieplaneinstellungen ändern, und klicken Sie auf Er-
weiterte Energieeinstellungen ändern, um weitere Optionen für die Konfiguration aufzurufen.

Abb. 15 - Energieoptionen
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Installation der Treiber
Die Disc Device Drivers & Utilities + User's Manual enthält
die Treiber und Hilfsprogramme, die für das einwandfreie
Funktionieren des Computers notwendig sind.  Legen Sie die
mitgelieferte Disc und klicken Sie auf Install Drivers
(Schaltfläche), oder klicken Sie auf Option Drivers (Schalt-
fläche), um das optionale Treibermenü aufzurufen. Installie-
ren Sie die Treiber in der in Tabelle 5 angegebenen
Reihenfolge. Markieren Sie die Treiber, die installiert wer-
den sollen (notieren Sie zum späteren Nachlesen die Treiber,
die Sie installiert haben). Hinweis: Muss ein Treiber neu in-
stalliert werden, sollten Sie den alten Treiber zunächst dein-
stallieren.

Manuelle Treiber-Installation
Klicken Sie in der Anwendung Drivers Installer auf die
Schaltfläche Browse CD/DVD und navigieren Sie zu der
ausführbaren Datei in dem Ordner für Ihren Treiber.

Wenn während des Installationsvorgangs das Fenster Neue
Hardware gefunden erscheint, klicken Sie auf Abbrechen,
und befolgen Sie dann die Installationsanweisungen.

Windows Update
Nachdem Sie alle Treiber installiert haben, sollten Sie die
Funktion Windows Update aktualisieren, um immer die
neuesten Sicherheits-Updates usw. zu erhalten (die Updates
enthalten die neuesten Fehlerbehebungen von Microsoft).

Tabelle 5 - Installationsvorgang

Treiber (Windows 7 mit SP1)* Seite#

Chipsatz Seite 46

Video Seite 46

Network (LAN) Seite 46

ExpressCard/Kartenleser Seite 46

Hotkey AP Seite 46

USB 3.0 Seite 46

Intel MEI Seite 46

Audio Seite 46

PC-Kamera (Option) Seite 47

Wireless-LAN-Modul (Option) Seite 49

WiDi Seite 50

Bluetooth-Modull (Option) Seite 50

TPM Seite 52

Windows Update aktivieren (siehe links)

*Alle mitgelieferten Treiber sind für Windows 7 mit Service Pack 1 
vorgesehen.
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Chipsatz
1. Klicken Sie auf 1.Install Chipset Driver > Ja.
2. Klicken Sie auf Weiter > Ja > Weiter > Weiter.
3. Klicken Sie auf Fertig stellen, um den Computer neu zu 

starten.

Video
1. Klicken Sie auf 2.Install VGA Driver > Ja.
2. Klicken Sie auf Weiter > Ja > Weiter > Weiter.
3. Klicken Sie auf Fertig stellen, um den Computer neu zu 

starten.

LAN
1. Klicken Sie auf 3.Install LAN Driver > Ja.
2. Klicken Sie auf Installieren > Fertig stellen.
3. Nun können die Netzwerkeinstellungen konfiguriert 

werden.

ExpressCard/Kartenleser
1. Klicken Sie auf 4.Install Cardreader Driver > Ja.
2. Klicken Sie auf Installieren > Fertig stellen.

Hotkey AP
1. Klicken Sie auf 5.Install Hotkey AP > Yes.
2. Klicken Sie auf  Next > Next.
3. Klicken Sie auf  Finish > Finish um den Computer neu 

zu starten.

USB 3.0
1. Klicken Sie auf 6.Install USB 3.0 Driver > Ja.
2. Klicken Sie auf Weiter.
3. Klicken Sie auf die Schaltfläche Ich bin mit den 

Bedingungen der Lizenzvereinbarung einverstanden, 
und dann auf  Weiter.

4. Klicken Sie auf Weiter > Installieren.
5. Klicken Sie auf Fertig stellen.

Intel MEI
1. Klicken Sie auf 7.Install MEI Driver > Ja.
2. Klicken Sie auf Weiter > Ja > Weiter > Weiter.
3. Klicken Sie auf Fertig stellen.

Audio
1. Klicken Sie auf 8.Install Audio Driver > Ja.
2. Klicken Sie auf Weiter
3. Klicken Sie auf Fertig stellen, um den Computer neu zu 

starten.


Treiberinstallation und Stromversorgung

Während die Treiber installiert werden, muss der Computer
über den AC/DC-Adapter mit Strom versorgt werden. Einige
Treiber benötigen für den Installationsvorgang sehr viel Strom.
Wenn der Akku nicht mehr über genügend Strom verfügt, kann
sich das System während der Installation ausschalten, was zu
Systemfehlern führen kann (das ist kein Sicherheitsproblem,
und der Akku ist innerhalb von einer Minute wieder aufladbar).
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PC-Kamera (Option)
Schalten Sie das Kameramodul ein, bevor Sie mit der Installa-
tion des Treibers beginnen (verwenden Sie dazu die Ein/Aus-
Taste auf dem Bildschirm (OSD) - siehe Seite 35).

Wenn die PC-Kameraanwendung läuft, leuchtet die LED
links neben der Kamera rot (siehe "Systemübersicht: Ansi-
cht von vorne" auf Seite 33).

Installieren des PC-Kamera-Treibers 
1. Klicken Sie auf Option Drivers (Schaltfläche).
2. Klicken Sie auf 1.Install Webcam Driver > Ja.
3. Klicken Sie auf Fertig stellen, um  das Computer neu zu 

starten.
Oder
Klicken Sie auf Weiter > Fertig stellen.

4. Starten Sie die Kameranwendung über die Verknüpfung 
auf dem Desktop (wenn die Hardware ausgeschaltet 
wurde, können Sie sie mit der Tastenkombination Fn + 
F10 wieder einschalten).

Audio-Setup für die PC-Kamera
Wenn Sie mit der Kamera Video- und Audio-Daten
aufnehmen möchten, müssen Sie bei Windows die Optionen
für die Audio-Aufnahme einstellen.

1. Klicken Sie Start (Menü) und klicken Sie Systemsteuerung (oder 
zeigen auf Einstellungen und klicken Systemsteuerung).

2. Klicken Sie auf Sound  (Hardware und Sound).

3. Klicken Sie auf Aufnahme (Registerkarte).

4. Klicken Sie mit der rechten Maustaste auf Mikrofon (Realtek High 
Definition Audio) und stellen Sie sicher, dass die Funktion nicht 
deaktiviert ist.

5. Klicken sie doppelt auf Mikrofon (oder wählen Sie aus dem 
Rechtsklick-Menü die Option Eigenschaften).

6. Klicken Sie auf Pegel (Registerkarte), und regeln Sie die 
Einstellungen von Mikrofon and Mikrofonverstärkung.

7. Klicken Sie auf OK und schließen Sie alle Fenster.

8. Starten Sie die Kameranwendung über die Verknüpfung auf dem 
Desktop.

9. Rufen Sie das Menü Geräte auf, und wählen Sie Mikrofon 
(Realtek....) (es sollte mit einem Häkchen gekennzeichnet sein).

10. Rufen Sie das Menü Aufnahme auf, und wählen Sie Audio 
aufnehmen (es sollte mit einem Häkchen gekennzeichnet sein).

11. Für eine sehr gute Aufnahmequalität sollten Sie beim Realtek HD 
Audio-Manager die Option Rauschunterdrückung aktivieren 
(siehe "Einrichten der Audioaufnahme" auf Seite 43).


PC-Kameraanwendung und Stromsparmodi

Wenn der Computer bei laufender Kameraanwendung in
einen Stromsparmodus (Standby oder Ruhezustand) wech-
selt, wird das Programm gestoppt. Wenn der Computer
wieder aktiviert wurde, muss es neu gestartet werden.
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Kameranwendung
Die Kameranwendung ist ein Videowiedergabegerät für die
allgemeine Videowiedergabe und -prüfung. Die Videoda-
teien werden im Format .avi aufgenommen.

1. Starten Sie die Kameranwendung über die Verknüpfung auf dem 
Desktop (es wird empfohlen, vor der Aufnahme die 
Aufnahmedatei einzustellen - siehe "Einstellen der 
Aufnahmedatei" weiter unten).

2. Gehen Sie zum Menü Aufnahme (wenn Sie Ton aufnehmen 
möchten, siehe "Audio-Setup für die PC-Kamera" auf Seite 47) 
und wählen Sie dann Aufnahme starten.

3. Klicken Sie auf OK (der Speicherort der Datei wird im Pop-up-
Fenster angezeigt), um die Aufzeichnung zu starten, und auf Esc, 
um sie zu stoppen (Die Datei können Sie sich dann mit Windows 
Media Player ansehen).

Einstellen der Aufnahmedatei
Vor dem Aufnehmen von Videodateien können Sie im Menü
Datei die Option Aufnahmedatei einst. wählen und den
Dateinamen und den Speicherort für die aufgenommene
Datei festlegen (dadurch können Sie vermeiden, dass andere
Dateien versehentlich überschrieben werden). Wählen Sie
den Namen und den Speicherort, und klicken Sie auf Öffnen.
Legen Sie dann bei "Capture file size:" die Größe der
Aufnahmedatei fest, und klicken Sie auf OK. Nun können
Sie den Aufnahmevorgang wie oben beschrieben starten.

Reduzieren der Videodateigröße
Beachten Sie, dass die Dateien beim Aufnehmen von Video-
dateien mit großer Auflösung sehr viel Speicherplatz in An-
spruch nehmen. Prüfen Sie nach dem Aufnehmen des Videos
die Dateigröße (klicken Sie mit der rechten Maustaste auf die
Datei, und wählen Sie Eigenschaften) und den freien
Speicherplatz auf der Festplatte (klicken Sie auf Computer,
danach mit der rechten Maustaste auf die Festplatte, und
wählen Sie dann Eigenschaften). Wenn nötig, können Sie
die aufgenommene Videodatei auf einem austauschbaren
Datenträger speichern, z. B. CD, DVD oder USB-Speicher.

Beachten Sie, dass das Betriebssystem Windows mindestens
15GB freien Speicher auf der Systempartition Laufwerk C:
benötigt. Um Probleme mit dem Betriebssystem zu ver-
meiden, sollten Sie die Videodateien nicht auf Laufwerk C:
speichern, die Dateigröße beschränken oder die Auflösung
der Videoaufnahmen verringern.

So verringern Sie die Größe der Videoauflösung:
1. Starten Sie die Kameranwendung über die Verknüpfung auf dem 

Desktop.

2. Gehen Sie zu Optionen, und wählen Sie dort Video Aufnahme 
konfigurieren....

3. Klicken Sie das Feld Ausgabegröße an, und wählen Sie eine 
niedrigere Auflösung, um die Größe der Aufnahmedateien zu 
verringern.
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Wireless-LAN-Modul (Option)
Schalten Sie das Wireless-LAN-Modul ein, bevor Sie mit der
Installation des Treibers beginnen (verwenden Sie dazu die
Ein/Aus-Taste auf dem Bildschirm (OSD) - siehe Seite 35).

Installieren des WLAN-Treibers
Führen Sie die folgenden Schritte aus:

WLAN und Bluetooth Combo (Intel)
1. Klicken Sie auf Option Drivers (Schaltfläche).
2. Klicken Sie auf 2.Install WLAN Driver > Ja.
3. Klicken Sie auf Weiter > Weiter.
4. Klicken Sie auf die Schaltfläche Ich akzeptiere die 

Bedingungen der Lizenzvereinbarung, und dann auf  
Weiter.

5. Klicken Sie auf Standard (Schaltfläche) oder 
Benutzerdefiniert (Schaltfläche).

6. Klicken Sie auf Installieren > Fertig stellen.

WLAN (andere Hersteller) 
1. Klicken Sie auf Option Drivers (Schaltfläche).
2. Klicken Sie auf 2.Install WLAN Driver > Ja.
3. Wählen Sie eine Sprache und klicken auf Weiter.
4. Klicken Sie auf Weiter > Installieren.
5. Klicken Sie auf Fertig stellen, um den Computer neu zu 

starten.

WLAN und Bluetooth 4.0 Combo (andere Hersteller) 
1. Klicken Sie auf Option Drivers (Schaltfläche).
2. Klicken Sie auf 2.Install WLAN Driver > Ja.
3. Klicken Sie auf Weiter.
4. Klicken Sie auf Fertig stellen, um den Computer neu zu 

starten.

Anschließen an ein Drahtlosnetzwerk
Das Betriebssystem ist die Standardeinstellung für die Steue-
rung des Wireless LAN bei Windows. Stellen Sie sicher, dass
das Wireless-LAN-Modul aktiviert ist.

1. Klicken Sie auf das Wireless LAN-Symbol  in der Taskleiste, 
klicken Sie dann doppelt auf einen Zugriffspunkt, zu dem die Ver-
bindung hergestellt werden soll, oder klicken Sie auf Netzwerk- 
und Freigabecenter öffnen, wenn im Taskleisten-Menü nicht das 
Netzwerk angezeigt wird, zu dem die Verbindung hergestellt wer-
den soll (es erscheint eine Liste mit Optionen zum Ändern von 
Einstellungen und Erstellen eines neuen Netzwerks).

2. Möglicherweise müssen Sie für die Verbindung zu einem 
Zugriffspunkt einen Sicherheitsschlüssel eingeben.

3. Klicken Sie die Position des Netzwerks an (z. B. Heimnetzwerk, 
Arbeitsplatznetzwerk oder Öffentliches Netzwerk).

4. Klicken Sie auf “Einstellungen im Netzwerk- und 
Freigabecenter anzeigen oder ändern”, um weitere Optionen für 
die Verbindung aufzurufen.

5. Klicken Sie auf das Taskleistensymbol , um die aktuell 
angeschlossenen Netzwerke anzuzeigen.

6. Wenn Sie die Verbindung zum Drahtlosnetzwerk trennen 
möchten, klicken sie auf das Wireless LAN-Symbol  in der 
Taskleiste, dann auf die aktive Verbindung und dann auf Trennen 
(Schaltfläche).
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Intel® Wireless Display Applica-
tion
Mit der Intel® Wireless Display Application (dafür benö-
tigen Sie das Intel® Centrino WLAN/Combo-Modul)
können Sie, wenn Sie einen kompatiblen Videoadapter
(separat erhältlich) verwenden, die Inhalte des Notebook-
Monitors auf einem anderen Monitor (z. B. HDTV) ohne
Kabelverbindung wiedergeben. Sie können dann auf dem
TV/externen Monitor ohne HDMI- oder A/V-Kalbelver-
bindung Games spielen, im Internet browsen oder Videos
oder Fotos ansehen.

Bevor Sie die Intel® WiDi-Anwendung konfigurieren, müs-
sen Sie den kompatiblen Adapter an den Monitor/die Laut-
sprecher anschließen und einrichten. Schließen Sie den
Adapter mit einem HDMI- oder A/V-Kabel an, und schalten
Sie den Monitor ein (wenn Sie ihn mit den Lautsprechern
einrichten möchten, schließen Sie ihn mit den Kabeln des
Adapters an den drahtlosen Lautsprecheradapter an).
Schalten Sie dann den Monitor auf den entsprechenden
Eingangskanal (Angaben dazu finden Sie in der Dokumenta-
tion, die Sie zusammen mit dem kompatiblen Adapter er-
halten haben).

Intel® WiDi enthält auch Intel® Wireless Music, mit dem
Sie drahtlos den Ton von Ihrem Computer auf den die mit
einem kompatiblen drahtlosen Lautsprecheradapter (separat
erhältlich) angeschlossenen Lautsprecher wiedergeben
können.

Installation der Intel® WiDi Application
1.  Klicken Sie auf Option Drivers (Schaltfläche).
2. Klicken Sie auf 3.Install WiDi AP > Ja.
3. Klicken Sie auf Weiter.
4. Klicken Sie auf die Schaltfläche, um die 

Lizenzvereinbarung anzunehmen und klicken Sie dann auf 
Weiter.

5. Klicken Sie auf Fertig stellen.

Konfiguration der Intel® WiDi Applica-
tion
1. Klicken Sie auf Start > Alle Programme > Intel Corporation > 

Intel(R) Wireless Display > Intel(R) Wireless Display, oder klik-
ken Sie dann doppelt auf das Symbol  auf den Desktop.

2. Klicken Sie auf Ich erkläre mich mit den Bedingungen dieses 
Lizenzvertrags einverstanden (Schaltfläche).

3. Die Anwendung sucht zunächst nach angeschlossenen 
kompatiblen Adaptern (Sie können auch auf die Schaltfläche 
Nach verfügbaren Adaptern suchen klicken, um Intel My WiFi 
Technology zu aktivieren).

4. Wählen Sie einen der angezeigten Adapter aus, und klicken Sie 
auf Verbinden.

5. Sie werden nun aufgefordert, den 4-stelligen Sicherheitscode 
einzugeben, der auf dem externen TV-Monitor angezeigt wird.

6. Geben Sie den Code für den Videoadapter ein und klicken Sie auf 
Weiter.

7. Sie werden nun aufgefordert, einen Namen für den Videoadapter 
einzugeben und klicken Sie auf Weiter.

8. Klicken Sie auf Fertig, um den Vorgang abzuschließen.
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Bluetooth-Modul (Option)
Schalten Sie das Bluetooth-Modul ein, bevor Sie mit der In-
stallation des Treibers beginnen (verwenden Sie dazu die Ein/
Aus-Taste auf dem Bildschirm (OSD) - siehe Seite 35).

Installieren des Bluetooth-Treibers
Führen Sie die folgenden Schritte aus:

WLAN und Bluetooth Combo (Intel)
1. Klicken Sie auf Option Drivers (Schaltfläche).
2. Klicken Sie auf 4.Install Combo BT Driver > Ja.
3. Klicken Sie auf Weiter > Weiter.
4. Klicken Sie auf die Schaltfläche, um die Lizenzvereinbarung 

anzunehmen und klicken Sie dann auf Weiter.
5. Klicken Sie auf Weiter > Fertig stellen.

WLAN und Bluetooth 4.0 Combo (andere Hersteller) 
1. Klicken Sie auf Option Drivers (Schaltfläche).
2. Klicken Sie auf 4.Install Combo BT Driver > Ja.
3. Klicken Sie auf Weiter.
4. Klicken Sie auf Fertig stellen > Ja, um den Computer neu 

zu starten.

Bluetooth-Konfiguration

Richten Sie Ihr Bluetooth-Gerät so ein, dass 
der Computer es erkennen kann
1. Schalten Sie Ihr Bluetooth-Gerät (z. B. PDA, Mobiltelefon) ein.

2. Schalten Sie das Gerät in den Erkennbar-Modus (eine 
Beschreibung dazu finden Sie in der dazugehörigen 
Dokumentation).

Einschalten des Bluetooth-Moduls
1. Schalten Sie das Bluetooth-Modul mit der Ein/Aus-Taste auf dem 

Bildschirm (OSD) ein.

2. In der Taskleiste erscheint das Bluetooth-Symbol .

3. Führen Sie dann einen der folgenden Schritte aus, um das 
Fenster Bluetooth-Geräte aufzurufen.

• Klicken Sie doppelt auf das Symbol , um das Fenster Blu-
etooth-Geräte aufzurufen.

• Klicken/klicken Sie mit der rechten Maustaste auf das Symbol 
 und wählen Sie eine Option aus dem Menü.

Bluetooth-Hilfe
Klicken Sie auf Start, wählen Sie Hilfe und Support, und
geben Sie in das Feld Suchen das Wort Bluetooth ein. Klik-
ken Sie dann auf das Lupen-Symbol. Sie erhalten dann wei-
tere Informationen zur Bluetooth-Übertragung.
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TPM (Trusted Platform Module)
Bevor Sie die TPM-Funktionen einrichten, müssen Sie die
Sicherheitsplattform initialisieren.

Aktivieren der TPM-Funktionen
1. Starten Sie das Notebook neu.

2. Rufen Sie das Aptio Setup Utility auf, indem Sie während des 
POST-Vorgangs auf F2 drücken.

3. Wählen Sie mit den Pfeiltasten das Menü Security.

4. Wählen Sie TPM Configuration und drücken Sie auf die 
Eingabetaste.

5. Wählen Sie TPM Support und drücken Sie auf die Eingabetaste. 
Wählen Sie Enable und drücken Sie auf die Eingabetaste.

6. Wählen Sie TPM State, drücken Sie auf die Eingabetaste und 
wählen Sie Enable (Aktivieren), um den TPM Status auf Aktiviert 
zu setzen. Sie müssen anschließend auf F4 drücken, um die 
Änderungen zu speichern und den Computer neu zu starten.

7. Drücken Sie beim Neustart des Computers auf F2, um das BIOS 
erneut aufzurufen und gehen Sie zum Menü TPM Configuration.

8. Wählen Sie Pending TPM operation (Laufende TPM Operation), 
drücken Sie auf die Eingabetaste und wählen Sie die benötigte 
Option aus (wenn Sie TPM initialisieren, sollten Sie Enable Take 
Ownership (Besitz übernehmen aktivieren) auswählen). Sie 
müssen anschließend auf F4 drücken, um die Änderungen zu 
speichern und den Computer neu zu starten.

9. Sie können jetzt den TPM Treiber installieren und anschließend 
den TPM initialisieren.

Installieren des TPM-Treibers
1. Klicken Sie auf Option Drivers (Schaltfläche).
2. Klicken Sie auf 5.Install TPM Driver > Ja.
3. Klicken Sie auf Installieren > Weiter.
4. Klicken Sie auf die Schaltfläche, um die Lizenzvereinbarung 

anzunehmen und klicken Sie dann auf Weiter.
5. Klicken Sie auf Weiter > Weiter >Installieren.
6. Klicken Sie auf Fertig stellen > Ja, um den Computer neu zu 

starten.
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Initialisieren des TPM
1. Die Software des TPM wird über den Eintrag Infineon Security 

Platform Lösung > Security Platform verwalten im Menü Start 
> Programme/Alle Programme gestartet.

2. Klicken Sie auf Benutzereinstellungen, und dann auf Ja, oder 
klicken Sie mit der rechten Maustaste auf das Symbol  im 
Benachrichtigungsbereich der Taskleiste und wählen Sie Security 
Platform-Initialisierung (oder klicken Sie auf die Sprechblase 
des Security Platform-Status in der Taskleiste).

3. Die Schnelle Initialisierung Methode wird automatisch für Sie 
ausgewählt (falls Sie die erweiterten Einstellungen Ihres 
Netzwerkadministrators verwenden müssen, wählen Sie 
Erweiterte Initialisierung).

4. Sie müssen einen Wechseldatenträger (z.B. ein USB Flash-
Laufwerk) zum Speichern von Kennwörtern und Daten verwenden 
(bewahren Sie das Medium an einem sicheren Ort auf, bevor Sie 
es benötigen).

5. Wählen Sie das zu benutzende Laufwerk aus der Liste aus und 
klicken Sie auf Weiter.

6. Wählen Sie die gewünschten Funktionen der Security Platform 
durch Anklicken der entsprechenden Kästchen aus.

7. Geben Sie ein Basic User Password (Benutzerkennwort) ein 
(und ein zweites Mal zur Bestätigung) und klicken Sie auf Weiter.

8. Klicken Sie auf Weiter, um die Einstellungen zu bestätigen.

9. Der Computer wird die Einstellungen anschließend initialisieren.

10. Klicken Sie auf Fertig stellen.

11. Klicken Sie auf die Registerkarten und Fenster, um die 
Einstellungen anzupassen.

12. Klicken Sie doppelt auf das Taskleisten-Symbol  zum Aufruf 
des Parametrierungstools der Infineon Security Platform oder 
klicken Sie mit der rechten Maustaste auf das Taskleisten-Symbol 

 und wählen eine Menüoption.

Parametrierungstool der Infineon Secu-
rity Platform
Mit dem Parametrierungstool der Infineon Security Platform
können Sie den TPM Status verwalten und überprüfen, Ihre
Kennwortinformationen verwalten und Ihre TPM Daten si-
chern und wiederherstellen. Da ein TPM normalerweise in
großen Unternehmen und Organisationen verwaltet wird, be-
nötigen Sie bei der Verwaltung der hiesigen Informationen
die Hilfe Ihres Systemadministrators.

Abb. 16
Assistent 

für die 
schnelle Ini-
tialisierung 
der Security 

Platform
Abb. 17 - Paramet-
rierungstool der 
Infineon Security 

Platform
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Fehlerbehebung

Problem Mögliche Ursache - Lösung

Die Module Wireless-LAN/
Bluetooth können nicht erkannt 
werden.

Die Module sind ausgeschaltet. Drücken Sie etwa 2 Sekunden lang (siehe Tabelle 2 auf Seite 
34) auf die Funktionsmenütaste, um das OSD-Menü zu öffnen. Prüfen Sie, ob das 
entsprechende OSD ein- oder ausgeschaltet ist.

Es ist kein Ton zu hören, wenn 
ein Anzeigegerät an den HDMI 
angeschlossen ist.

Der HDMI-Audioausgang wurde nicht konfiguriert. Siehe "Audio-Setup für HDMI" auf 
Seite 43.

Die mit der PC-Kamera
aufgenommenen Dateien
benötigen zu viel Speicherplatz.

Videodateien, die mit hoher Auflösung aufgenommen werden, erfordern sehr viel Speicherplatz.

Beachten Sie, dass das Betriebssystem Windows mindestens 15GB freien Speicher im
Laufwerk C: der Systempartition benötigt. Es wird empfohlen, die aufgenommenen
Videodateien in einem anderen Laufwerk als C: zu speichern, die Dateigröße der
Aufnahmedateien zu beschränken oder die Auflösung der Videos zu verringern (Optionen/
Options > Video Aufnahme konfigurieren.../Video Capture Pin... > Ausgabegröße).
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Technische Daten


Aktualität der technischen Daten

Die in diesem Anhang aufgeführten
technischen Daten sind zum Zeitpunkt
der Druckstellung richtig. Bestimmte
Elemente (insbesondere Prozessorty-
pen/-geschwindigkeiten) können im
Rahmen des Entwicklungsplans des Her-
stellers zwischenzeitlich geändert oder
aktualisiert werden. Detailinformationen
erhalten Sie bei Ihrem Servicezentrum.

Prozessor-Optionen

Intel® Core™ i7 Prozessor

i7-3770S (3,10GHz)

8MB L3 Cache, 22nm, DDR3-1600MHz,
TDP 65W

i7-3570S (3,10GHz)

6MB L3 Cache, 22nm, DDR3-1600MHz,
TDP 65W

Intel® Core™ i5 Prozessor

i5-3550S (3,00GHz), i5-3475S (2,90GHz), 
i5-3470S (2,90GHz), i5-3450S (2,80GHz), 
i5-3570T (2,30GHz)

6MB L3 Cache, 22nm, DDR3-1600MHz,
TDP 65W

Intel® Pentium® Prozessor

G640 (2,80GHz)

3MB L3 Cache, 22nm, DDR3-1066MHz,
TDP 65W

Intel® Celeron® Prozessor

G540 (2,50GHz)

2MB L3 Cache, 22nm, DDR3-1066MHz,
TDP 65W

Core Logic

Intel® HM61 Chipsatz

BIOS

AMI BIOS (48Mb SPI Flash-ROM)

Speicher

Zwei 204-Pin SODIMM-Sockel, 
Unterstützung von DDR3 1333/1600MHz 
Speicher

Speicher auf bis zu 8GB erweiterbar

Videoadapter

Intel Integrated GPU
(Die GPU ist vom Prozessor abhängig)

Intel® HD Graphics

Dynamische Frequenz (Intel Dynamic Video 
Memory Technology für bis zu 1,7GB)

Kompatibel mit MS DirectX® 10

Intel® HD Graphics 2500

Dynamische Frequenz (Intel Dynamic Video 
Memory Technology für bis zu 1,7GB)

Kompatibel mit MS DirectX® 10

Intel® HD Graphics 4000

Dynamische Frequenz (Intel Dynamic Video 
Memory Technology für bis zu 1,7GB)

Kompatibel mit MS DirectX® 11

LCD

21.5" (54,61cm) FHD

Speicher

(Werkseitige Option) Ein austauschbares 
optisches Laufwerk (12,7 mm Höhe) (Super 
Multi-Laufwekrsmodul oder kombiniertes 
Blu-Ray-Laufwerksmodul)

Eine Austauschbare SATA-2,5"-Festplatte 
(9,5mm Höhe)

Eine Austauschbare SATA-3,5"-Festplatte 
(25mm Höhe)
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Audio

High-Definition-Audio-kompatible 
Schnittstelle

2 eingebaute Lautsprecher

Eingebautes Mikrofon

Sicherheit

BIOS-Paßwort

Öffnung für Sicherheitsschloß (Typ 
Kensington)

TPM 1.2

Schnittstellen

Veir USB 2.0-Anschlüsse 

Zwei USB 3.0-Anschlüsse 

Ein HDMI-Eingangsanschluss

Ein HDMI-Ausgangsanschluss

Eine Lautsprecher/Kopfhörer-
Ausgangsbuchse

Eine Mikrofon-Eingangsbuchse

Zwei serielle (COM) Schnittstellen 

Zwei PS/2-Schnittstellen

Eine RJ-45-LAN-Buchse

Eine DC-Eingangsbuchse

Steckplätze

Ein Steckplatz für Wireless-LAN-Modul o  
Kombinierte Bluetooth und WLAN-Modul

Ein ExpressCard/54(34)-Steckplatz

Kartenleser

Festes Multi-in-1 Kartenleser-Modul

MMC (MultiMedia Card) / RS MMC

SD (Secure Digital) / Mini SD / SDHC/ 
SDXC

MS (Memory Stick) / MS Pro / MS Duo

Tastatur & Zeigegerät

(Werkseitige Option) RF USB-Tastatur/
Maus mit dem Sender/Empfänger

Kommunikation

1 Gbit Ethernet-LAN eingebaut

(Werkseitige Option) 2,0M FHD PC-
Kamera-Modul

WLAN/ Bluetooth Half Mini-Card Module:

(Werkseitige Option) Intel® Centrino® 
Wireless-N 2230 Wireless LAN (802.11b/g/
n) und Bluetooth 4.0

(Werkseitige Option) Wireless LAN 
(802.11b/g/n) (andere Hersteller)

(Werkseitige Option) Wireless LAN 
(802.11b/g/n) und Bluetooth 4.0 (andere 
Hersteller)

Stromversorgung

AC/DC-Adapter für den gesamten 
Spannungsbereich 

AC-Eingang: 100-240 V, 50-60Hz
DC-Ausgang: 19V, 6,3A (120W)

(Werkseitige Option) 6 Zellen-smart 
Lithium-Ionen-Akkupack, 62,16WH

Umgebungsbedingungen

Temperatur

In Betrieb: 5ºC – 35ºC
Bei Aufbewahrung: -20ºC – 60ºC

Relative Luftfeuchtigkeit

In Betrieb: 20 – 80 %

Bei Aufbewahrung: 10 – 90 %

Abmessungen  und Gewicht

525 (B) x 49 (T) x 418 (H) mm

Ca. 7kg (mit optischem Laufwerk)
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A propos de ce Guide Utilisateur Concis
Ce guide rapide est une brève introduction à la mise en route de votre système. l s’agit d’un supplément, et non pas d’une
alternative au Manuel de l’Utilisateur en Anglais complet au format Adobe Acrobat sur le disque Device Drivers & Utilities
+ User's Manual fourni avec votre ordinateur. Ce disque contient aussi les pilotes et utilitaires nécessaires au fonctionnement
correct de votre ordinateur (Remarque: La compagnie se réserve le droit de revoir cette publication ou de modifier son conte-
nu sans préavis).

Certains ou tous les éléments de l’ordinateur peuvent avoir été déjà installés. Si ce n’est pas le cas, ou si vous avez l’intention
de reconfigurer (ou réinstaller) des portions du système, reportez-vous au Manuel de l’Utilisateur complet. Le disque Device
Drivers & Utilities + User’s Manual ne contient pas de système d’exploitation.

Informations de réglementation et de sécurité
Prêtez attention aux avis réglementaires et informations de sécurité contenus dans le Manuel de l'Utilisateur se trouvant sur
le disque Device Drivers & Utilities + User’s Manual.

©  Août 2012

Marques déposées
Intel et Intel Core sont des marques déposées ou enregistrées d’Intel Corporation.
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Instructions d’entretien et 
d’utilisation
L’ordinateur est robuste, mais il peut toutefois être endomma-
gé. Afin d’éviter ceci, veuillez suivre ces recommandations :

• Ne le laissez pastomber. Ne l’exposez à aucun choc ou vibration.  
Si l’ordinateur tombe, le boîtier et d’autres éléments pourraient être 
endommagés.

• Gardez-le sec. Ne le laisser pas surchauffer. Tenez l’ordinateur et 
son alimentation externe à distance de toute source de chaleur. Il s’agit 
d’un appareil électrique. Si de l’eau ou tout autre liquide venait à 
pénétrer à l’intérieur de votre ordinateur, il pourrait être sérieusement 
endommagé.

• Evitez les interférences. Tenez l’ordinateur à distance de transforma-
teurs à haute capacité, moteurs électriques, et autres appareils généra-
teurs de champs magnétiques importants. Ceux-ci peuvent gêner ses 
performances normales et endommager vos données.

• Suivez les procédures appropriées d’utilisation de votre ordina-
teur. Arrêtez l’ordinateur correctement, et fermez tous vos pro-
grammes (n’oubliez pas d’enregistrer votre travail). N’oubliez pas 
d’enregistrer vos données régulièrement puisqu’elles peuvent être per-
dues si la batterie est vide.

• Notez que dans les ordinateurs ayant un logo fixé par dépôt électroly-
tique, le logo est recouvert par une protection adhésive. À cause de 
l’usure générale, cette protection adhésive se détériore avec le temps et 
le logo exposé peut former des angles coupants. Faites bien attention 
lorsque vous manipulez l'ordinateur, et évitez de toucher le logo fixé 
par dépôt électrolytique. En cas d’une telle usure, contactez votre 
centre de services.

Sécurité de l'alimentation et de la batterie
• Utilisez uniquement un adaptateur AC/DC agréé avec votre ordina-

teur. 
• Utilisez uniquement le cordon d’alimentation et les batteries indiqués 

dans ce manuel.
• Votre adaptateur AC/DC peut avoir été conçu pour les voyages inter-

nationaux mais il lui faut tout de même une source de courant régu-
lière et ininterrompue. Si vous n’êtes pas sûr des caractèristiques du 

réseau électrique local, consultez notre représentant de service ou la 
compagnie électrique locale.

• L’adaptateur AC/DC que vous utilisez, peut être à 2 broches ou à 3 
broches, comprenant une prise de terre. Cette prise de terre est un des 
éléments de sécurité importants, ne vous en passez pas ! Si une prise 
murale compatible n’est pas disponible, demandez à un électricien 
qualifié de vous en installez une. 

• Quand vous voulez débrancher le cordon d’alimentation, ne tirez pas 
sur le fil, mais attrapez la tête de la prise. 

• Assurez-vous que la prise murale et la (les) rallonge(s) que vous utili-
sez peuvent supporter la consommation électrique de tous les appa-
reils qui y sont reliées.

• Utilisez uniquement des batteries conçues pour votre ordinateur. Un 
mauvais type de batterie peut provoquer des explosions, des fuites et/
ou endommager votre ordinateur.

• Ne continuez pas d'utiliser une batterie qui est tombée, ou qui paraît 
endommagée (ex: tordue ou vrillée) d'une manière quelconque. Même 
si l'ordinateur continue de fonctionner avec la batterie en place, cela 
peut détériorer le circuit, pouvant déclencher un incendie.

• Rechargez les batteries en utilisant le système de l’ordinateur. Un 
rechargement incorrect peut provoquer l’explosion de la batterie.

• N’essayez jamais de réparer la batterie. Au cas où votre batterie aurait 
besoin d’être réparée ou changée, veuillez vous adresser à votre repré-
sentant de service ou à des professionnels qualifiés.

• Gardez les batteries endommagées hors de portée des enfants et débar-
rassez-vous en le plus vite possible. Veuillez toujours jeter les batte-
ries avec précautions. Les batteries peuvent exploser ou se mettre à 
fuire si elles sont exposées au feu ou si elles sont manipulées ou jetées 
d’une façon non appropriée.

• Gardez la batterie loin des appareils métalliques.
• Placez un morceau de scotch sur les contacts de la batterie avant de la 

jeter.
• Ne jetez pas les batteries dans le feu. Elles peuvent exploser. Consul-

tez la réglementation locale pour des instructions de recyclage pos-
sibles.

• Ne touchez pas les contacts de la batterie avec les mains ou avec des 
objects en métal.
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Précautions concernant les batteries poly-
mères
Notez les informations suivantes spécifiques aux batteries po-
lymères, et le cas échéant, celles-ci remplacent les informa-
tions générales de précaution sur les batteries.

• Les batteries polymères peuvent présenter une légère dilatation ou 
gonflement, mais cela est inhérent au mécanisme de sécurité de la bat-
terie et ne représente pas une anomalie.

• Manipulez les batteries polymères de façon appropriée lors de leur uti-
lisation. Ne pas utiliser de batteries polymères dans des environne-
ments présentant une température ambiante élevée, et ne pas stocker 
les batteries non utilisées pendant de longues périodes.

Révision
Si vous essayez de réparer l'ordinateur par vous-même, votre
garantie sera annulée et vous risquez de vous exposer et d'ex-
poser l'ordinateur à des chocs électriques. Confiez toute répa-
ration à un technicien qualifié, particulièrement dans les cas
suivants:

• Si le cordon d’alimentation ou l’adaptateur AC/DC est endommagé, 
abimé ou effiloché.

• Si votre ordinateur a été exposé à la pluie ou tout autre liquide.
• Si votre ordinateur ne fonctionne pas normalement bien que vous ayez 

suivi les instructions de mise en marche à la lettre.
• Si votre ordinateur est tombé par terre ou a été endommagé (si l'écran 

LCD est cassé, ne touchez pas le liquide car il contient du poison).
• Si une odeur inhabituel, de la chaleur ou de la fumée apparaissait sor-

tant de votre ordinateur.

Nettoyage
• Utilisez un chiffon propre et doux pour nettoyer l'ordinateur, mais 

n'appliquez pas d'agent de nettoyage directement sur l'ordinateur. 
• N’utilisez pas de produit de nettoyage volatil (des distillés pétrôle) ou 

abrasifs sur aucun des éléments de l’ordinateur.
• Avant de nettoyer l'ordinateur, retirez la batterie et assurez-vous que 

l'ordinateur est débranché de toute alimentation électrique externe, 
périphériques et câbles (y compris les lignes téléphoniques).


Elimination de la batterie & avertissement

Le produit que vous venez d’acheter contient une batterie re-
chargeable. Cette batterie est recyclable. Quand elle n’est
plus utilisable, en fonction des lois locales des différents états
et pays, il peut être illégal de s’en débarrasser en la jetant
avec les ordures ménagères normales. Vérifiez auprès du
responsable local de l’élimination des déchets solides de
votre quartier pour vous informer des possibilités de recyclage
ou de la manière appropriée de la détruire.

Il existe un danger d’explosion si la batterie est remise de fa-
çon incorrecte. Remplacez-la uniquement par des batteries
de même type ou de type équivalent, recommandées par le
fabricant. Eliminez les batteries usagées selon les instructions
du fabricant.
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Guide de démarrage rapide
1. Enlevez tous les emballages.

2. Posez l’ordinateur sur une surface stable.

3. Connectez fermement les périphériques que vous souhaitez utiliser avec votre ordinateur (par ex. clavier et souris) à leurs ports respectifs.

4. Fixez l'adaptateur AC/DC à la prise d'entrée DC à l’arrière du LCD, branchez ensuite le cordon secteur à une prise murale, puis à l’adaptateur 
AC/DC.

5. Appuyez sur le bouton de mise en marche situé à l'avant de l'ordinateur pour allumer l'ordinateur.

Figure  1 -  Ordinateur avec un adaptateur AC/DC branché/Bouton de mise en marche

Logiciel système
Votre ordinateur peut être livré avec un logiciel système pré-installé. Si ce n’est pas le cas, ou si vous re-configurez votre
ordinateur pour un système différent, vous constaterez que ce manuel fait référence à Microsoft Windows 7.


Arrêt

Veuillez noter que vous devriez toujours éteindre votre ordinateur
en utilisant la commande Arrêter du menu Démarrer.

Cette précaution évite des problèmes de disque dur ou de système.

Bouton de mise en marche
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Carte du système : Vue de face

Figura 2 - Vue de face

1. Microphone

2. Caméra PC (optionnelle)

3. Indicateur LED indicateur de 
caméra PC

4. Écran LCD 

5. Bouton d'alimentation

6. Boutons de fonction

7. Indicateurs LED

8. Haut-parleur

4

3 1

5

2

7 6 88

57 6
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Indicateurs LED
Les indicateurs LED affichent des informations utiles sur
l’état actuel de votre ordinateur.

Tableau 1 - Indicateurs LED

Boutons de fonction 

Tableau 2  - Boutons de fonction 

Icône Couleur Description

Vert L’ordinateur est allumé

Vert 
clignotant

Le système est dans le mode de 
Veille configuré

Orange L'adaptateur AC/DC est branchée

Orange La batterie est en charge

Vide
La batterie est complètement char-

gée

Orange
clignotant

La batterie a atteint le niveau bas 
critique

Vert
Câble HDMI branché (si l'ordina-
teur est éteint) - voir la page 66

Vert
Le disque dur est en cours d'utilisa-

tion

Vert Le module LAN sans fil est allumé

Orange Le module Bluetooth est allumé

Icône de Hot-Key Description

Boutons Diminuer/Augmenter – Utilisez 
ces boutons pour diminuer/augmenter 

la luminosité ou le volume

Menu Permuter – Utilisez ce bouton 
pour commuter entre les menus lumi-

nosité et audio et utilisez les boutons ci-
dessus pour faire le réglage

Mode Permuter – Utilisez ce bouton 
pour choisir entre les modes d’entrée 

HDMI et ordinateur 
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Indicateurs d’affichage à l'écran (OSD)
Appuyez sur le bouton menu de fonction pendant environ deux secondes (voir le Tableau 2 à la page 62) pour faire apparaître
l'affichage à l’écran. L'OSD fournit des indicateurs visuels de luminosité, volume, appareil photo/WLAN/bascule d’alimen-
tation Bluetooth (les indicateurs d’appareil photo, WLAN et d’alimentation Bluetooth ne s'affichent que si les modules sont
inclus dans la configuration de votre achat) lorsque le Hotkey AP est installé (reportez-vous à "Hotkey AP" à la page 74).

Tableau 3 - Indicateurs d’affichage à l'écran (OSD)

Les indicateurs apparaîtront quand l’ordinateur démarre, ou reprend à partir de l’état d’économie d’énergie, afin d’afficher
l’état actuel d’alimentation de l’appareil photo et/ou du module Bluetooth. Si vous réglez la luminosité ou le volume, les in-
dicateurs OSD apparaîtront, et vous permettront également de régler l’état de l’alimentation de l'appareil photo et/ou du mo-
dule Bluetooth à l’aide de la souris en cliquant sur l'icône.

Icône de OSD Description

Diminution/Augmentation de la 
luminosité de l’écran LCD

Diminution/Augmentation du 
volume sonore

Activer/Désactiver le module LAN 
sans fil

Activer/Désactiver le module Blue-
tooth

Activer/Désactiver le module 
caméra PC
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Kit de clavier et souris USB sans 
fil optional
Il y a un kit de clavier et souris USB sans fil optional RF dis-
ponible pour cette série d'ordinateurs. Un port USB situé au
bas du capot arrière est conçu pour abriter l'émetteur-récep-
teur pour le kit de clavier et souris sans fil USB.

Figure 3
Kit de clavier 

et souris 
USB sans fil 

optional


Dongle et ports USB

Un dongle USB unique (qui agit comme un
émetteur-récepteur pour le clavier et la sou-
ris) est fourni avec le kit de clavier et souris.
Ce dongle peut être inséré dans un des
ports USB. Cependant, il est recommandé
d’utiliser le port USB spécialement prévu à
cet effet.


Port USB pour l'émetteur-récepteur sans fil

Notez que le port USB pour l'émetteur-récepteur sans fil est
conçu spécifiquement pour le kit de clavier et souris RF en
option fourni avec ce modèle uniquement.

Ne pas utiliser d'autres périphériques USB dans ce port.

Figure 4 - Port USB pour 
le kit clavier et souris 

sans fil

1
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Carte du système : Vue gauche Figure 5

Vue gauche

1. Socle

2. Lecteur de carte multi-en-1

3. Logement d'ExpressCard/
54(34)

4. 2 Ports USB 3.0

5. Prise d'entrée HDMI

6. Prise de sortie HDMI


Port USB 3.0

Les ports USB 3.0  sont colorés
en bleu. USB 3.0 transfèrera des
données bien plus rapidement que
l’USB 2.0, et il est compatible en
amont avec USB 2.0.

Lecteur de carte multi-en-1

Le lecteur de carte vous permet 
d'utiliser certaines des cartes de 
stockage numériques les plus res-
sentes. 

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SD-

HC/ SDXC
MS (Memory Stick) / MS Pro / MS 

Duo 

4

1

2

3

4

5

6

4
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Port d’entrée HDMI
Le port d’entrée HDMI vous permet d’afficher des sources externes telles que des lecteurs Blu-ray, DVD, boîtiers décodeur
et consoles de jeux, etc. sur votre écran d’ordinateur.

L’ordinateur n’a pas besoin d’être alimenté pour afficher la vidéo et l’audio provenant des sources externes. Tant que l’ordi-
nateur est branché à une source d’alimentation à travers l’adaptateur CA/CC (l’indicateur lumineux X est orange si l’ordina-
teur est connecté mais éteint), connectez simplement le câble HDMI du périphérique externe au port d’entrée HDMI et
l’ordinateur agira comme un périphérique d’affichage. Si l'ordinateur est alimenté par batterie, appuyez alors sur le bouton
d'alimentation sur l'ordinateur pour allumer l'ordinateur afin d’utiliser le port d’entrée HDMI.

Mode Permuter
Enfoncez et maintenez le bouton de changement de mode  pour basculer entre les modes d’entrée HDMI et ordinateur.
Si la « Source d’entrée HDMI » est affichée, vous pouvez utiliser n’importe quel périphérique HDMI connecté au port d’en-
trée HDMI de l’ordinateur. Une pression rapide sur le bouton permet d’allumer et éteindre l'affichage.

Le tableau suivant indique les fonctions lorsqu'un câble HDMI est branché au port d’entrée HDMI.

Tableau 4 - Fonctions de changement de mode lorsqu'un câble HDMI est branché

État de l'alimentation de 
l'ordinateur Icône HDMI 

Bouton de changement de 

mode 

(Appuyer et maintenir)

Bouton de changement 

de mode 

(Appui rapide)

 L'ordinateur est allumé (en utilisant 
l'adaptateur AC/DC / batterie)

Indique uniquement l'état de charge 
de la batterie

Bascule entre l’affichage de 
l’ordinateur et l’entrée HDMI

Allume/éteint l'affichage

L'ordinateur est éteint (mais il est 
branché à l'adaptateur AC/DC

Vert (lorsque le câble HDMI est 
branché et que le bouton de change-

ment de mode a été enfoncé et 
maintenu pour sélectionner l'entrée 

HDMI)

Bascule entre l’affichage de 
l’ordinateur et l’entrée HDMI

Allume/éteint l'affichage
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Carte du système : Vue droite 

Figure 6
Vue droite

1. Trou d’ejection d’urgence

2. Baie de périphérique optique

3. Prise de sortie casque

4. Prise d'entrée de micro-
phone

5. 2 * Ports USB 2.0

6. Socle


Ejection d’urgence du disque

Si vous devez éjecter manuelle-
ment un disque (par ex. suite à une
coupure de courant) vous pouvez
enfoncer l’extrémité d’un trombone
redressé dans le trou d’ejection
d’urgence. N’utilisez pas la pointe
d’un crayon, ou tout autre objet si-
milaire qui pourrait se casser et res-
ter coincé dans le trou.


Déplacer l'ordinateur

Nous conseillons fortement d'utiliser les deux mains
pour déplacer l'ordinateur. Vous pouvez tenir l'ordina-
teur par le socle d'une main, et de l'autre tenir le som-
met de l'écran LCD.

Il est recommandé de transporter l'ordinateur avec le
LCD face à vous afin d'éviter de rayer la surface contre
d'autres objets. Cependant, faites attention à ne pas
rayer le LCD avec des objets personnels, boucle de
ceinture ou bijoux etc. (une main tenant le socle et
l'autre tenant le sommet de l'ordinateur pour éviter de
le faire tomber accidentellement).

3

1

2

4
5

5

6
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Incliner l'écran
Il est possible d'incliner l'écran LCD afin d'obtenir le
meilleur angle de vision possible de l'écran sans reflets etc. 

1. Placez une main au sommet de l'ordinateur , et à l’aide de 
l'autre main ouvrez le socle  à un angle d'environ 15 degrés 
par rapport à la position verticale (le socle vous permettra de 
régler à l'angle approprié si vous le sortez et le laissez retourner 
en arrière).

Figure 7 -  Ajuster le socle

2. D’une main, appliquez une pression au sommet (au point ) de 
l'ordinateur (tout en maintenant le côté de l'autre main) pour 
pousser délicatement l'écran LCD vers le bas afin de l'incliner de 
l'angle de vue approprié (jusqu'à 50 degrés par rapport à la 
position verticale).

3. Placez une main au sommet de l'ordinateur (tout en maintenant le 
côté avec l'autre main) pour ramener l'ordinateur à sa position 
initiale.

Figure 8 - Incliner l'écran

1
2

Ajustez le socle pour
incliner l'ordinateur de
15 ° par rapport à la
position verticale. 

15°

1

2

3


Fonctionnement du DVD

Notez que même si l'ordina-
teur peut être incliné jusqu'à
un angle de 50 degrés par
rapport à la position verticale,
le lecteur de DVD-ROM fonc-
tionnera (c.-à-d. continuera à
tourner et à lire les DVD) jus-
qu'à un angle d'environ 35
degrés par rapport à la posi-
tion verticale.

Si vous rencontrez des pro-
blèmes lors de la lecture des
DVD, réglez l'angle d’inclinai-
son en conséquence.

Appliquez une
pression à partir
du haut de l'écran
pour régler le
socle vers l'exté-
rieur (jusqu'à 50 °
par rapport à la po-
sition verticale). 

50°

50°

3
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Carte du Système : Vue Arrière


CPU

Veuillez ne pas essayer d’ou-
vrir ou de forcer le processeur
UC de votre ordinateur. Le fait
d'accéder au CPU de quelque
manière que ce soit risque de
violer la garantie.

Surchauffe

Afin de ne pas causer une sur-
chauffe de votre ordinateur,
verifiez que rien ne bouche la
(les) ventilation(s) quand le
systeme est allume.

Informations sur la fixation 
murale

L'ordinateur peut être fixé au
mur pour l'affichage. Le sys-
tème répond au standard
VESA (FDMI)
(100mm*100mm) pour la fixa-
tion murale. Cependant, si
vous avez l'intension de fixer
le système au mur, contactez
votre service clientèle pour
obtenir les informations né-
cessaires afin de ne pas vous
blesser ou endommager l'or-
dinateur.

Figura 9 - Vue Arrière

1. Cache de composants arrière

2. Socle

3. Ventilation

4. Zone de poignée de transport

5. Couvercle de l’émetteur-récepteur 
USB sans fil (pour le kit de clavier 
et souris RF en option)

6. Fente de verrouillage de sécurité

7. Batterie (optionnelle)

8. 2 Ports Série (COM)

9. Port PS/2 (clavier)

10. Port PS/2 (souris)

11. Prise d’entrée DC

12. 2 * Ports USB 2.0

13. Prise réseau RJ-45

1

3

2

8

3

4

5

8

7

10

11

6

12 13

9
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Caractéristiques vidéo
Vous pouvez permuter les dispositifs d'affichage et configu-
rer les options d'affichage depuis le panneau de contrôle Af-
fichage dans Windows et/ou le Panneau de configuration
graphiques et média Intel, à partir du moment où le pilote
vidéo est installé.

Pour accéder au panneau de contrôle Affichage:
1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de confi-

guration (ou pointez sur Paramètres et cliquez sur Panneau de 
configuration).

2. Cliquez sur Affichage dan Apparence et personnalisation 
(catégorie).

3. Cliquez sur Modifier la résolution de l’écran/Ajuster la 
résolution.

OU
4. Autrement, vous pouvez cliquer-droit sur le bureau et sélectionner 

la Résolution d’écran.

5. Utilisez le menu déroulant pour sélectionner la résolution d’écran 
.

6. Cliquez sur Paramètres avancés .

Pour accéder au  panneau de configuration graphiques et
média Intel:
1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de confi-

guration (ou pointez sur Paramètres et cliquez sur Panneau de 
configuration).

2. Cliquez sur Graphiques et média Intel(R) en Affichage 
classique.

OU
3. Cliquez-droit sur le bureau et sélectionnez Propriétés 

graphiques dans le menu.

OU
4. Cliquez sur l'icône   dans la zone de notification de la barre 

des tâches et sélectionnez Propriétés graphiques dans le menu.

5. Sélectionnez le mode pour  l’application (Mode de Base, Mode 
Avancé ou Mode Assistant) et cliquez sur OK.

1
2

2
1

Figure 10 - Panneau de contrôle Affichage

3

Figure 11
Panneau de configuration 
graphiques et média Intel 3
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Caractéristiques audio
Vous pouvez configurer les options audio sur votre ordina-
teur à partir du panneau de configuration de Sons  dan
Windows, ou à partir de l'icône du Gestionnaire audio DD
Realtek /  dans la zone de notification/dans le Pan-
neau de Configuration (faites un clic droit sur l'icône  de
la zone de notification pour faire apparaître un menu audio).

Le volume peut également être réglé au moyen de l'icône
Haut-Parleur de la barre des tâches ou des indicateurs d’affi-
chage à l'écran (voir la page 63).

Configuration pour l'enregistrement audio
Pour enregistrer des sources audio sur votre ordinateur à la
qualité optimale suivez les instructions ci-dessous:

1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de confi-
guration (ou pointez sur Paramètres et cliquez sur Panneau de 
configuration).

2. Cliquez sur Gestionnaire audio HD Realtek  (ou faites un clic-
droit sur l'icône  de zone de notification et sélectionnez 
Gestionnaire de sons).

3. Cliquez sur Effet microphone (onglet) dans Microphone 
(onglet), puis cliquez pour sélectionner Suppression de bruit 
(bouton), ou ajuster le niveau du Volume d'enregistrement à 
environ 60, pour obtenir la qualité d'enregistrement optimale.

4. Cliquez sur OK pour fermer la fenêtre Son .

Configuration audio pour HDMI
HDMI supporte les signaux vidéo et audio. Dans certains
cas, il sera nécessaire d'aller au panneau de configuration
Son et configurer manuellement la sortie audio HDMI.

1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de confi-
guration (ou pointez sur Paramètres et cliquez sur Panneau de 
configuration).

2. Cliquez sur Son  (Matériel et audio).

3. Cliquez sur Lecture (onglet).

4. Le périphérique de lecture sera sélectionné.

5. Dans certains cas, il se peut que vous deviez sélectionner le 
périphérique audio et cliquez sur Par défaut (bouton).

6. Double-cliquez sur l'appareil pour accéder aux onglets du 
panneau de configuration.

7. Ajuster les paramètres HDMI à partir des onglets du panneau de 
configuration.

8. Cliquez sur OK pour fermer la fenêtre Son .

Figure 12 
Gestionnaire Au-
dio HD Realtek - 
Configuration de 
l'enregistrement

Figure 13 
Options de lecture 

du son
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Caractéristiques de gestion de l’alimentation
Le panneau de configuration Options d'alimentation de votre système Windows vous permet de configurer la gestion d'ali-
mentation de votre ordinateur. Vous pouvez économiser de l'énergie à l'aide de modes de gestion de l'alimentation et confi-
gurer les options pour le bouton d'alimentation, bouton de veille, mode Affichage et Veille dans le menu de gauche.
Remarquez que le mode de gestion d'économie d'énergie peut avoir un impact sur les performances de l'ordinateur.

Cliquez pour sélectionner l'un des modes existants, ou cliquez sur Créer un mode de gestion d'alimentation dans le menu
gauche et sélectionnez les options pour créer un nouveau mode. Cliquez sur Modifier les paramètres du mode et cliquez
sur Modifier les paramètres d'alimentation avancés pour accéder à plus d'options de configuration.

Figure 14 - Options d’alimentation
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Installation du pilote
Le disque Device Drivers & Utilities + User’s Manual
contient les pilotes et les utilitaires nécessaires pour un bon
fonctionnement de votre ordinateur. Insérez le disque  et cli-
quez sur Install Drivers (bouton) ou cliquez sur Option Dri-
vers (bouton) pour accéder au menu de pilote optionnel.
Installez les pilotes en respectant l'ordre indiqué dans le
Tableau 5. Cliquez pour sélectionner les pilotes que vous dé-
sirez installer (vous devez noter les pilotes lorsque vous les
installez). Remarque: Si vous devez réinstaller un pilote,
vous devez d’abord le désinstaller.

Installation manuelle du pilote
Cliquez le bouton Browse CD/DVD dans l'application Dri-
vers Installer et naviguer jusqu'au fichier exécutable dans le
dossier de pilote approprié.

Si l’assistant Nouveau matériel détecté apparaît pendant la
procédure d'installation, cliquez sur Annuler, et suivez la
procédure d'installation comme indiqué.

Windows Update
Après avoir installé tous les pilotes vérifiez que vous avez
activé Windows Update afin d'obtenir toutes les dernières
mises à jour de sécurité etc. (toutes les mises à jour incluront
les derniers correctifs de Microsoft). Tableau 5 - Procédure d'Installation

Pilote (Windows 7 avec SP1)* Page#

Chipset page 74

Vidéo (VGA) page 74

Réseau page 74

ExpressCard/Lecteur de carte page 74

Hot-Key page 74

USB 3.0 page 74

Intel MEI page 74

Son page 74

Caméra PC (option) page 75

Module LAN sans fil (option) page 77

WiDi page 78

Module Bluetooth (option) page 79

TPM page 80

Activer Windows Update (voir à gauche)

*Notez que tous les pilotes fournis sont pour Windows 7 avec Ser-
vice Pack 1.
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Chipset
1. Cliquez sur 1.Install Chipset Driver > Oui.
2. Cliquez sur Suivant > Oui > Suivant > Suivant.
3. Cliquez sur Terminer pour redémarrer votre ordinateur.

Vidéo
1. Cliquez sur 2.Install VGA Driver > Oui.
2. Cliquez sur Suivant > Oui > Suivant > Suivant.
3. Cliquez sur Terminer pour redémarrer votre ordinateur.

Réseau
1. Cliquez sur 3.Install LAN Driver > Oui.
2. Cliquez sur Installer > Terminer.
3. La carte réseau est maintenant prête à etre configurée.

ExpressCard/Lecteur de carte
1. Cliquez sur 4.Install CardReader Driver > Oui.
2. Cliquez sur Installer > Terminer.

Hotkey AP
1. Cliquez sur 5.Install Hotkey AP > Oui.
2. Cliquez sur Next > Next.
3. Cliquez sur Finish > Finish pour redémarrer votre 

ordinateur.

USB 3.0
1. Cliquez sur 6.Install USB 3.0 Driver > Oui.
2. Cliquez sur Suivant.
3. Cliquez sur le bouton J’accepte les termes de contrat de 

licence, puis cliquez sur Suivant.
4. Cliquez sur Suivant > Installer.
5. Cliquez surTerminer.

Intel MEI
1. Cliquez sur 7.Install MEI Driver > Oui.
2. Cliquez sur Suivant > Oui > Suivant > Suivant.
3. Cliquez sur Terminer.

Son
1. Cliquez sur 8.Install Audio Driver > Oui. 
2. Cliquez sur Suivant.
3. Cliquez sur Terminer pour redémarrer votre ordinateur.


Installation des pilotes et alimentation

Lors de l'installation des pilotes assurez-vous que votre ordi-
nateur est alimenté par l'adaptateur AC/DC connecté à une
source d'alimentation. Certains pilotes consomment une quan-
tité importante d'énergie pendant la procédure d'installation, et
si la capacité restante de la batterie n'est pas suffisante cela
peut provoquer l'arrêt du système et entraîner des problèmes
de système (à noter qu'il n'y a pas ici de problème de sécurité
en cause, et la batterie sera rechargeable en 1 minute).
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Caméra PC (Option)
Assurez-vous que la caméra PC est sous tension avant de lan-
cer la procédure d'installation du pilote (utilisez l'affichage à
l'écran (OSD) pour basculer l'alimentation sur le module de la
caméra PC - voir la page 63).

Lorsque l'application PC Camera s’exécute le indicateur
LED à gauche de l'appareil photo s'allumera en rouge (see re-
portez-vous à "Carte du système : Vue de face" à la
page 61).

Installation du pilote de la caméra PC
1. Cliquez sur Option Drivers (bouton).
2. Cliquez sur 1.Install Webcam Driver > Oui.
3. Cliquez sur Terminer pour redémarrer votre ordinateur.

Ou 
Cliquez sur Suivant > Terminer.

4. Exécutez l'application caméra à partir du raccourci sur le 
bureau (si le matériel est éteint utilisez la combinaison de 
touches Fn + F10 pour le rallumer).

Paramétrage audio de caméra PC
Si vous souhaitez capturer de la vidéo et du son avec votre
caméra, il est nécessaire de régler les options d'enregistre-
ment du son dans Windows.

1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de confi-
guration (ou pointez sur Paramètres et cliquez sur Panneau de 
configuration).

2. Cliquez sur Son  (Matériel et audio).

3. Cliquez sur Enregistrement (onglet).

4. Cliquez avec le bouton droit de la souris sur Microphone (Realtek 
High Definition Audio) et vérifiez que l'élément n'est pas désactivé.

5. Double-cliquez sur Microphone (ou sélectionnez Propriétés 
dans le menu contextuel).

6. Cliquez sur Niveaux (onglet), et réglez les curseurs Microphone 
et Ampli microphone au niveau requis.

7. Cliquez sur OK et fermez les panneaux de contrôle.

8. Exécutez l'application caméra à partir du raccourci sur le bureau.

9. Allez aux en-têtes de menu des Périphériques et sélectionnez 
Microphone (Realtek....) (il devrait y avoir une marque sur le côté)

10. Allez aux en-têtes de menu des Capture et sélectionnez Capture 
Audio (il devrait y avoir une marque sur le côté).

11. Pour obtenir la meilleure qualité d'enregistrement sonore activez 
Suppression du bruit dans le panneau de contrôle Gestionnaire 
audio HD Realtek (reportez-vous à "Configuration pour 
l'enregistrement audio" à la page 71).

Application PC Camera et États d’Économie d’énergie

Si l'ordinateur entre en mode Veille ou Veille prolongée pen-
dant l'exécution de l'application appareil photo, le pro-
gramme s'arrêtera, et devra être repris lorsque le système
sortira de l'état d'économie d'énergie.
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Application caméra
L'application caméra est un afficheur vidéo utile pour visua-
liser et tester les vidéos en général, et permet de capturer des
fichiers vidéo au format .avi.

1. Exécutez l'application caméra à partir du raccourci sur le bureau (il 
est recommandé de Définir le fichier de capture avant la capture 
- voir "Définir le fichier de capture" ci-dessous).

2. Allez à l'en-tête du menu Capture (si vous désirez capturer de 
l'audio, reportez-vous à "Paramétrage audio de caméra PC" à la 
page 75) et sélectionnez Démarrer la capture.

3. Cliquez sur OK (l'emplacement du fichier s'affichera dans la 
fenêtre contextuelle) pour démarrer la capture, et appuyez sur 
Echap pour arrêter (vous pouvez visionner le fichier en utilisant 
Windows Media Player).

Définir le fichier de capture
Avant de capturer des fichiers vidéo vous pouvez sélection-
ner l'option Définir le fichier de capture dans le menu Fi-
chier et définir le nom et l'emplacement du fichier avant de
capturer (ceci permettra d'éviter d'écraser accidentellement
des fichiers). Définissez le nom et l'emplacement puis cli-
quez sur Ouvrir, puis définissez la "Taille du fichier de cap-
ture :" et cliquez sur OK. Vous pouvez alors lancer le
processus de capture comme ci-dessus.

Réduire la taille des fichiers vidéo
Notez que la capture de fichiers vidéo à haute résolution né-
cessite un espace substantiel sur le disque  pour chaque fi-
chier. Après avoir enregistré la vidéo, vérifiez la taille du
fichier vidéo (cliquez avec le bouton droit de la souris sur le
fichier et sélectionnez Propriétés) et l'espace disponible res-
tant sur votre disque dur (allez à Ordinateur, cliquez avec le
bouton droit de la souris sur le disque dur, et sélectionnez
Propriétés). Si nécessaire, vous pouvez retirer le fichier vi-
déo enregistré sur un support amovible ex. CD, DVD ou mé-
moire Flash USB.

Notez que le système Windows nécessite un minimum de
15Go d'espace libre sur la partition système du lecteur C:.
Pour éviter tout problème système, il est recommandé d'en-
registrer le fichier vidéo capturé dans un autre emplacement
que le lecteur C:, limitez la taille du fichier de la vidéo cap-
turée ou réduisez la résolution vidéo.

Pour réduire la taille de sortie de la résolution vidéo:
1. Exécutez l'application caméra à partir du raccourci sur le bureau.

2. Allez à Options et faites défiler vers le bas pour sélectionner 
Video Capture Pin... (Broche de capture vidéo...).

3. Cliquez sur la liste déroulante Taille de sortie et sélectionnez une 
taille de résolution inférieure afin de diminuer la taille du fichier 
capturé.
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Module LAN sans fil (Option)
Assurez-vous que le module LAN sans file est sous tension
avant de lancer la procédure d'installation du pilote (utilisez
l'affichage à l'écran (OSD) pour basculer l'alimentation sur le
module LAN sans - voir la page 63).

Installation du pilote de LAN sans fil
Suivez les instructions ci-dessous:

Combo LAN sans fil et Bluetooth (Intel)
1. Cliquez sur Option Drivers (bouton).
2. Cliquez sur 2.Install WLAN Driver > Oui.
3. Cliquez sur Suivant > Suivant.
4. Cliquez sur le bouton J’accepte les termes de ce contrat 

de licence, puis cliquez sur Suivant.
5. Cliquez sur Par défaut (bouton) ou Personnalisée 

(bouton).
6. Cliquez sur Installer > Terminer.

LAN sans fil (tiers)  
1. Cliquez sur Option Drivers (bouton).
2. Cliquez sur 2.Install WLAN Driver > Oui.
3. Choisissez la langue que vous préférez, et cliquez sur  

Suivant > Suivant > Installer.
4. Cliquez sur Terminer pour terminer l'installation.

Combo LAN sans fil et Bluetooth 4.0(tiers)  
1. Cliquez sur Option Drivers (bouton).
2. Cliquez sur 2.Install WLAN Driver > Oui.
3. Cliquez sur  Suivant.
4. Cliquez sur Terminer pour terminer l'installation.

Se connecter à un réseau sans fil
Le système d'exploitation est le paramètre par défaut pour le
contrôle LAN sans fil dans Windows. Assurez-vous que le
module LAN sans fil est allumé.

1. Cliquez sur l’icône LAN sans fil  de la barre des tâches, puis 
double-cliquez sur un point d’accès auquel vous souhaitez vous 
connecter ou cliquez sur Ouvrir le Centre Réseau et partage si 
vous ne voyez pas le réseau auquel vous souhaitez vous connec-
ter dans le menu de la barre des tâches (une liste d’options appa-
raîtra vous permettant de modifier les paramètres, et de créer un 
nouveau réseau).

2. Vous devrez saisir un code d’authentification pour chaque point 
d’accès auquel vous souhaitez vous connecter.

3. Cliquez pour sélectionner le type de réseau (ex.: Réseau 
domestique, Réseau de bureau ou Réseau public).

4. Cliquez sur « Afficher ou modifier les paramètres dans le 
Centre Réseau et partage » pour accéder à plus d’options de 
connexion.

5. Cliquez sur l’icône  de la barre des tâches pour voir les réseaux 
en cours de connexion.

6. Pour déconnecter le réseau sans fil, cliquez sur l’icône LAN sans 
fil  de la barre des tâches, cliquez sur la connexion active puis 
cliquez sur Déconnecter (bouton). 
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Application Intel® Wireless 
Display
L’application Intel® Wireless Display (nécessite le proces-
seur Intel® Centrino WLAN/module Combo), conjointe-
ment avec un adaptateur vidéo compatible (vendu
séparément) vous permet d'afficher le contenu de l'écran du
notebook sur un autre affichage (par exemple HDTV), sans
la nécessité d’avoir des fils s'étendant à travers une pièce.
Vous pouvez ensuite jouer à des jeux, naviguer sur Internet,
afficher des vidéos ou des diaporamas de photos sur votre
écran TV/externe sans utiliser les câbles HDMI ou A/V.

Avant de configurer l’application Intel® WiDi vous aurez
besoin d’installer votre adaptateur compatible avec votre af-
fichage/haut-parleurs. Connectez l'adaptateur à l'aide d'un
câble HDMI ou A/V et allumez l’affichage (ou dans le cas
des haut-parleurs, connectez-les à l’adaptateur de haut-
parleur sans fil à l’aide des câbles fournis avec l'adaptateur),
puis paramétrez l'affichage sur le canal d’entrée approprié
(consultez la documentation fournie avec votre adaptateur
compatible pour plus de détails).

Intel® WiDi intègre également Intel® Wireless Music, qui
vous permet de diffuser sans fil l’audio de votre ordinateur
vers des haut-parleurs connectés à un adaptateur de haut-
parleur sans fil compatible (vendu séparément).

Installation de l’application Intel® WiDi
1. Cliquez sur Option Drivers (bouton).
2. Cliquez sur 3.Install WiDi AP > Qui.
3. Cliquez sur Suivant.
4. Cliquez sur le bouton pour accepter la licence, puis cliquez 

sur Suivant.
5. Cliquez sur Terminer.

Configuration de l’application Intel® 
WiDi
1. Cliquez sur Démarrer > Tous les programmes > Intel Corpora-

tion > Intel(R) Wireless Display > Intel(R) Wireless Display, ou 
double-cliquez sur l’icône  sur le bureau.

2. Cliquez sur Je suis d’accord avec les dispositions de cette 
licence (bouton).

3. L'application va rechercher tous les adaptateurs connectés 
compatibles (ou vous pouvez cliquer sur le bouton Détection des 
adaptateurs disponibles pour activer Intel My WiFi 
Technology).

4. Cliquez pour sélectionner l'adaptateur détecté et cliquez sur 
Connecter.

5. Le système vous demandera alors d'entrer le code de sécurité à 
4 chiffres qui sera affiché sur l'écran de TV externe.

6. Entrez le code pour l’adaptateur vidéo et cliquez sur Continuer.

7. Vous serez alors invité à entrer un nom pour l’adaptateur vidéo et 
cliquez sur Continuer.

8. Cliquez sur Terminé pour terminer l'installation.
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Module Bluetooth (Option)
Assurez-vous que le module Bluetooth est sous tension avant
de lancer la procédure d'installation du pilote (utilisez l'affi-
chage à l'écran (OSD) pour basculer l'alimentation sur le mo-
dule Bluetooth - voir la page 63).

Installation du pilote de Bluetooth
Suivez les instructions ci-dessous:

Combo LAN sans fil et Bluetooth (Intel)
1. Cliquez sur Option Drivers (bouton).
2. Cliquez sur 4.Install Combo BT Driver > Oui.
3. Cliquez sur Suivant > Suivant.
4. Cliquez sur le bouton pour accepter le contrat de licence, 

puis cliquez sur Suivant.
5. Cliquez sur Suivant > Terminer.

Combo LAN sans fil et Bluetooth 4.0 (tiers)
1. Cliquez sur Option Drivers (bouton).
2. Cliquez sur 4.Install Combo BT Driver > Oui.
3. Cliquez sur Suivant.
4. Cliquez sur Terminer pour redémarrer votre ordinateur.

Configuration Bluetooth

Configurez votre périphérique Bluetooth afin 
que votre ordinateur le trouve

1. Allumez votre périphérique Bluetooth (ex. PDA, téléphone mobile 
etc.).

2. Rendez le périphérique détectable (pour cela consultez la 
documentation de votre périphérique).

Allumer le module Bluetooth
1. Activez le module Bluetooth à l'aide de l'affichage à l'écran (OSD).

2. Une icône  Bluetooth apparaîtra sur la barre des tâches.

3. Vous pouvez alors procéder comme suit pour accéder au panneau 
de contrôle des périphériques Bluetooth.

• Double-cliquez sur l'icône  pour accéder au panneau de 
contrôle des périphériques Bluetooth.

• Cliquez/Cliquez avec le bouton droit de la souris sur l'icône  
et sélectionnez une option dans le menu.

Aide Bluetooth
Cliquez sur Démarrer et sélectionnez Aide et assistance
puis tapez Bluetooth dans la boîte d'Aide de recherche, puis
cliquez sur l'icône de la loupe pour rechercher plus d'infor-
mations à propos du transfert Bluetooth. 
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TPM (Trusted Platform Module)
Avant de paramétrer les fonctions TPM vous devez initialiser
la plate-forme de sécurité.

Activer TPM
1. Redémarrez l’ordinateur.

2. Entrez dans l'Aptio Setup Utility en appuyez sur F2 pendant le 
POST.

3. Utilisez les touches fléchées pour sélectionner le menu Security.

4. Sélectionnez TPM Configuration, puis appuyez sur Entrée.

5. Sélectionnez TPM Support, puis appuyez sur Entrée. 
Sélectionnez Enable, puis appuyez sur Entrée.

6. Sélectionnez TPM State, puis appuyez sur Entrée et sélectionnez 
Enable pour modifier l’état du TPM sur activé. Appuyez ensuite 
sur F4 pour enregistrer les modifications et redémarrer 
l’ordinateur.

7. Pendant le redémarrage de l’ordinateur, appuyez sur F2 pour 
accéder au BIOS et allez dans le menu TPM Configuration 
(Configuration de TMP).

8. Sélectionnez Pending TMP operation, appuyez sur Entrée et 
sélectionnez l’option adaptée (si vous initialisez le TPM, 
sélectionnez Enable Take Ownership). Appuyez ensuite sur F4 
pour enregistrer les modifications et redémarrer l’ordinateur.

9. Maintenant, vous pouvez installer le pilote TPM, puis initialiser le 
TPM.

Installation du pilote TPM
1. Cliquez sur Option Drivers (bouton).
2. Cliquez sur 5.Install TPM Driver > Oui.
3. Cliquez sur Installer > Suivant.
4. Cliquez sur le bouton pour accepter le contrat de licence , 

puis cliquez sur Suivant.
5. Cliquez sur Suivant > Suivant > Installer.
6. Cliquez sur Terminer > Oui pour redémarrer votre 

ordinateur.
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Initialiser TPM
1. Exécutez l'application de la TPM à partir de l'élément Solution 

Infineon Security Platform > Gestion de Security Platform 
dans le menu Démarrer > Programmes/Tous les programmes.

2. Cliquez sur Paramétres utilisateur, et cliquez sur Oui, ou ?
Cliquez avec le bouton droit sur l’icône  dans la zone de 
notification de la barre des tâches, et sélectionnez Initialisation 
de Security Platform (ou cliquez sur la bulle de la barre des 
tâches État de Security Platform).

3. La méthode Initialisation Rapide sera sélectionnée 
automatiquement (si vous avez beoin d’utiliser les paramètres 
avancés fournis par votre administrateur réseau, sélectionnez 
Initialisation avancée).

4. Vous aurez besoin d’un média amovible (une clé USB par 
exemple) pour stocker les mots de passe et les données 
(conservez le média dans un endroit sûr).

5. Sélectionnez le pilote que vous souhaitez utiliser dans le menu 
déroulant et cliquez sur Suivant.

6. Choisissez les Fonctions de Security Platform que vous 
souhaitez utiliser en cliquant la case correspondante.

7. Entrez un Mot de passe utilisateur de base (et retapez-le pour le 
confirmer) et cliquez sur Suivant.

8. Cliquez sur Suivant pour confirmer les paramètres.

9. L’ordinateur initialisera les paramètres.

10. Cliquez sur Terminer.

11. Cliquez sur les onglets et les panneaux de contrôle pour régler les 
paramètres.

12. Cliquez deux fois sur l’icône  de la barre des tâches pour 
accéder à Outil des paramétrage d’Infineon Security Platform, 
ou cliquez deux fois sur l’icône  de la barre des tâches et 
sélectionnez un élément du menu.

Outil des paramétrage d’Infineon Securi-
ty Platform
L’Outil des paramétrage d’Infineon Security Platform vous
permet de gérer et de vérifiez l’état du TPM, gérer vos infor-
mations de mot de passe, et sauvegarder et récupérer les don-
nées du TPM. Comme le TPM est généralement administré
au sein de larges enterprises et organisations, votre adminis-
trateur système devra vous assister pour la gestion des don-
nées.Figure 15

Security Plat-
form Assistant  
Rapide d’Initia-

lisation
Figure 16

Outil des para-
métrage d’Infi-
neon Security 

Platform
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Dépannage

Problème Cause possible - résolution

Les modules LAN sans fil/ 
Bluetooth ne peuvent pas 
être détectés.

Les modules sont désactivés. Appuyez sur le bouton menu de fonction pendant environ deux 
secondes (voir le Tableau 2 à la page 62) pour faire apparaître l'affichage à l’écran. Vérifiez l'OSD 
approprié pour voir s’il est activé ou désactivé.

Aucun son audible à via un 
périphérique d'affichage 
connecté par HDMI.

Vous n'avez pas configuré la sortie audio HDMI. Reportez-vous à Configuration audio pour HDMI à 
la page 71.

Les fichiers vidéo capturés
depuis la caméra PC
prennent trop de place sur
le disque.

Notez que la capture de fichiers vidéo à haute résolution nécessite un espace substantiel sur le
disque pour chaque fichier.

Notez que le système Windows nécessite un minimum de 15Go d'espace libre sur la partition
système du lecteur C:. Il vous est recommandé d'enregistrer le fichier vidéo capturé dans un autre
emplacement que le lecteur C:, limitez la taille du fichier de la vidéo capturée ou réduisez la
résolution vidéo (Options > Video Capture Pin... > Taille de sortie).
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Spécifications


Dernières informations de 

spécification

Les spécifications énumérées dans cet
Appendice sont correctes à l'heure de
la mise sous presse. Certains éléments
(particulièrement les types de proces-
seur/vitesse unique) peuvent être mo-
difiés ou mis à niveau en fonction du
calendrier des parutions du fabricant.
Voyez auprès de votre service clientèle
pour les détails.

Options de processeurs

Processeur Intel® Core™i7

i7-3770S (3,10GHz)

Cache L3 8Mo, 22nm, DDR3-1600MHz, 
TDP 65W

i7-3570S (3,10GHz)

Cache L3 6Mo, 22nm, DDR3-1600MHz, 
TDP 65W

Processeur Intel® Core™i5

i5-3550S (3,00GHz), i5-3475S (2,90GHz), 
i5-3470S (2,90GHz), i5-3450S (2,80GHz), 
i5-3570T (2,30GHz)

Cache L3 6Mo, 22nm, DDR3-1600MHz, 
TDP 65W

Processeur Intel® Pentium®

G640 (2,80GHz) 

Cache L3 3Mo, 22nm, DDR3-1066MHz, 
TDP 65W

Processeur Intel® Celeron®

G540 (2,50GHz)

Cache L3 2Mo, 22nm, DDR3-1066MHz, 
TDP 65W

Core logic

Chipset Intel® HM61

BIOS

AMI BIOS (SPI Flash ROM de 48Mb)

Mémoire

Deux emplacements SODIMM 204 broches, 
supportant la mémoire DDR3 1333/1600MHz

Mémoire extensible jusqu’à 8Go

Adaptateur Vidéo

GPU intégré Intel® 

(Le GPU dépend du processeur)

Intel® HD Graphics

Fréquence dynamique (Technologie de 
mémoire vidéo dynamique d'Intel jusqu’à 
1,7Go)

Compatible avec MS DirectX® 10

Intel® HD Graphics 2500

Fréquence dynamique (Technologie de 
mémoire vidéo dynamique d'Intel jusqu’à 
1,7Go)

Compatible avec MS DirectX® 11

Intel® HD Graphics 4000

Fréquence dynamique (Technologie de 
mémoire vidéo dynamique d'Intel jusqu’à 
1,7Go)

Compatible avec MS DirectX® 11

LCD

21,5" (54,61cm) FHD

Stockage de données

(Option d’usine) Un lecteur de type unité 
optique 12,7mm(h) remplaçable (module de 
lecteur Super Multi)

Un disque dur SATA remplaçable de 2,5" 
9,5mm (H)

Un disque dur SATA remplaçable de 3,5" 
25mm (H)
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Son

Interface conforme HDA 

2 haut-parleurs intégrés

Microphone intégré

Sécurité

Mot de Passe du BIOS

Fente de verrouillage de sécurité (type 
Kensington)

TPM 1.2

Interface

Quatre ports USB 2.0

Duex ports USB 3.0

Un prise d'entrée de HDMI

Une prise de sortie HDMI

Une prise de sortie haut-parleurs/casque

Une prise d'entrée de microphone

Deux ports série (COM)

Deux ports PS/2

Une prise RJ-45 pour réseau

Une prise d’entrée en DC

Logements

Un logement Mini-carte pour module LAN 
sans fil o module combo Bluetooth et LAN 
sans fil

Un logement d'ExpressCard/54(34)

Lecteur de carte

Lecteur de carte multi-en-1

MMC (MultiMedia Card) / RS MMC

SD (Secure Digital)/ Mini SD/ SDHC/ SDXC 

MS (Memory Stick) / MS Pro / MS Duo

Clavier & dispositif de pointage

(Option d’usine) Clavier et souris USB RF 
avec émetteur-récepteur

Communication

1Gbit réseau Ethernet intégré

(Option d’usine) 2,0M FHD caméra PC

Modules Half Mini-carte LAN sans fil/
Bluetooth:

(Option d’usine) Bluetooth 4.0 et LAN sans 
fil (802.11b/g/n) Intel® Centrino® Wireless-
N 2230

(Option d’usine) LAN sans fil (802.11b/g/n) 
(tiers)

(Option d’usine) Bluetooth 4.0 et LAN sans 
fil (802.11b/g/n) (tiers)

Mise en marche

Adaptateur AC/DC pleine bande 

Entrée AC: 100-240V, 50-60Hz 

Sortie DC: 19V, 6,3A (120W)

(Option d’usine) Batterie Smart Lithium-Ion 
à 6 éléments, 62,16WH

Spécifications environnementales

Température

En fonction : 5°C- 35°C 

Eteint : -20°C - 60°C

Humidité relative

En fonction : 20% - 80%

Eteint : 10% - 90%

Dimensions physiques & poids

525 (l) x 49 (p) x 418 (h) mm

Environ 7kg (avec lecteur optique)
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Acerca de esta Guía del Usuario Concisa
Esta guía rápida es una breve introducción para poner su sistema en funcionamiento. Es un suplemento y no un sustituto del
Manual del usuario completo en inglés en formato Adobe Acrobat del disco Device Drivers & Utilities + User's Manual
suministrado con el ordenador. En este disco también se encuentran los controladores y utilitarios necesarios para utilizar el
ordenador correctamente (Nota: La compañía se reserva el derecho a revisar esta publicación o cambiar su contenido sin
previo aviso). 

Algunas o todas las características del ordenador pueden haberse configurado de antemano. Si no lo están, o si desea
reconfigurar (o reinstalar) partes del sistema, consulte el Manual del usuario completo. El disco Device Drivers & Utilities
+ User’s Manual no contiene un sistema operativo.

Información de regulación y seguridad
Por favor, preste especial atención a todos los avisos de regulación e información de seguridad contenidos en el Manual del
usuario completo del disco Device Drivers & Utilities + User’s Manual.

© Agosto del 2012

Marcas registradas
Intel e Intel Core son marcas/marcas registradas de Intel Corporation.
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Instrucciones para el cuidado y 
funcionamiento
El ordenador es muy robusto, pero puede dañarse. Para evitar
esto, siga estas sugerencias:

• No lo deje caer ni lo exponga a golpes fuertes. Si el ordenador se 
cae, la carcasa y los componentes podrían dañarse.

• Manténgalo seco y no lo sobrecaliente. Mantenga el ordenador y 
fuente de alimentación alejados de cualquier tipo de fuente de calor. 
Esto es un aparato eléctrico. Si se derrama agua u otro líquido en su 
interior, el ordenador podría dañarse seriamente.

• Evite las interferencias. Mantenga el ordenador alejado de 
transformadores de alta capacidad, motores eléctricos y otros campos 
magnéticos fuertes. Éstos pueden dificultar el correcto 
funcionamiento y dañar los datos.

• Siga las instrucciones apropiadas de manejo del ordenador. 
Apague el ordenador correctamente y no olvide guardar su trabajo. 
Recuerde guardar periódicamente sus datos, pues los datos pueden 
perderse si la batería se descarga.

• Tenga en cuenta que en ordenadores con logotipos de LCD 
etiquetados eléctricamente en relieve, el logotipo está recubierto por 
un adhesivo protector. Debido al desgaste y rotura normales, este 
adhesivo puede deteriorarse con el tiempo y en el logotipo expuesto 
pueden formarse bordes afilados. Tenga cuidado al manipular el 
ordenador en este caso y evite tocar el logotipo del LCD etiquetado 
eléctricamente. Evite colocar cualquier elemento en la bolsa de 
transporte que pueda rozar la parte superior del ordenador durante el 
transporte Si ocurre un desgaste o rotura, contacte con el centro de 
servicios.

Seguridad de corriente y batería
• Utilice solamente un adaptador AC/DC aprobado para su uso con este 

ordenador.
• Utilice solamente el cable de corriente y las baterías indicados en este 

manual.
• Su adaptador AC/DC puede estar diseñado para viajes 

internacionales, pero puede que necesite una fuente de alimentación 
continuada. Si no está seguro de las especificaciones de alimentación 
locales, consulte con el servicio de asistencia o compañía de 
electricidad del lugar.

• El adaptador de alimentación puede tener un enchufe de 2 dientes o 
un enchufe con tierra de 3 dientes. El tercer diente es una 
característica de seguridad; no lo elimine. Si no tiene acceso a un 
enchufe de pared compatible, haga que un electricista cualificado 
instale uno.

• Cuando desee desenchufar el cable de alimentación, asegúrese de 
desconectarlo por la cabeza del enchufe, no por su cable.

• Compruebe que la toma y cualquier alargadera que utilice puedan 
soportar la carga de corriente total de todos los dispositivos 
conectados.

• Compruebe que su ordenador esté completamente apagado antes de 
introducirlo en una bolsa de viaje (o en cualquier funda).

• Utilice sólo baterías diseñadas para este ordenador. Una batería 
inadecuada podría explotar, perder o dañar el equipo.

• Nunca utilice una batería que se haya caído o que parezca dañada (p. 
ej. doblada o retorcida). Incluso si el ordenador sigue funcionando 
con una batería dañada, puede provocar daños en el circuito que 
podrían causar fuego.

• Recargue la batería con el sistema del ordenador. Una recarga 
incorrecta puede hacer que la batería explote.

• No intente reparar baterías. Solicite la reparación o la sustitución a su 
representante de servicio o a personal de servicio cualificado.

• Mantenga las baterías dañadas fuera del alcance de los niños y 
deséchelas inmediatamente. La eliminación de baterías debe 
efectuarse con cuidado. Las baterías pueden explotar o perder si se 
exponen al fuego o si se manipulan o desechan de manera 
inadecuada.

• Mantenga las baterías lejos de elementos metálicos.
• Cubra los contactos de la batería con cinta adhesiva antes de 

desecharla.
• No tire las baterías al fuego. Podrían explotar. Consulte los códigos 

locales para posibles instrucciones para desechos especiales.
• No toque los contactos de la batería con las manos o con objetos 

metálicos.
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Precauciones para baterías de polímero
Tenga en cuenta la información siguiente específica para
baterías de polímero; además, donde corresponda, invalida la
información sobre precauciones para baterías normales.

• Las baterías pueden aumentar o hincharse ligeramente, sin embargo, 
esto es parte del mecanismo de seguridad de la batería y o supone un 
problema.

• Utilice los procedimientos de manejo apropiados cuando utilice 
baterías de polímero. No utilice baterías de polímero en entornos con 
temperatura ambiental alta y no guarde las baterías sin usar durante 
mucho tiempo.

Servicio
Si intenta reparar el ordenador usted mismo, podría anular la
garantía y exponerse usted y el ordenador a descarga eléctrica.
Deje que sea personal de reparación cualificado el que realice
las reparaciones, especialmente bajo cualquiera de estas
condiciones:

• Cuando el cable de alimentación o adaptador AC/DC esté dañado o 
pelado.

• Si el ordenador ha estado expuesto a la lluvia u otros líquidos.
• Si el ordenador no funciona con normalidad tras seguir las 

instrucciones de uso.
• Si el ordenador se ha caído o dañado (no toque el líquido venenoso si 

el panel LCD se rompe).
• Si hay un olor fuera de lo normal, calor o humo que sale del 

ordenador.

Limpieza
• Utilice un trapo limpio y suave para limpiar el ordenador, pero no 

aplique limpiador directamente en el ordenador. 
• No utilice limpiadores volátiles (derivados del petróleo) o 

limpiadores abrasivos en ningún lugar del ordenador.
• Antes de limpiar el ordenador, quite la batería y asegúrese de que el 

ordenador esté desconectado de cualquier fuente de alimentación 
externa, periféricos y cables (incluyendo la línea telefónica).


Eliminación de la batería & Cuidado

El producto que usted ha comprado contiene una batería
recargable. La batería es reciclable Terminada su vida útil,
según las leyes locales y estatales, puede ser ilegal
desecharla junto con los residuos ordinarios. Verifique con
las autoridades locales responsables de los desechos
sólidos cuáles son las opciones de eliminación y reciclado
existentes en su zona.

Peligro de explosión si la batería está mal colocada.
Sustitúyala con un tipo de batería igual o equivalente al
recomendado por el fabricante. Elimine la batería usada de
conformidad con las instrucciones del fabricante.
87



E
sp

añ
o

l

Guía rápida para empezar
1. Quite todos los materiales del embalaje.

2. Coloque el ordenador en una superficie estable.

3. Conecte en los puertos correspondientes los periféricos que desee utilizar con el ordenador (p. ej. teclado y ratón)

4. Coloque el adaptador AC/DC en el conector de entrada de DC en la parte posterior de la pantalla LCD y luego conecte el cable de 
alimentación AC en un eschufe y al adaptador.

5. Pulse el botón de encendido en la parte frontal del ordenador para encender el ordenador "on".

Figura  1 - Ordenador con el adaptador AC/DC enchufado/Botón de encendido

Software de sistema
Puede ser que su ordenador tenga instalado un software de sistema. Si no es el caso, o si desea reconfigurarlo con otro sistema,
este manual se refiere a Microsoft Windows 7.


Apagar

Por favor, tenga en cuenta que debería siempre apagar el ordena-
dor eligiendo la opción Apagar desde el menú Inicio.

Esto le ayudará a evitar problemas con el disco duro o el sistema. 

Botón de encendido
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Mapa del sistema: Vista frontal

Figura 2 - Vista frontal

1. Micrófono incorporado

2. Cámara PC (opcional)

3. Indicador LED de cámara PC

4. Panel LCD 

5. Botón de encendido

6. Botones de función

7. Indicadores LED

8. Altavoces incorporados

4

3 1

5

2

7 6 88

57 6
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Indicadores de LED
Los indicadores LED en su ordenador muestran una valiosa
información sobre el estado actual del ordenador.

Tabla 1 - Indicadores LED

Botones de función 

Tabla 2 - Botones de función 

Icono Color Descripción

Verde El ordenador está encendido

Verde 
parpadeante

El ordenador está en modo Sus-
pensión

Naranja
El adaptador de AC/DC está conec-

tado

Naranja La batería se está cargando

 Blanco
La batería está completamente car-

gada

Naranja parpa-
deante

La batería ha alcanzado el estado 
crítico de poca energía

Verde
Cable HDMI enchufado (si el orde-

nador está apagado) - vea la  
página 94

Verde El disco duro está en uso

Verde
El módulo LAN Wireless está acti-

vado

Orange
The Bluetooth Module is Powered 

On

Icono Descripción

Botones Disminuir/Aumentar - Utilice los botones 
para disminuir o aumentar el brillo/volumen

Cambiar Menú - Utilice este botón para cambiar 
entre los menús de brillo o audio y utilice los boto-

nes anteriores para el ajuste

Cambiar Modo - Utilice este botón para cambiar 
entre los modos de entrada ordenador y HDMI 
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Indicadores del menú en pantalla (OSD)
Presione el botón del menú de funciones durante unos dos segundos (vea la Tabla 3 en la página 91) para abrir el menú en
pantalla. El OSD ofrece indicadores visuales para el brillo, volumen, cambio de alimentación entre cámara/WLAN/Bluetooth
(los indicadores de alimentación de la cámara, WLAN y Bluetooth sólo aparecerán si los módulos están incluidos en su
configuración de compra) cuando Hotkey AP está instalado (consulte "Hotkey AP" en la página 102).

Tabla 3 - Indicadores de OSD

Los indicadores aparecerán cuando arranque el equipo o si reanuda de un estado de ahorro de energía para mostrar el estado
de encendido actual de la cámara y/o del Bluetooth. Si ajusta el brillo o el volumen, los indicadores del OSD aparecerán y
también le permitirán ajustar el estado de encendido del módulo de la cámara y/o del Bluetooth con un clic del ratón en el
icono.

Icono de OSD Descripción

Reducción/Aumento brillo LCD

Reducción/Aumento volumen de sonido

WLAN Module Power Toggle

Activar/desactivar el módulo Bluetooth

Activar/desactivar el módulo cámara PC
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Kit de teclado y ratón inalámbrico opcional
Hay un kit de teclado y ratón USB inalámbrico por RF opcio-
nal disponible para esta serie de ordenadores. Un puerto USB
situado en la parte inferior de la tapa posterior ha sido dise-
ñado para albergar el transceptor para el kit de teclado y ratón
inalámbrico USB. 

Figura 3
 Kit de teclado 
y ratón inalám-

brico
opcional


Dispositivo y puertos USB

Un único dispositivo USB (que actúa como
transceptor para teclado y ratón) está
incluido con el teclado y el ratón. Este
dispositivo puede insertarse en cualquiera
de los puertos USB. Sin embargo, se
recomienda usar el puerto USB específico
para esto.


Puerto USB para transceptor inalámbrico

Tenga en cuenta que el puerto USB para transceptor
inalámbrico  ha sido especialmente diseñado para el
teclado y ratón RF opcional incluido solamente con este
modelo. 

No utilice otros dispositivos USB en este puerto.

1

Figura 4 - Puerto USB 
para kit de teclado y ra-

tón inalámbricos

1
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Mapa del sistema: Vista izquierda Figura 5

Vista izquierda

1. Soporte

2. Lector de tarjetas multi-
en-1 

3. Ranura ExpressCard/
54(34)

4. 2 * Puertos USB 3.0

5. Puerto de entrada de 
HDMI

6. Puerto de salida de 
HDMI


Puerto USB 3.0

El color de los puertos USB 3.0
 es azul. USB 3.0 transfiere

los datos mucho más rápido
que USB 2.0 y es compatible
con su antecesor USB 2.0.

Lector de tarjetas multi-en-1 

El lector de tarjetas le permite 
usar algunas de las últimas tar-
jetas de almacenamiento digi-
tal.
 

MMC (MultiMedia Card) / RS 
MMC

SD (Secure Digital) / Mini SD / 
SDHC/ SDXC

MS (Memory Stick) / MS Pro / 
MS Duo 

4

1

2

3

4

5

6

4
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Puerto de entrada HDMI
Este ordenador incluye un puerto de entrada HDMI que le permite mostrar fuentes externas como reproductores Blu-ray,
DVDs, decodificadores y consolas de juegos, etc. en la pantalla de su ordenador.

No necesita encender el ordenador para mostrar vídeo y audio desde fuentes externas. Siempre que el ordenador esté
enchufado a una fuente de alimentación a través del adaptador AC/DC (el indicador LED  cambiará a naranja si el
ordenador está enchufado y apagado), simplemente enchufe el cable HDMI del dispositivo externo en el puerto de entrada
HDMI-In del ordenador y éste actuará como dispositivo de visualización. Si el ordenador es alimentado por batería, presione
el botón de alimentación en el ordenador para encenderlo y usar el puerto HDMI-In.

Cambiar Modo
Mantenga presionado el botón de cambio de modo  para cambiar entre los modos de entrada ordenador y HDMI. Cuan-
do aparezca “Input Source HDMI” podrá utilizar cualquier dispositivo HDMI enchufado al puerto de entrada HDMI del or-
denador. Una pulsación rápida del botón encenderá y apagará la pantalla.

La tabla siguiente indica las funciones cuando un cable HDMI está enchufado en el puerto HDMI-In.

Tabla 4 - funciones  de cambio de modo cuando un cable HDMI está enchufado

Estado de alimentación del 
ordenador Icono HDMI 

Botón de cambio de 

modo  (Mantener 

presionado)

Botón de cambio de 

modo 

(Pulsación rápida)

El ordenador es encendido (usando 
el adaptador AC/DC ó la batería)

Indica solamente el estado de carga 
de la batería

Cambia entre las entradas 
pantalla del ordenador y HDMI

Enciende y apaga la pantalla

El ordenador es apagado (pero 
enchufado en el adaptador AC/DC)

Verde (cuando el cable HDMI está 
enchufado y se ha mantenido pre-

sionado el botón de cambio de 
modo para seleccionar la entrada 

HDMI)

Cambia entre las entradas 
pantalla del ordenador y HDMI

Enciende y apaga la pantalla
94



E
sp

añ
o

l

Mapa del sistema: Vista derecha

Figura 6
Vista derecha

1. Orificio de expulsión de 
emergencia

2. Bahía de dispositivo óptico

3. Conector de salida de auri-
culares

4. Conector de entrada para 
micrófono

5. 2 * Puertos USB 2.0

6. Soporte


Expulsión de emergencia del 

disco

Si necesita expulsar un disco
manualmente (p. ej. por un corte de
corriente inesperado) puede
introducir la punta de un clip en el
orificio de expulsión de
emergencia. No utilice la punta de
un lápiz u otros objetos que puedan
romperse y quedar atrapados en el
orificio.


Mover el ordenador

Se recomienda utilizar las dos manos para mover el or-
denador. Puede usar una mano para agarrar el orde-
nador por el soporte y la otra para sostener la parte
superior de la pantalla LCD. 

Se recomienda que lleve el ordenador con la pantalla
LCD mirando hacia su cuerpo para evitar rayar la su-
perficie contra otros objetos. Sin embargo, procure no
rayar la pantalla LCD con objetos personales, hebillas,
joyas, etc. (una mano agarrando el soporte y la otra
agarrando la parte superior del ordenador para evitar
que caiga por accidente).

3

1

2

4
5

5

6
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Inclinar la pantalla
Es posible inclinar la pantalla LCD para obtener el mejor
ángulo de visión posible de la pantalla sin reflejos, etc. 

1. Coloque una mano en la parte superior del ordenador  y utilice 
la otra para abrir el soporte  hasta un ángulo de unos 15 
grados desde la posición vertical (el soporte le permitirá ajustar 
al ángulo apropiado si tira de él y lo deja retroceder).

Figura 7 - Ajustar el soporte

2. Aplique presión con una mano en la parte superior (en el punto 
) del ordenador (mientras sostiene el lateral con la otra mano) 

para presionar con cuidado la pantalla LCD para inclinarla a un 
ángulo de visión apropiado (hasta 50 grados desde la posición 
vertical).

3. Utilice una mano en la parte superior del ordenador (mientras 
sostiene el lateral con la otra mano) para volver a colocar el 
ordenador en su posición original.

Figura 8  - Inclinar la pantalla

1
2

Ajuste el soporte
para inclinar el orde-
nador a 15° desde la
posición vertical. 

15°

1

2

3


Función DVD

Tenga en cuenta que aunque
el ordenador puede
inclinarse hasta un ángulo de
50 grados desde la posición
vertical, la unidad de DVD-
ROM sólo funcionará (es
decir, continuará girando y
leyendo DVDs) hasta un
ángulo de unos 35 grados
desde la posición vertical. 

Si el sistema tiene problemas
para leer DVDs, ajuste el
ángulo de inclinación.

Aplique presión
desde la parte
superior de la
pantalla para
ajustar la base
hacia el exterior
(hasta 50° de la
posición verti-
cal). 

50°

50°

3
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Mapa del sistema: Vista posterior


CPU

El usuario no debe
manipular la CPU. El
acceso a la CPU de
cualquier modo puede
anular su garantía.

Recalentamiento

Para evitar que su
ordenador se recaliente
compruebe que nada
bloquea la(s) rejilla(s) con
el equipo encendido.

Información sobre el 
montaje en pared

El ordenador puede mon-
tarse en una pared para vi-
sualizarlo. El sistema
cumple con el estándar
VESA (FDMI) (100mm *
100mm) para el montaje
en pared. Sin embargo, si
desea montar el sistema
en la pared, contacte con
su centro de servicios para
información y evitar así le-
siones personales o daños
en el ordenador.

1

3

2

8

3

4

5

8

7

10

11

6

12 13

9

Figura 9 - Vista posterior

1. Tapa de componentes tra-
seros

2. Soporte

3. Rejilla

4. Área del asa de transporte

5. Tapa del transceptor ina-
lámbrico USB (para el kit 
de teclado y ratón RF 
opcional)

6. Ranura del cierre de seguridad

7. Batería (opcional)

8. 2 Puertos serie

9. Puerto PS/2 (teclado)

10. Puerto PS/2 (ratón)

11. Conector de entrada DC

12. 2 * Puertos USB 2.0

13. Conector LAN RJ-45
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Parámetros de vídeo
Puede cambiar los dispositivos de pantalla y configurar las
opciones de pantalla desde el panel de control Pantalla en
Windows y/o desde el Panel de control de graficos y
multimedia Intel siempre que tenga instalado el controlador
de vídeo.

Para acceder al panel de control Pantalla:
1. Haga clic en Inicio (menú),  y haga clic en Panel de control (o 

vaya a Configuración y haga clic en Panel de control).

2. Haga clic en Pantalla (icono) - en Apariencia y personalización 
(categoría).

3. Haga clic en Ajustar resolución de pantalla/Ajustar resolución.
O
4. Como alternativa, puede hacer clic con el botón derecho en el 

escritorio y seleccionar Resolución de pantalla.

5. Utilice el cuadro desplegable para seleccionar la resolución de la 
pantalla .

6. Haga clic en Configuración avanzada . 

Para acceder al Panel de control de gráficos y multimedia
Intel®:
1. Haga clic en Inicio (menú),  y haga clic en Panel de control (o 

vaya a Configuración y haga clic en Panel de control).

2. Haga clic en Gráficos y multimedia Intel(R) (icono) en Vista 
clásica.

O
3. Haga clic con el botón derecho en el escritorio y seleccione 

Propiedades de gráficos en el menú.

O
4. Haga clic el icono  en el área de notificación de la barra de 

tareas y seleccione Propiedades de gráficos en el menú.

5. Seleccione el modo de aplicación (Modo básico, Modo 
avanzado o Modo de asistente) y haga clic en Aceptar.

1
2

2
1

Figura 10 - Panel de control Pantalla

3

Figura 11
Panel de control de 

graficos y multimedia 
Intel 

3
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Características de audio
Puede configurar las opciones de audio de su ordenador en el
panel de control de Sonido , o desde el icono de
Administrador de sonido Realtek HD /  en el área
de notificación o en el Panel de Control (haga clic con el
botón derecho en el icono  del área de notificación para
abrir el menú de audio).

El volumen también puede ajustarse en el icono del altavoz
en la barra de tareas o los indicadores del menú en pantalla
(vea la  página 91).

Configuración para grabación de audio
Para grabar de fuentes de audio en su ordenador a calidad
óptima siga las instrucciones siguientes:

1. Haga clic en Inicio (menú), y haga clic en Panel de control (o 
vaya a Configuración y haga clic en Panel de control).

2. Haga clic en Administrador  de sonido Realtek HD (o haga clic 
con el botón derecho en el icono  del área de notificación y 
seleccione Administrador de sonido).

3. Haga clic en Efecto micrófono (ficha) en Micrófono (ficha), y 
haga clic para seleccionar Supresión de ruidos (botón), o ajuste 
el nivel de Volumen de grabación al 60, para obtener la calidad 
de grabación óptima.

4. Haga clic en Aceptar para cerrar el panel de control Sonido .

Configuración de audio para HDMI
HDMI soporta las señales de vídeo y audio. En algunos
casos será necesario ir al panel de control de Sonido para
configurar manualmente la salida de audio HDMI.

1. Haga clic en Inicio (menú), y haga clic en Panel de control (o 
vaya a Configuración y haga clic en Panel de control).

2. Haga clic en Sonido  (Hardware y sonido).

3. Haga clic en Reproducción (ficha).

4. El dispositivo de reproducción será seleccionado.

5. En algunos casos, puede que necesite seleccionar el dispositivo 
de audio y haga clic en Predeterminar (botón).

6. Haga doble clic en el dispositivo para acceder a las fichas del 
panel de control.

7. Ajuste la configuración HDMI desde las fichas del panel de 
control.

8. Haga clic en Aceptar para cerrar el panel de control Sonido .

Figura 12 
Administra-

dor  de sonido 
Realtek HD - 

Configuración 
de grabación

Figura 13 
Opciones de 
reproducción 

del sonido
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Funciones de administración de energía
El panel de control de las opciones de energía (menú Hardware y sonido) de Windows permite configurar las funciones de
administración de energía del ordenador. Puede ahorrar energía con los planes de energía y configurar las opciones para el
botón de encendido, botón de suspensión, pantalla y modo de suspensión en el menú de la izquierda. Tenga en cuenta que
el plan economizador puede afectar al rendimiento del ordenador.

Haga clic para seleccionar uno de los planes existentes o haga clic en Crear un plan de energía en el menú izquierdo y
seleccione las opciones para crear un plan nuevo. Haga clic en Cambiar la configuración del plan y haga clic en Cambiar
la configuración avanzada de energía para acceder a más opciones de configuración.

Figura 14 - Opciones de energía
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Instalación de controladores
El disco Device Drivers & Utilities + User’s Manual
contiene los controladores y utilitarios necesarios para
utilizar el ordenador correctamente. Inserte el disco y haga
clic en Install Drivers (botón), u Option Drivers (botón)
para acceder al menú de controladores opcional. Instale los
controladores en el orden indicado en la Tabla 5. Haga clic
para seleccionar los controladores que desea instalar (debería
anotar los controladores conforme los instala). Nota: Si
necesita reinstalar un controlador, debería desinstalar el
controlador antes.

Instalación manual del controlador
Haga clic en el botón Browse CD/DVD en la aplicación
Drivers Installer y busque el archivo ejecutable en la carpeta
de controladores apropiada.

Si durante el procedimiento de instalación aparece una
ventana Nuevo hardware encontrado, haga clic en
Cancelar, y siga con el procedimiento de instalación.

Windows Update
Tras instalar todos los controladores asegúrese de haber
habilitado Windows Update para obtener las últimas
actualizaciones de seguridad, etc. (todas las actualizaciones
incluirán los últimos parches de Microsoft).

Tabla 5 - Procedimiento de instalación

Controlador (Windows 7 con SP1)* Página #

Chipset página 102

Vídeo (VGA) página 102

Red (LAN) página 102

ExpressCard/Lector de tarjetas página 102

Hot-Key página 102

USB 3.0 página 102

Intel MEI página 102

Sonido página 102

Cámara PC (opción) página 103

Módulo LAN Wireless (opción) página 105

WiDi página 106

Módulo Bluetooth (opción) página 106

TPM página 108

Activar Windows Update (ver a la izquierda)

*Tenga en cuenta que todos los controladores incluidos son para 
101



E
sp

añ
o

l

Chipset
1. Haga clic en 1.Install Chipset Driver > Sí.
2. Haga clic en Siguiente > Sí > Siguiente > Siguiente.
3. Haga clic en Finalizar para reiniciar el sistema.

Vídeo
1. Haga clic en 2.Install VGA Driver > Sí.
2. Haga clic en Siguiente > Sí > Siguiente > Siguiente.
3. Haga clic en Finalizar para reiniciar el sistema.

Red (LAN)
1. Haga clic en 3.Install LAN Driver > Sí.
2. Haga clic en Instalar > Finalizar.
3. Ahora se pueden configurar los parámetros de red. 

ExpressCard/Lector de tarjetas
1. Haga clic en 4.Install CardReader Driver > Sí.
2. Haga clic en Instalar > Finalizar.

Hotkey AP
1. Haga clic en 5.Install Hotkey AP > Sí.
2. Haga clic en Next > Next.
3. Haga clic en Finish > Finish para reiniciar el sistema.

USB 3.0
1. Haga clic en 6.Install USB 3.0 Driver > Sí.
2. Haga clic en Siguiente.
3. Haga clic en el botón Acepto los términos del acuerdo de 

licencia, luego haga clic en Siguiente.
4. Haga clic en Siguiente > Instalar.
5. Haga clic en Finalizar.

Intel MEI
1. Haga clic en 7.Install MEI Driver > Sí.
2. Haga clic en Siguiente > Sí > Siguente > Siguiente.
3. Haga clic en Finalizar.

Sonido
1. Haga clic en 8.Install Audio Driver > Sí.
2. Haga clic en Siguiente.
3. Haga clic en Terminar para reiniciar el sistema.


Instalación del controlador y alimentación

Cuando instale controladores asegúrese de que el ordenador
esté alimentado por el adaptador AC/DC conectado a una
fuente de corriente activa. Algunos controladores consumen
una cantidad significativa de corriente durante el proceso de
instalación, y si la batería se consume puede provocar que el
sistema se apague, causando problemas en el sistema (tenga
en cuenta que esto no supone un problema de seguridad y la
batería podrá recargarse en 1 minuto).
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Cámara PC (Opción)
Asegúrese de que el módulo Cámara PC esté encendido antes
de iniciar el proceso de instalación del controlador (utilice el
menú en pantalla (OSD) para el encendido del módulo de la
cámara - ver la página 91).

Cuando la aplicación PC Camera esté en ejecución el
indicador LED de la izquierda de la cámara se iluminará en
rojo (consulte "Mapa del sistema: Vista frontal" en la
página 89).

Instalación del controlador de la cámara 
PC
1. Haga clic en Option Drivers (botón).
2. Haga clic en 1.Install WebCam Driver > Sí.
3. Haga clic en Finalizar para reiniciar el sistema.

O
Haga clic en Siguiente > Finalizar.

4. Ejecute la aplicación de cámara desde el acceso directo  en 
el escritorio (si el hardware está apagado utilice la 
combinación de teclas Fn + F10 para volver a encenderlo).

Configuración del audio de la cámara PC
Configure las opciones de grabación de audio en Windows
para capturar vídeo & audio con su cámara.

1. Haga clic en Inicio (menú), y haga clic en Panel de control (o 
vaya a Configuración y haga clic en Panel de control).

2. Haga clic en Sonido  (Hardware y sonido).

3. Haga clic en Grabar (ficha).

4. Haga clic con el botón derecho en Micrófono (Realtek High 
Definition Audio) y compruebe que el ítem esté deshabilitado.

5. Haga doble clic en Micrófono (o seleccione Propiedades en el 
menú contextual).

6. Haga clic en Niveles (ficha) y ajuste los controles deslizantes de 
Micrófono y Amplificación de micrófono hasta el nivel 
deseado.

7. Haga clic en Aceptar y cierre los paneles de control.

8. Ejecute la aplicación de cámara desde el acceso directo en el 
escritorio.

9. Vaya al menú Devices (Dispositivos) y seleccione Micrófono 
(Realtek....) (debería tener una marca al lado).

10. Vaya al menú Capture (Capturar) y seleccione Capture Audio 
(debería tener una marca al lado).

11. Para obtener la mejor calidad de grabación de sonido habilite 
Supresión de ruidos en el panel de control de Administrador  
de sonido Realtek HD (consulte "Configuración para 
grabación de audio" en la página 99).


Estados de la aplicación PC Camera y ahorro de energía

Si el ordenador entra en el modo Suspensión o Hibernación
durante la ejecución de la aplicación de la cámara, el
programa se detendrá y deberá reiniciarse cuando el
sistema se reanude del estado de ahorro de energía.
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Aplicación de cámara
La aplicación de cámara es un visor de vídeo útil para el
propósito general de visualización y comprobación de vídeo
y puede capturar archivos de vídeo en formato .avi.

1. Ejecute la aplicación de cámara desde el acceso directo en el 
escritorio (se recomienda que Ajuste el archivo de captura 
antes del proceso de captura - ver “Ajustar archivo de captura” 
a continuación).

2. Vaya al menú de Capture (Capturar) (si desea capturar audio 
consulte "Configuración del audio de la cámara PC" en la 
página 103) y seleccione Start Capture (Iniciar captura).

3. Haga clic en OK (Aceptar) (la ubicación del archivo aparecerá en 
el cuadro emergente) para iniciar la captura y pulse Esc para 
detenerla  (puede ver el archivo usando Windows Media Player).

Ajustar archivo de captura
Antes de capturar archivos de vídeo puede seleccionar la
opción Set Capture File... (Ajustar archivo de captura...) en
el menú File (Archivo) y ajuste el nombre del archivo y la
ubicación antes de capturar (esto ayudará a evitar
sobrescribir archivos accidentalmente). Ajuste el nombre y
la ubicación y luego haga clic en Abrir, luego ajuste el
"Tamaño del archivo de captura": y haga clic en OK
(Aceptar). Luego podrá iniciar el proceso de captura como
arriba.

Reducir el tamaño de archivo de vídeo
Tenga en cuenta que la captura de archivos de vídeo a alta
resolución necesita una cantidad considerable de espacio en
el disco para cada archivo. Tras grabar el vídeo, compruebe
el tamaño del archivo de vídeo (haga clic en el archivo y
seleccione Propiedades) y el espacio libre en su disco duro
(vaya a Equipo, haga clic con el botón derecho en el disco
duro y seleccione Propiedades). Si lo necesita, puede pasar
el archivo de vídeo grabado a un medio extraíble, como CD,
DVD o unidad USB Flash.

Tenga en cuenta que el sistema Windows necesita un mínimo
de 15GB de espacio libre en la unidad C: para la partición del
sistema. Para evitar problemas en el sistema, se recomienda
que guarde el archivo de vídeo capturado en una ubicación
distinta a la unidad C:, limite el tamaño de archivo del vídeo
capturado o reduzca la resolución del vídeo.

Para reducir el tamaño de salida de la resolución del 
vídeo:
1. Ejecute la aplicación de cámara desde el acceso directo en el 

escritorio.

2. Vaya a Options y seleccione Video Capture Pin....

3. Haga clic en el cuadro desplegable Tamaño de salida y 
seleccione un tamaño de resolución menor para reducir el tamaño 
del archivo capturado.
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Módulo WLAN (Opción)
Asegúrese de que el módulo WLAN esté encendido antes de
iniciar el proceso de instalación del controlador (utilice el
menú en pantalla (OSD) para el encendido del módulo
WLAN - ver la página 91).

Instalación del controlador de WLAN
Siga las instrucciones siguientes:

WLAN y Bluetooth Combo (Intel)
1. Haga clic en Option Drivers (botón).
2. Haga clic en 2.Install WLAN Driver > Sí.
3. Haga clic en Siguiente > Siguiente.
4. Haga clic en el botón Acepto los términos del contrato de 

licencia, luego haga clic en Siguiente.
5. Haga clic en Tipica (botón) o Personalizada (botón).
6. Haga clic en Instalar > Finalizar.

WLAN (de tercera parte) 
1. Haga clic en Option Drivers (botón).
2. Haga clic en 2.Install WLAN Driver > Sí.
3. Elija el idioma que prefiera y haga clic en Siguiente.
4. Haga clic en Siguiente > Instalar.
5. Haga clic en Finalizar para completar la instalación.

WLAN y Bluetooth 4.0 Combo (de tercera parte) 
1. Haga clic en Option Drivers (botón).
2. Haga clic en 2.Install WLAN Driver > Sí.
3. Haga clic en Siguiente.
4. Haga clic en Finalizar para completar la instalación.

Conectar a una red inalámbrica
El sistema operativo es la configuración predeterminada para
el control de LAN inalámbrica en Windows. Compruebe que
el módulo WLAN esté activado.

1. Haga clic en el icono de LAN inalámbrica  en la barra de tareas 
y luego haga doble clic en un punto de acceso para conectarse o 
haga clic para Abrir Centro de redes y recursos compartidos si 
no ve la red a la que desea conectarse en el menú de la barra de 
tareas (aparecerá una lista de opciones para poder cambiar la 
configuración y crear una nueva red).

2. Puede que necesite introducir una clave de seguridad para un 
punto de acceso al que intenta conectarse.

3. Haga clic para seleccionar una ubicación de red (p.ej. Red 
doméstica, Red de trabajo o Red pública).

4. Haga clic en “Ver o cambiar la configuración en el Centro de 
redes y recursos compartidos” para acceder a más opciones 
para la conexión.

5. Haga clic en el icono de la barra de tareas  para ver las redes 
conectadas actualmente.

6. Para desconectar de la red inalámbrica, puede hacer clic en el 
icono de la LAN inalámbrica , hacer clic en la conexión activa y 
luego en Desconectar (botón).
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Intel® Wireless Display 
Application
La aplicación de pantalla inalámbrica Intel® (Intel®
Wireless Display Application) (necesita Intel® Centrino
WLAN/módulo combo), junto con un adaptador de vídeo
compatible (se vende por separado), le permite ver el
contenido de la pantalla del portátil en otra pantalla (p.ej.
HDTV) sin necesidad de extender cables por toda la
habitación. Podrá jugar a videojuegos, explorar Internet,
mostrar vídeos o presentaciones de fotos en su televisor o
pantalla externa sin usar cables HDMI o A/V.

Antes de configurar la aplicación Intel® WiDi necesitará
ajustar su adaptador compatible con su pantalla o altavoces.
Conecte el adaptador usando un cable HDMI o A/V y
encienda la pantalla (y si hay altavoces, conéctelos al
adaptador de altavoces inalámbrico con los cables incluidos
con el adaptador), y luego ajuste la pantalla al canal de
entrada apropiado (vea la documentación incluida con su
adaptador compatible para más detalles).

Intel® WiDi también incorpora Intel® Wireless Music que
le permite emitir audio de forma inalámbrica desde el
ordenador a los altavoces conectados a un adaptador de
altavoces inalámbrico compatible (se vende por separado).

Instalación de la aplicación Intel® WiDi
1.  Haga clic en Option Drivers (botón).
2. Haga clic en 3.Install WiDi AP > Sí.
3. Haga clic en Siguiente.
4. Haga clic en el botón para aceptar la licencia, luego haga clic 

en Siguiente.
5. Haga clic en Finalizar.

Configuración de la aplicación Intel® 
WiDi
1. Haga clic en Inicio > Todos los programas > Intel Corporation 

> Intel(R) Wireless Display > Intel(R) Wireless Display, o haga 
doble clic en el icono  en el escritorio.

2. Haga clic en Acepto los términos de esta licencia (botón).

3. La aplicación buscará un adaptador compatible conectado (o 
puede hacer clic en el botón Explorar en busca de adaptadores 
disponibles para habilitar la tecnología Intel My WiFi).

4. Haga clic para seleccionar el adaptador detectado, y haga clic en 
conectar.

5. El sistema le pedirá entonces introducir el código de seguridad 
de 4 dígitos que aparecerá en la pantalla de televisión externa.

6. Escriba el código para el adaptador de vídeo y haga clic en 
Continuar.

7. Entonces se le pedirá que escriba un nombre para el adaptador 
de vídeo y haga clic en Continuar.

8. Haga clic en Finalizado para completar la instalación.
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Módulo Bluetooth (Opción)
Asegúrese de que el módulo Bluetooth esté encendido antes
de iniciar el proceso de instalación del controlador (utilice el
menú en pantalla (OSD) para el encendido del módulo
Bluetooth - ver la página 91).

Instalación del controlador de Bluetooth
Siga las instrucciones siguientes:

WLAN y Bluetooth Combo (Intel)
1. Haga clic en Option Drivers (botón).
2. Haga clic en 4.Install Combo BT Driver > Sí.
3. Haga clic en Siguiente > Siguiente.
4. Haga clic en el botón para aceptar el acuerdo de licencia, 

luego haga clic en Siguiente.
5. Haga clic en Siguiente > Finalizar.

WLAN y Bluetooth 4.0 Combo (tercera parte) 
1. Haga clic en Option Drivers (botón).
2. Haga clic en 4.Install Combo BT Driver > Sí.
3. Haga clic en Siguiente.
4. Haga clic en Finalizar para reiniciar el sistema.

Configuración de Bluetooth
Configurar su dispositivo Bluetooth para que 
el ordenador pueda encontrarlo
1. Encienda su dispositivo Bluetooth (p. ej. PDA, teléfono móvil, 

etc.).

2. Deje al dispositivo accesible (para hacerlo consulte la 
documentación del dispositivo).

Para encender el módulo Bluetooth
1. Utilice el menú en pantalla (OSD) para activar el módulo 

Bluetooth. 

2. Aparecerá un icono de Bluetooth  en la barra de tareas.

3. Luego podrá hacer lo siguiente para acceder al panel de control 
Dispositivos Bluetooth.

• Haga doble clic en el icono  para acceder al panel de control 
Dispositivos Bluetooth.

• Haga clic en/Haga clic con el botón derecho en el icono  y 
elija una opción desde el menú.

Ayuda Bluetooth
Haga clic en Inicio y seleccione Ayuda y Soporte y luego
escriba Bluetooth en el cuadro Buscar ayuda y haga clic en
el icono de la lupa para buscar más información sobre la
transferencia por Bluetooth.
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TPM (Trusted Platform Module)
Antes de configurar las funciones del TPM deberá iniciar la
plataforma de seguridad.

Activar TPM
1. Reinicie el ordenador.

2. Entre en Aptio Setup Utility pulsando F2 durante el POST.

3. El menú Security aparecerá.

4. Seleccione TPM Configuration y presione Entrar.

5. Seleccione TPM Support y presione Entrar. Seleccione Enable y 
presione Entrar.

6. Seleccione TPM State, presione Entrar y seleccione Enable 
(Activar) para cambiar el estado de TPM a activado. Luego deberá 
presionar F4 para guardar los cambios y reiniciar el ordenador.

7. Cuando el ordenador reinicie presione F2 para entrar en la BIOS 
de nuevo y vaya al menú TPM Configuration (Configuración de 
TPM).

8. Seleccione Pending TPM operation (Operación TPM pendiente), 
presione Entrar y seleccione la opción necesaria (si está 
inicializando TPM debería seleccionar Enable Take Ownership 
(Activar tomar posesión). Luego deberá presionar F4 para guardar 
los cambios y reiniciar el ordenador.

9. Ahora puede instalar el controlador TPM y luego inicializar el 
TPM.

Instalación del controlador TPM
1. Haga clic en Option Drivers (botón).
2. Haga clic en 5.Install TPM Driver > Sí.
3. Haga clic en Instalar > Siguiente.
4. Haga clic en el botón para aceptar el acuerdo de licencia, 

luego haga clic en Siguiente.
5. Haga clic en Siguiente > Siguiente >Instalar.
6. Haga clic en Finalizar > Sí para reiniciar el sistema.
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Inicializar el TPM
1. Ejecute la aplicación del TPM desde la opción La solución 

Infineon Security Platform > Administrar Security Platform en 
el menú Inicio > Programas/Todos los programas.

2. Haga clic en Configuración del usuario, y haga clic en Sí, o 
haga clic con el botón derecho en el icono  en el área de 
notificación de la barra de tareas y seleccione Inicialización de 
Security Platform (o haga clic en la burbuja de la barra de tareas 
Security Platform State (Estado de Security Platform)).

3. El método Inicialización rápida se seleccionará 
automáticamente (si necesita utilizar la configuración avanzada 
ofrecida por su administrador de red, seleccione Inicialización 
avanzada).

4. Necesitará usar una unidad extraíble (p. ej. una unidad Flash 
USB) para almacenar contraseñas y datos (guarde la unidad en 
un lugar seguro hasta que la necesite).

5. Seleccione la unidad que desea usar en el menú desplegable y 
haga clic en Siguiente.

6. Elija las Características de Security Platform que desee usar 
haciendo clic en la casilla apropiada.

7. Escriba una Contraseña básica de usuario (y vuelva a escribirla 
para confirmarla) y haga clic en Siguiente.

8. Haga clic en Siguiente para confirmar la configuración.

9. El ordenador inicializará la configuración.

10. Haga clic en Finalizar.

11. Haga clic en las fichas y paneles de control para ajustar la 
configuración.

12. Haga doble clic en el icono de la barra de tareas  para acceder 
a la Herramienta de configuración de Infineon Security 
Platform o haga clic con el botón derecho en el icono  y 
seleccione un elemento del menú.

Herramienta de configuración de 
Infineon Security Platform
La Herramienta de configuración de Infineon Security
Platform le permite administrar y comprobar el estado de la
TPM, administrar su información de contraseñas y copiar y
restaurar los datos de la TPM. Como la TPM normalmente es
administrada en empresas y organizaciones grandes, su
administrador de sistemas deberá asesorarle para administrar
esta información.Figura 15

Asistente 
para la ini-
cialización 
rápida de 
Security 
Platform

Figura 16
Herramienta 
de configu-

ración de In-
fineon 

Security Pla-
tform
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Solución de problemas

Problema Posible causa - Solución

Los módulos WLAN y  
Bluetooth no pueden 
detectarse.

Los módulos están desactivados.  Presione el botón del menú de funciones durante unos dos 
segundos (vea la Tabla 3 en la página 91) para abrir el menú en pantalla. Marque el OSD 
apropiado para ver si está encendido o apagado.

No se escucha sonido a 
través del dispositivo de 
pantalla HDMI conectado.

No ha configurado la salida de audio HDMI. Consulte "Configuración de audio para HDMI" en la
página 99.

Los archivos de vídeo
capturados de la cámara PC
ocupan demasiado espacio
en el disco.

Tenga en cuenta que capturar archivos de vídeo de alta resolución requiere una cantidad sustancial
de espacio en el disco para cada archivo.

Tenga en cuenta que el sistema Windows requiere un mínimo de 15GB de espacio libre en la
partición del sistema unidad C:. Se recomienda que guarde el archivo de vídeo capturado en una
ubicación distinta a la unidad C:, limite el tamaño de archivo del vídeo capturado o reduzca la
resolución del vídeo (Options > Video Capture Pin... > Tamaño de salida).
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Especificaciones


Información actualizada de 

especificaciones

Las especificaciones listadas en este
Apéndice son correctas en el momento
de publicación. Ciertas opciones (parti-
cularmente tipos/velocidades de proce-
sadores) pueden cambiar o
actualizarse según la fecha de lanza-
miento del fabricante. Diríjase a su cen-
tro de servicios para más detalles.

Opciones de procesadores

Procesador Intel® Core i7

i7-3770S (3,10GHz)

Caché de nivel 3 de 8MB, 22nm, DDR3-
1600MHz, TDP 65W

i7-3570S (3,10GHz)

Caché de nivel 3 de 6MB, 22nm, DDR3-
1600MHz, TDP 65W

Procesador Intel® Core i5

i5-3550S (3,00GHz), i5-3475S (2,90GHz), 
i5-3470S (2,90GHz), i5-3450S (2,80GHz), 
i5-3570T (2,30GHz)

Caché de nivel 3 de 6MB, 22nm, DDR3-
1600MHz, TDP 65W

Procesador Intel® Pentium

G640 (2,80GHz)

Caché de nivel 3 de 3MB, 22nm, DDR3-
1066MHz, TDP 65W

Procesador Intel® Celeron®  

G540 (2,50GHz)

Caché de nivel 3 de 2MB, 22nm, DDR3-
1066MHz, TDP 65W

Núcleo logic

Chipset Intel(R) HM61

BIOS

AMI BIOS (SPI Flash ROM de 48Mb)

Memoria

Dos zócalos de 204 pins SODIMM, para 
memoria DDR3 1333/1600MHz

Memoria expansible hasta 8GB

Adaptador de vídeo

GPU integrada de Intel® 

(La GPU depende del procesador)

Intel® HD Graphics

Frecuencia dinámica (Tecnología de 
memoria de vídeo dinámica Intel hasta 
1,7GB)

Compatible con DirectX® 10

Intel® HD Graphics 2500

Frecuencia dinámica (Tecnología de 
memoria de vídeo dinámica Intel hasta 
1,7GB)

Compatible con DirectX® 11

Intel® HD Graphics 4000

Frecuencia dinámica (Tecnología de 
memoria de vídeo dinámica Intel hasta 
1,7GB)

Compatible con DirectX® 11

LCD

21,5" (54,61cm) FHD

Dispositivos de almacenamiento

(Opción de fábrica) Una unidad de 
dispositivo óptico de 12,7mm(h) 
intercambiable (módulo unidad Super Multi/ 
módulo unidad combo Blu-Ray)

Un HDD SATA intercambiable de 2,5" 9,5mm 
(h)

Un HDD SATA intercambiable de 3,5" 25mm 
(h)
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Audio

Interfaz compatible HDA  

2 altavoces incorporados

Micrófono incorporado 

Seguridad

Ranura para cierre de seguridad (tipo 
Kensington®)

Contraseña de BIOS

Interfaz

Cuatro puertos USB 2.0

Dos puertos USB 3.0 

Un conector de entrada de HDMI

Un conector de salida HDMI 

Un conector de salida de altavoces/
auriculares

Un conector de entrada para micrófono

Dos puertos serie (COM)

Dos puertos PS/2

Un conector LAN RJ-45

Un conector de entrada de DC

Ranuras

Una ranura Mini-Card para módulo LAN 
inalámbrica o módulo combo Bluetooth y 
LAN Inalámbrica

Una ranura ExpressCard/54(34)

Lector de tarjetas

Módulo lector de tarjetas multi-en-1 

MMC (MultiMedia Card) / RS MMC

SD (Secure Digital) / Mini SD / SDHC/ 
SDXC 

MS (Memory Stick) / MS Pro / MS Duo

Teclado & dispositivo puntero
(Opción de fábrica) Teclado y ratón USB  
por RF con transceptor 

Comunicaciones

LAN Ethernet de 1Gbit incorporada

(Opcion de fábrica) Módulo cámara PC 
FHD (2,0M)
 

Módulos Half Mini-Card WLAN/ Bluetooth:

(Opción de fábrica) Bluetooth 4.0 y LAN 
inalámbrica (802.11b/g/n) Intel® Centrino® 
Wireless-N 2230

(Opción de fábrica) LAN inalámbrica 
(802.11b/g/n) (tercera parte)

(Opción de fábrica) Bluetooth 4.0 y LAN 
Inalámbrica (802.11b/g/n) (tercera parte)

Alimentación

Adaptador de AC/DC autodetector de 
corriente

Entrada AC: 100~240V, 50~60Hz

Salida DC: 19V, 6,3A (120W)

(Opción de fábrica) Batería de Litio-Ion 
inteligente de 6 elementos, 62,16WH 

Especificaciones del ambiente

Temperatura

En funcionamiento: 5°C - 35°C 

Apagado: -20°C - 60°C

Humedad relativa

En funcionamiento: 20% - 80%

Apagado: 10% - 90%

Dimensiones y peso

525 (a) x 49 (l) x 418 (h) mm

Alrededor de 7kgs (con unidad óptica)
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Informazioni sulla Guida Rapida per l'Utente
Questo manuale rappresenta un’introduzione rapida all’avvio del sistema. Si tratta di un supplemento e non di una
sostituzione del Manuale per l'utente completo in lingua inglese nel formato Adobe Acrobat, memorizzato sul disco Device
Drivers & Utilities + User's Manual fornito a corredo del computer. Inoltre, questo disco contiene i driver e le utilità necessari
per il corretto uso del computer (Nota: La società si riserva il diritto di revisionare la presente pubblicazione o di modificarne
il contenuto senza preavviso).

È possibile che alcune o tutte le funzionalità del computer siano già state configurate. In caso contrario, o se si sta pianificando
di riconfigurare (o reinstallare) componenti del sistema, fare riferimento al Manuale utente completo. Il disco Device Drivers
& Utilities + User’s Manual non contiene il sistema operativo.

Informazioni legali e di sicurezza
Prestare particolare attenzione alle informative legali e di sicurezza contenute nel manuale dell'utente che si trova sul disco
Device Drivers & Utilities + User’s Manual.

©  Agosto 2012

Marchi registrati
Intel ed Intel Core sono marchi/marchi registrati della Intel Corporation.
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Istruzioni per la custodia e il 
funzionamento
Il computer è abbastanza rigido, ma è possibile che possa
essere danneggiato. Per evitare qualsiasi danno, attenersi ai
seguenti suggerimenti:

• Non lasciarlo cadere ed evitare urti. Se il computer cade, è possibile 
che il telaio e i componenti possano esserne danneggiati.

• Tenerlo all'asciutto e non provocarne il surriscaldamento. Tenere 
il computer e l'alimentazione lontani da ogni tipo di impianto di 
riscaldamento. Si tratta di un apparato elettrico. Se acqua o altri 
liquidi dovessero penetrarvi, esso potrebbe risultarne seriamente dan-
neggiato.

• Evitare le interferenze. Tenere il computer lontano da trasformatori 
ad alta capacità, motori elettrici e altri intensi campi magnetici. Ciò ne 
può impedire il corretto funzionamento e danneggiare i dati.

• Attenersi alle corrette procedure di lavoro con il computer. Spe-
gnere il computer correttamente e non dimenticare di salvare il pro-
prio lavoro. Ricordare di salvare frequentemente i propri dati poiché 
essi potrebbero essere persi nel caso in cui la batteria si esaurisse.

• Si noti che nei computer che hanno un logo elettroimpresso LCD in 
rilievo, questo è coperto da un adesivo protettivo. Nell'uso quotidiano e 
con il passare del tempo, questo adesivo potrebbe deteriorarsi e il logo 
sottostante potrebbe avere del bordi acuminati. In questo caso, fare 
attenzione quando si maneggia il computer ed evitare di toccare il logo 
elettroimpresso LCD in rilievo. Se si sviluppano parti consumate e 
logorate, contattare il centro di assistenza.

Sicurezza dell'alimentazione e della batteria 
• Utilizzare esclusivamente un adattatore AC/DC approvato per l'uti-

lizzo di questo computer.
• Utilizzare solo il cavo di alimentazione e le batterie indicate in questo 

manuale.
• L'adattatore AC/DC potrebbe essere stato progettato per viaggi 

all'estero, ma richiede ugualmente un'alimentazione stabile e conti-
nua. Se non si è certi delle specifiche elettriche locali, consultare 

l'assistenza tecnica o la società locale di fornitura elettrica.
• L'adattatore di alimentazione deve avere una spina dotata di messa a 

terra a due o tre poli. Il terzo polo costituisce un'importante funziona-
lità di sicurezza. Non rinunciare al suo impiego. Se non è disponibile 
una presa compatibile, farne installare una da un elettricista qualifi-
cato.

• Quando si desidera scollegare il cavo dell'alimentazione, accertarsi di 
scollegarlo toccando la testa della spina, non il suo cavo.

• Accertarsi che la presa e ogni prolunga utilizzata siano in grado di 
supportare il carico di corrente totale risultante da tutte le periferiche 
collegate.

• Utilizza unicamente batterie progettate per questo computer. Un tipo 
di batteria errato potrebbe esplodere, avere perdite o danneggiare il 
computer.

• Non continuare a usare in alcun modo una batteria che sia caduta in 
terra o che sembri danneggiata (es. piegata o torta). Anche se il com-
puter continua a funzionare con una batteria danneggiata, questa può 
provocare danni ai circuiti risultanti in pericolo di incendio.

• Ricaricare le batterie utilizzando il sistema del computer. Un'opera-
zione di ricarica non corretta può far esplodere la batteria.

• Non provare a riparare il pacco batteria. Fare riferimento sempre 
all'assistenza tecnica o a personale qualificato per la riparazione o la 
sostituzione del pacco batteria.

• Tenere i bambini lontani da una batteria danneggiata e provvedere 
tempestivamente al suo smaltimento. Smaltire sempre con cura le bat-
terie. Le batterie possono esplodere o presentare perdite se esposte a 
fuoco oppure se manipolate o smaltite impropriamente.

• Tenere la batteria lontana da qualsiasi apparecchio di metallo.
• Apporre del nastro adesivo sui contatti della batteria prima di smal-

tirla.
• Non gettare le batterie nel fuoco, poiché potrebbero esplodere. Fare 

riferimento alle normative locali per istruzioni speciali in tema di 
smaltimento rifiuti.

• Non toccare i contatti della batteria con le mani o con oggetti metal-
lici.
114 



Italian
o

Precauzioni relative alla batteria ai polimeri
Le informazioni seguenti sono molto importanti e si
riferiscono unicamente alle batterie ai polimeri e, ove
applicabile, hanno priorità rispetto alle precauzioni generali
relative alle batterie.

• Le batterie ai polimeri possono espandersi o gonfiarsi leggermente, 
tuttavia questo fa parte del meccanismo di sicurezza della batteria e 
non deve essere causa di preoccupazione.

• Maneggiare le batterie ai polimeri in modo corretto nel loro utilizzo. 
Non utilizzare batterie ai polimeri in ambienti con temperature ele-
vate e non conservare le batterie inutilizzate per periodi di tempo pro-
lungati.

Assistenza
Ogni tentativo di riparare da soli il computer può annullare la
garanzia ed esporre l'utente a scosse elettriche. Per l'assistenza
rivolgersi solo a personale tecnico qualificato, in particolar
modo nelle situazioni seguenti:

• Quando il cavo di alimentazione o l'adattatore AC/DC è danneggiato 
o logorato.

• Se il computer è stato esposto alla pioggia o ad altri liquidi.
• Se il computer non funziona normalmente dopo aver seguito corretta-

mente le istruzioni operative.
• Se il computer è caduto o si è danneggiato (non toccare il liquido 

velenoso in caso di rottura dello schermo LCD).
• Se c'è un odore non usuale, calore o fumo che fuoriesce dal computer.

Pulizia
• Per pulire il computer utilizzare solo un panno morbido e pulito, evi-

tando di applicare detergenti direttamente sul computer.
• Non utilizzare detergenti volatili (distillati di petrolio) o abrasivi su 

qualsiasi parte del computer.
• Prima di pulire il computer ricordare sempre di rimuovere la batteria e 

di scollegare il computer da qualsiasi fonte di alimentazione esterna, 
da periferiche e altri cavi (incluse linee telefoniche).


Smaltimento della batteria & Attenzione

Il prodotto acquistato contiene una batteria ricaricabile. La
batteria è riciclabile. Al termine della durata di uso, in base alle
diverse leggi locali e statali, può essere illegale smaltire
questa batteria insieme ai rifiuti comuni. Controllare i requisiti
previsti nella propria zona consultando i funzionari locali
addetti allo smaltimento dei rifiuti solidi per le opzioni di riciclo
o lo smaltimento corretto.

Pericolo di esplosione in caso sostituzione errata della
batteria. Sostituire solamente con lo stesso tipo o con uno
analogo raccomandato dal produttore. Eliminare la batteria
usata seguendo le istruzioni del produttore.
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Guida di avvio rapido
1. Eliminare tutti i materiali di imballo.

2. Appoggiare il computer su una superficie stabile.

3. Collegare bene le periferiche che si desidera usare con il computer alle porte corrispondenti.

4. Collegare l'adattatore AC/DC al jack di ingresso CC situato sul retro dello schermo LCD, quindi inserire il cavo di alimentazione AC in una 
presa e collegare il cavo di alimentazione AC all'adattatore AC/DC.

5. Premere il pulsante di alimentazione davanti al computer (sotto lo schermo LCD) per accendere il computer.

Figura 1 - Computer con alimentatore AC/DC collegato/pulsante di alimentazione

Software del sistema
È possibile che il software sia già pre-installato sul computer. In caso contrario, oppure in casi di riconfigurazione del
computer per un sistema diverso, questo manuale si riferisce a Microsoft Windows 7.


Spegnimento

È importante tenere presente che è sempre necessario spegne-
re il computer scegliendo il comando Arresta il sistema dispo-
nibile dal menu Start.

In questo modo si evitano problemi al sistema o al disco rigido.

Pulsante di alimentazione 
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Descrizione del sistema: Vista anteriore

4

3 1

5

2

Figura 2 - Vista anteriore

1. Microfono incorporato

2. Camera PC (opzionale)

3. LED della camera PC

4. Schermo LCD 

5. Pulsante di alimentazione

6. Pulsanti funzione 

7. Indicatori LED

8. Altoparlanti incorporati

7 6 88

57 6
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Indicatori LED
Gli indicatori LED sul computer segnalano importanti in-
formazioni relative allo stato corrente del computer.

Tabella 1 - Indicatori LED

Pulsanti funzione

Tabella 2 - Pulsanti funzione 

Icona Colore Descrizione

Verde Il computer è acceso

Verde lampeg-
giante

Il computer è in modalità 
Sospensione

Arancione L'alimentatore è collegato

Arancione La batteria è in carica

Bianco Batteria completamente carica

Arancione lam-
peggiante

La batteria ha raggiunto lo stato 
critico di carica bassa

Verde
Cavo HDMI collegato (se il com-

puter è spento) - vedere la 
pagina 122

Verde Il disco rigido è in uso

Verde Il modulo LAN Wireless è attivo

Arancione Il modulo Bluetooth è attivo

Icon Description

Pulsanti Aumenta/Diminuisci - Utilizzare questi 
pulsanti per aumentare/ridurre la luminosità e il 

volume

Selezione menu - Utilizzare questo pulsante per 
passare dal menu luminosità al menu audio e 

viceversa, quindi utilizzare i pulsanti superiori per 
effettuare le regolazioni

Selezione Modalità - Utilizzare questo pulsante 
per selezionare le modalità del computer e 

dell'ingresso HDMI 
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Indicatori a schermo (OSD)
Tenere premuto il pulsante del menu funzione per circa due secondi (vedere la Tabella 2 a pagina 118) per aprire la
schermata. Quando è installato Hotkey AP (vedere "Hotkey AP" a pagina 130), l'OSD rende disponibili indicatori visivi
per luminosità, volume, accensione/spegnimento di videocamera, Bluetooth e WLAN (si noti che gli indicatori di
accensione/spegnimento di videocamera, WLAN e Bluetooth vengono visualizzati solo se nella configurazione acquistata
sono inclusi questi moduli).

Tabella 3 - Pulsanti OSD

Gli indicatori appaiono quando il computer si avvia o viene ripreso da uno stato di risparmio energetico, allo scopo di
mostrare lo stato corrente del modulo videocamera e/o Bluetooth.   Quando si regola la luminosità o il volume, gli indicatori
a schermo appaiono e permettono all'utente di regolare anche lo stato di accensione/spegnimento del modulo videocamera
e/o Bluetooth con un clic del mouse sull'icona.

Icona OSD Descrizione

Riduzione/Aumento luminosità LCD

Riduzione/Aumento volume audio

Attiva/disattiva il modulo LAN wireless

Attiva/disattiva il modulo Bluetooth

Attiva/disattiva Camera PC
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Kit tastiera e mouse senza fili optional
Per questa serie di computer è disponibile un kit tastiera e
mouse USB senza fili optional. Una porta USB che si trova
nella parte inferiore del coperchio posteriore è progettata
per alloggiare il ricetrasmettitore del kit tastiera e mouse
USB senza fili. 

Figure 3
Kit tastiera 

e mouse 
senza fili 
optional


Dongle e porte USB

per tastiera e mouse viene fornito un singolo
dongle USB (che opera come un
ricetrasmettitore per tastiera e mouse).
Questo dongle può essere inserito in
qualsiasi porta USB. Tuttavia, si consiglia di
utilizzare la porta USB specificatamente
fornita per questo scopo.


Porta USB del ricetrasmettitore senza fili

Si noti che la porta USB del ricetrasmettitore senza fili  è
stata progettata specificatamente per il kit tastiera e mouse a
radiofrequenza opzionale fornito solo con questo modello.

Non utilizzare nessun altro dispositivo USB in questa porta.

1

Figura 4 - Porta USB per kit 
tastiera e mouse wireless

1

120 



Italian
o

Descrizione del sistema: Vista sinistra Figura 5
Vista sinistra

1. Supporto

2. Lettore di schede multi-
in-1

3. Slot ExpressCard/54(34)

4. 2 * Porte USB 3.0

5. Porta ingresso HDMI

6. Porta uscita HDMI

1


Porta USB 3.0

Le porte USB 3.0  sono di colo-
re blu. USB 3.0 trasferisce i dati
molto più velocemente di USB 2.0
ed è compatibile con i dispositivi
USB 2.0.

Lettore di schede multi-en-1 

Il lettore di schede consente di uti-
lizzare alcune tra le più recenti 

schede di memoria digitali.
 

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / 

SDHC/ SDXC
MS (Memory Stick) / MS Pro / MS 

Duo 

4

1

2

3

4

5

6

4
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Porta d'ingresso HDMI
Questo computer è dotato di una porta d'ingresso HDMI che consente di visualizzare sorgenti esterne come lettori Blu-Ray,
DVD, decoder, console di videogame ecc. sullo schermo del computer.

Non è necessario accendere il computer per visualizzare il video e riprodurre l'audio proveniente da sorgenti esterne. Se il
computer sia collegato a una sorgente di alimentazione tramite l'alimentatore AC/DC (l'indicatore LED  è di colore aran-
cione se il computer è collegato ma spento), è sufficiente collegare il cavo HDMI dal dispositivo esterno alla porta d'ingresso
HDMI del computer per consentire al computer di funzionare come dispositivo di visualizzazione. Se il computer è alimen-
tato a batteria, premere il pulsante di accensione sul computer per accendere il computer e poter utilizzare la porta d'ingresso
HDMI-In.

Selezione Modalità
Tenere premuto il pulsante di selezione  per passare dalla visualizzazione d'ingresso HDMI a quella del computer e
viceversa. Quando viene visualizzato la “Input Source HDMI (Sorgente di input HDMI)” è possibile utilizzare qualsiasi di-
spositivo HDMI collegato alla porta HDMI-In del computer. Una pressione rapida del pulsante accende/spegne lo scher-
mo.

Nella tabella seguente sono indicate le funzioni esistenti quando è collegato un cavo HDMI alla porta d'ingresso HDMI-In.

Tabella 4 - Funzioni di selezione della modalità quando è collegato un cavo HDMI

Stato di alimentazione del 
computer Icona HDMI 

Pulsante di selezione 

della modalità 

(Tenere premuto)

Pulsante di selezione 

della modalità 

(Pressione rapida)

Il computer è accesso (con ali-
mentatore/batteria)

indica lo stato di carica solo batte-
ria

Toggles between computer 
display and HDMI input

accende/spegne lo schermo

Il computer è spento (ma è colle-
gato all'alimentatore)

verde (con cavo HDMI collegato e 
pulsante di selezione modalità 
tenuto premuto per selezionare 

l'ingresso HDMI)

Toggles between computer 
display and HDMI input

accende/spegne lo schermo
122



Italian
o

Descrizione del sistema: Vista destra

Figura 6
Vista destra

1. Foro di espulsione di 
emergenza

2. Bay unità ottica

3. Jack uscita delle cuffie

4. Jack ingresso del 
microfono

5. 2 * Porte USB 2.0

6. Supporto


Espulsione di emergenza del disco

Se si desidera estrarre manualmente
un disco (per esempio a causa di
un'inaspettata interruzione
dell'alimentazione) è possibile
spingere l'estremità di una graffetta per
carta raddrizzata nel foro di espulsione
di emergenza. Non usare una matita
appuntita o un oggetto analogo che
potrebbe rompersi oppure rimanere
incastrato nel foro.


Trasportare il computer

È vivamente consigliato di utilizzare entrambe le mani per
spostare il computer. È possibile utilizzare una sola mano per
afferrare il computer dal supporto e l'altra per tenere la parte
superiore dello schermo LCD. 

Si consiglia di trasportare il computer con lo schermo
LCD rivolto verso il proprio corpo onde evitare di graffiare
la superficie contro altri oggetti. Fare attenzione a non
graffiare lo schermo LCD con oggetti personali, come ad
esempio la fibbia della cintura, un gioiello e così via (af-
ferrare con una mano il supporto e con l'altra la parte su-
periore del computer per evitarne la caduta accidentale).

3

1

2

4
5

5

6
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Inclinazione dello schermo
È possibile inclinare lo schermo LCD per ottenere il miglior
angolo di visione possibile dello schermo senza riflessi, e
così via.

1. Appoggiare una mano sopra il the computer  e utilizzare l'altra 
mano per aprire il supporto  a un'angolazione di circa 15 gradi 
dalla posizione verticale (il supporto consentirà all'utente di 
regolare l'angolazione migliore tirando e lasciando il richiamo della 
molla).

Figura 7 - Regolare il supporto

2. Applicare una pressione con una mano sopra il computer (al punto 
), tenendolo dal lato con l'altra mano, quindi spingere lo 

schermo LCD verso il basso per inclinarlo all'angolazione di 
visione desiderata (fino a 50 gradi dalla posizione verticale).

3. Con una mano sopra il computer, tenendolo dal lato con l'altra 
mano, muovere il computer di nuovo nella posizione originale.

Figure 8 - Inclinazione dello schermo

1
2

Regolare il supporto
per inclinare il compu-
ter di 15° dalla posizio-
ne verticale. 

15°

1

2

3


DVD Operation

Note that although the
computer may be tilted up to
an angle of 50 degrees from
the vertical position, the
DVD-ROM drive will only
work (i.e continue to spin and
read DVDs) up until an angle
of around 35 degrees from
the vertical position. 

If you have any problems
with the system reading
DVDs, adjust the tillt angle
accordingly.

Applicare una
pressione sulla
parte superiore
dello schermo per
regolare il suppor-
to in fuori (fino a
50° dalla posizio-
ne verticale). 

50°

3

50°
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Descrizione del sistema: Vista posteriore


CPU

La CPU non è un componente
che necessita assistenza da
parte dell’utente. Accedere alla
CPU in qualsiasi modo implica
una violazione della garanzia.

Surriscaldamento

Per prevenire il surriscaldamento
del computer, accertarsi che non
vi sia nulla che ostruisca la (le)
ventola (ventole) durante l’uso del
computer.

Informazioni per il montaggio 
a parete

Il computer può essere montato
su una parete per la visione. Il
sistema soddisfa i requisiti dello
Standard VESA (FDMI)
(100mm x 100mm) per il
montaggio su una parete. Per
montare il sistema a parete si
consiglia comunque di
contattare il centro assistenza
per informazioni su come
evitare infortuni personali o
danni al computer.

Figure 9 - Vista posteriore

1. Coperchi posteriore 
componenti

2. Supporto

3. Ventola

4. Area maniglia di trasporto

5. Coperchio del ricetrasmettitore 
wireless USB (per il kit tastiera 
e mouse a radiofrequenza 
opzionale)

6. Slot blocco di sicurezza

7. Batteria (Optional)

8. 2 Porte seriali (COM) 

9. Porta PS/2 (tastiera)

10. Porta PS/2 (mouse)

11. Jack di ingresso DC

12. 2 * Porte USB 2.0

13. Jack RJ-45 per LAN

1

3

2

8

3

4

5

8

7

10

11

6

12 13

9
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Funzioni video
È possibile modificare le Impostazioni di visualizzazione
dal pannello di controllo schermo in ambiente Windows e/
o dal Pannello di controllo grafica e multimedia Intel, se
è installato il driver video.

Per accedere al pannello di controllo Schermo:
1. Fare clic su Start, e fare clic su Pannello di controllo (oppure 

scegliere Impostazioni e fare clic su Pannello di controllo).

2. Fare clic sull'icona Schermo - in Aspetto e personalizzazione 
(categoria).

3. Fare clic su Modifica risoluzione dello schermo/Modifica 
risoluzione.

O
4. In alternativa è possibile fare clic con il pulsante destro del mouse 

sul desktop e scegliere Risoluzione dello schermo.

5. Utilizzare la casella di riepilogo a discesa per selezionare la 
risoluzione dello schermo .

6. Fare clic su Impostazioni avanzate .

Per accedere al Pannello di controllo grafica e multi-
media Intel®:
1. Fare clic su Start, e fare clic su Pannello di controllo (oppure 

scegliere Impostazioni e fare clic su Pannello di controllo).

2. Fare clic sull'icona Grafica e multimedia Intel(R) nella vista 
Classica.

O
3. Fare clic con il pulsante destro del mouse sul desktop e scegliere 

Proprietà grafiche dal menu.

O
4. Fare clic sull'icona   nell'area di notifica della barra delle 

applicazioni e scegliere Proprietà grafiche dal menu.

5. Scegliere la modalità dell'applicazione (Modalità di base, 
Modalità avanzata o Modalità procedura guidata) e fare clic su 
OK.

1
2

2
1

Figura 10 - Pannello di controllo Schermo 

3

3 Figura 11
Pannello di controllo 
grafica e multimedia 

Intel 
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Funzionalità audio
È possibile configurare le opzioni audio del computer dal
pannello di controllo Audio  di Windows, oppure
dall'icona Gestione Audio Realtek HD /  nell'area di
notifica/pannello di controllo (fare clic con il pulsante destro
del mouse sull'icona  dell'area di notifica per aprire un
menu audio). 

Il volume può essere regolato anche mediante l'icona
dell'altoparlante nell'area di notifica o gli indicatori
visualizzati a schermo (vedere la pagina 119).

Configurazione per la registrazione audio
Per registrare sorgenti audio sul computer in qualità ottimale,
seguire le seguenti istruzioni:

1. Fare clic su Start, e fare clic su Pannello di controllo (oppure 
scegliere Impostazioni e fare clic su Pannello di controllo).

2. Fare clic su Gestione Audio Realtek HD (oppure fare clic con il 
pulsante destro del mouse sull'icona  nell'area di notifica e 
scegliere Gestione Sonoro).

3. Selezionare la scheda Effetti microfono nella scheda Microfono, 
quindi fare clic sul pulsante Soppressione dei disturbi o regolare 
il livello del Volume di registrazione a un valore intorno a 60 al fine 
di ottenere la qualità di registrazione ottimale.

4. Fare clic su OK per chiudere il pannello di controllo Audio .

Configurazione audio per HDMI
HDMI supporta i segnali video e audio.   In alcuni casi sarà
necessario aprire il pannello di controllo Suoni e configurare
manualmente l'uscita audio HDMI.

1. Fare clic su Start, e fare clic su Pannello di controllo (oppure 
scegliere Impostazioni e fare clic su Pannello di controllo). 

2. Fare clic su Audio  (Hardware e suoni).

3. Fare clic su Riproduzione (scheda).

4. Verrà selezionato il dispositivo di riproduzione.

5. In alcuni casi può essere necessario selezionare la periferica 
audio e fare clic Predefinito (pulsante).

6. Fare doppio clic sul dispositivo per accedere alle schede del 
pannello di controllo.

7. Modificare le impostazioni dell'HDMI dalle schede del pannello di 
controllo.

8. Fare clic su OK per chiudere il pannello di controllo Audio .

Figura 12 
Gestione Audio 

Realtek HD - 
Configurazione 
della registra-

zione

Figura 13 
Opzioni per la 
riproduzione 

dei suoni
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Funzioni di risparmio energetico
Il pannello di controllo delle Opzioni risparmio energia (menu Hardware e suoni) di Windows consente la configurazione
delle funzioni di risparmio energetico del computer. Selezionando Risparmio di energia è possibile attivare questa
funzione e configurare le opzioni relative al pulsante di alimentazione, pulsante di sospensione, schermo e modalità
sospensione. Nota: la funzione Risparmio di energia può influire sulle prestazioni del computer.

Fare clic su una delle combinazioni esistenti o su Crea combinazione per il risparmio di energia sul menu di sinistra e
personalizzarla per creare una nuova combinazione. Fare clic su Modifica impostazioni combinazione, quindi su Cambia
impostazioni avanzate risparmio energia per accedere a ulteriori opzioni di configurazione.

Figura 14 - Opzioni risparmio energia
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Installazione driver
Il disco Device Drivers & Utilities + User’s Manual
contiene i driver e le utilità necessari per il corretto
funzionamento del computer. Inserire il disco e fare clic su
Install Drivers (pulsante), oppure il pulsante Option
Drivers per accedere al menu del driver opzionale.
Installare i driver attenendosi all'ordine indicato nella
Tabella 5. Fare clic per selezionare i driver da installare (è
consigliabile annotarsi i driver quando li si installa). Nota:
Se occorre reinstallare un qualsiasi driver, è opportuno
disinstallare prima quello precedente.

Installazione manuale dei driver
Fare clic sul pulsante Browse CD/DVD nell'applicazione
Drivers Installer e selezionare il file eseguibile nella
cartella del driver corrispondente.

Se compare la finestra Trovato nuovo hardware durante la
procedura di installazione, fare clic su Annulla e seguire la
procedura di installazione come descritto.

Windows Update
Dopo l'installazione di tutti i driver assicurarsi di aver
attivato Windows update per ottenere tutti i recenti
aggiornamenti di sicurezza ecc. (tutti gli aggiornamenti
includeranno i più recenti hotfixes di Microsoft).

Tabella 5 - Procedura di installazione

Driver (Windows 7 con SP1)* Pagina#

Chipset pagina 130

Video (VGA) pagina 130

Rete (LAN) pagina 130

ExpressCard/Lettore di schede pagina 130

Hot-Key pagina 130

USB 3.0 pagina 130

Intel MEI pagina 130

Audio pagina 130

Camera PC (opzione) pagina 131

Modulo LAN Wireless (opzione) pagina 133

WiDi pagina 134

Modulo Bluetooth (opzione) pagina 135

TPM pagina 136

Attivare Windows update (vedere a sinistra)

*Si noti che tutti i driver forniti sono per Windows 7 con Service 
Pack 1.
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Chipset
1. Fare clic su 1.Install Chipset Driver > Sì.
2. Fare clic su Avanti > Sì > Avanti > Avanti.
3. Fare clic su Fine per riavviare il computer.

Video
1. Fare clic su 2.Install VGA Driver > Sì.
2. Fare clic su Avanti > Sì > Avanti > Avanti.
3. Fare clic su Fine per riavviare il computer.

Rete (LAN)
1. Fare clic su 3.Install LAN Driver > Sì.
2. Fare clic su Installa > Fine.
3. Ora è possibile configurare le impostazioni di rete.

ExpressCard/Lettore di schede
1. Fare clic su 4.Install CardReader Driver > Sì.
2. Fare clic su Installa > Fine.

Hotkey AP
1. Fare clic su 5.Install Hotkey AP > Sì.
2. Fare clic su Next > Next.
3. Fare clic su Finish > Finish per riavviare il computer.

USB 3.0
1. Fare clic su 6.Install USB 3.0 Driver > Sì.
2. Fare clic su Avanti.
3. Fare clic sul pulsante “Accetto i termini del contratto di 

licenza”, quindi fare clic su Avanti.
4. Fare clic su Avanti > Installa.
5. Fare clic su Fine.

Intel MEI
1. Fare clic su 7.Install MEI Driver > Sì.
2. Fare clic su Avanti > Sì > Avanti > Avanti.
3. Fare clic su Fine.

Audio
1. Fare clic su 8.Install Audio Driver > Sì.
2. Fare clic su Avanti.
3. Fare clic su Fine per riavviare il computer.


Installazione dei driver e alimentazione

Quando si installano i driver, assicurarsi che il computer sia
alimentato con l'alimentatore collegato a una fonte di corrente
funzionante. Alcuni driver assorbono una quantità
considerevole di energia durante la procedura d'installazione,
e se la capacità rimanente della batteria non è sufficiente, il
computer potrebbe spegnersi e causare problemi al sistema
(si noti che non si tratta di un problema legato alla sicurezza e
che la batteria sarà ricaricabile in un minuto).
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Camera PC (Opzione)
Assicurarsi che il modulo camera sia acceso prima di iniziare
il processo d'installazione del driver (utilizzare le icone a
schermo (OSD) per accendere il modulo camera - vedere la
pagina 119).

Quando l'applicazione Camera PC viene eseguita,
l'indicatore LED alla sinistra della camera si accenderà di
colore rosso (vedere "Descrizione del sistema: Vista
anteriore" a pagina 117).

Installazione del driver della camera PC
1. Fare clic su Option Drivers (pulsante).
2. Fare clic su 1.Install WebCam Driver > Sì.
3. Fare clic su Fine per riavviare il computer.

O
Fare clic su Avanti > Fine.

4. Eseguire l'applicazione della camera dal collegamento sul 
desktop (se l'hardware è spento, utilizzare la combinazione 
di tasti Fn + F10 per riaccenderlo).

Configurazione audio della camera PC
Configurare le opzioni di registrazione audio in Windows per
catturare video e audio con la camera.

1. Fare clic su Start, e fare clic su Pannello di controllo (oppure 
scegliere Impostazioni e fare clic su Pannello di controllo). 

2. Fare clic su Audio  (Hardware e suoni).

3. Fare clic su Registrazione (scheda).

4. Fare clic con il pulsante destro del mouse su Microfono (Realtek 
High Definition Audio) et accertarsi che la voce non sia disabilitata.

5. Fare doppio clic su Microfono (o selezionare Proprietà dal menu 
di scelta rapida ottenuto con il tasto destro del mouse).

6. Scegliere Livelli (scheda) e regolare i cursori Microfono e 
Preamplificazione microfono) per ottenere il livello richiesto.

7. Fare clic su OK, quindi chiudere i pannelli di controllo.

8. Eseguire l'applicazione della camera dal collegamento sul 
desktop.

9. Aprire il menu Dispositivi e selezionare Microfono (Realtek, 
ecc.) (accanto ad esso dovrebbe essere presente un segno di 
spunta).

10. Aprire il menu Cattura e selezionare Audio cattura (accanto ad 
esso dovrebbe essere presente un segno di spunta).

11. Per ottenere la migliore qualità di registrazione audio, attivare la 
Soppressione dei disturbi nel pannello di controllo Gestione 
Audio Realtek HD (vedere "Configurazione per la 
registrazione audio" a pagina 127).

Applicazione Camera PC e stati di risparmio energetico

Se il computer passa nella modalità Sospensione o
Ibernazione mentre è in esecuzione l'applicazione della
videocamera, il programma interromperà l'esecuzione e sarà
necessario riavviarla quando il sistema verrà ripreso dallo
stato di risparmio energetico.
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Applicazione della camera
L’applicazione della camera è un utile visualizzatore video
per la visualizzazione e il test di video generali, ed è inoltre
in grado di catturare file video in formato .avi.

1. Eseguire l'applicazione della camera dal collegamento sul 
desktop.

2. Aprire il menu Cattura (se si desidera catturare file di audio 
vedere "Configurazione audio della camera PC" a pagina 131) 
e selezionare Avvia cattura.

3. Fare clic su OK (la collocazione del file verrà visualizzata nella 
casella a scomparsa), per avviare la cattura, quindi premere Esc 
per interromperla (è possibile visualizzare il file utilizzando 
Windows Media Player).

Imposta cattura file
Prima di effettuare la cattura dei file di video si può
selezionare  l'opzione Imposta file di cattur nel menu File e
impostare il nome del file e la collocazione prima della
cattura (questo contribuirà a evitare la sovrascrittura dei file).
Impostare il nome e la collocazione poi cliccare Apri, quindi
impostare la "dimensione del file di cattura:" e cliccare OK.
Quindi è possibile avviare il processo di cattura di cui sopra.

Riduzione delle dimensioni dei file video
Si noti che la cattura di file video ad alta risoluzione richiede
una grande quantità di spazio sul disco rigido per ogni file.
Dopo aver registrato il video, controllare le dimensioni del
file video (fare clic con il pulsante destro del mouse sul file
e scegliere Proprietà) e lo spazio libero rimanente sul disco
rigido (aprire Computer, fare clic con il pulsante destro del
mouse sul disco rigido e scegliere Proprietà). Se necessario
è possibile spostare il file video registrato su un supporto
rimovibile, ad esempio CD, DVD o unità flash USB.

Si noti che il sistema operativo Windows richiede almeno
15GB di spazio libero sulla partizione di sistema dell'unità
C:. Per evitare problemi al sistema si consiglia di salvare il
file del video in una posizione diversa dall'unità C:, limitare
le dimensioni dei file del video catturato o ridurre la
risoluzione del video.

Per ridurre le dimensioni della risoluzione di output 
del video
1. Eseguire l'applicazione della camera dal collegamento sul 

desktop.

2. Aprire Opzioni e scorrere in giù per selezionare Video Capture 
Pin....

3. Scegliere l'elenco Dimensioni output e selezionare una 
risoluzione inferiore per ridurre le dimensioni del file catturato.
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Modulo LAN Wireless (Opzione)
Assicurarsi che il modulo LAN Wireless sia acceso prima di
iniziare il processo d'installazione del driver (utilizzare le
icone a schermo (OSD) per accendere il modulo LAN
Wireless - vedere la pagina 119).

Installazione del driver WLAN
Seguire le seguenti istruzioni:

WLAN e Bluetooth Combo (Intel) 
1. Fare clic su Option Drivers (pulsante).
2. Fare clic su 2.Install WLAN Driver > Sì. 
3. Fare clic su Avanti > Avanti.
4. Fare clic sul pulsante “Accetto i termini del contratto di 

licenza”, quindi fare clic su Avanti.
5. Fare clic su Tipica (pulsante) o Personalizzata (pulsante).
6. Fare clic su Installa > Fine.

WLAN (terze parti)
1. Fare clic su Option Drivers (pulsante).
2. Fare clic su 2.Install WLAN Driver > Sì.
3. Scegliere la lingua desiderata e fare clic su Avanti > 

Avanti > Installa.
4. Fare clic su Fine per completare l'installazione.

WLAN e Bluetooth 4.0 Combo (terze parti)
1. Fare clic su Option Drivers (pulsante).
2. Fare clic su 2.Install WLAN Driver > Sì.
3. Fare clic su Avanti.
4. Fare clic su Fine per completare l'installazione.

Connessione a una rete wireless
Il sistema operativo è l'impostazione predefinita per il
controllo LAN wireless in Windows. Accertarsi che il
modulo LAN Wireless sia acceso.

1. Fare clic sull'icona  della LAN wireless nell'area di notifica, 
quindi fare doppio clic su un Access Point per connettersi oppure 
fare clic su Apri Centro connessioni di rete e condivisione se 
nel menu della barra dell'area di notifica non è presente una rete a 
cui connettersi (appare un elenco di opzioni che consentono di 
modificare impostazioni e creare una nuova rete).

2. Può essere richiesta l'immissione di una chiave di sicurezza 
quando si cerca di connettersi a un Access Point.

3. Fare clic per selezionare una posizione di rete (ad esempio Rete 
domestica, Rete aziendale o Rete pubblica).

4. Fare clic su “Visualizza o modifica impostazioni in Centro 
connessioni di rete e condivisione” per accedere a ulteriori 
opzioni per la connessione.

5. Fare clic sull'icona  dell'area di notifica per vedere tutte le reti 
correntemente connesse.

6. Per disconnettersi dalla rete wireless è possibile fare clic sull'icona 
 della LAN wireless dell'area di notifica, scegliere la 

connessione attiva e quindi fare clic sul pulsante Disconnetti.
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Intel® Wireless Display 
Application
La Intel® Wireless Display Application (richiede il modulo
combinato Intel® Centrino WLAN/Combo), in associazione
a una scheda video compatibile (da acquistare
separatamente), consente di visualizzare il contenuto dello
schermo del notebook su un altro schermo (ad esempio una
TV in HD) senza dove utilizzare scomodi fili e cavi nella
stanza. È possibile riprodurre giochi, navigare in Internet,
visualizzare video o presentazioni di foto direttamente sulla
TV o su uno schermo esterno, senza dover utilizzare cavi
HDMI o A/V.

Prima di configurare l'applicazione Intel® WiDi sarà
necessario configurare la scheda compatibile con lo schermo
e gli altoparlanti. Collegare la scheda utilizzando un cavo
HDMI o A/V e accendere lo schermo (o nel caso degli
altoparlanti, collegarli alla scheda altoparlanti wireless
utilizzando i cavi forniti a corredo della scheda), quindi
configurare lo schermo per il canale di ingresso appropriato
(per informazioni dettagliate, consultare la documentazione
fornita a corredo con la scheda compatibile).

Intel® WiDi incorpora anche Intel® Wireless Music, che
consente di trasmettere l'audio in streaming e in modalità
wireless dal computer agli altoparlanti collegato a una
scheda altoparlanti wireless compatibile (da acquistare
separatamente).

Installazione dell'applicazione Intel® 
WiDi
1.  Fare clic su Option Drivers (pulsante).
2. Fare clic su 3.Install WiDi AP > Sì.
3. Fare clic su Avanti.
4. Fare clic sul pulsante di accettazione della licenza, quindi 

fare clic su Avanti.
5. Fare clic su Fine.

Configurazione dell'applicazione Intel® 
WiDi
1. Fare clic su Start > Tutti i programmi > Intel Corporation > 

Intel(R) Wireless Display > Intel(R) Wireless Display, oppure 
fare doppio clic sull'icona  sul desktop.

2. Fare clic su Accetto i termini di questa licenza (pulsante).

3. L'applicazione cercherà tutti gli adattatori compatibili collegati (o è 
possibile fare clic sul pulsante Ricerca adattatori disponibili per 
abilitare la tecnologia Intel My WiFi).

4. Selezionare l'adattatore rilevato con il mouse e fare clic su 
Connetti.

5. Il sistema chiede di immettere il codice di protezione di 4 cifre 
che verrà visualizzato sullo schermo TV esterno.

6. Immettere il codice dell'adattatore video e fare clic su Continua.

7. Viene richiesto di immettere un nome per l'adattatore video e fare 
clic su Continua.

8. Fare clic su Fine per completare la configurazione.
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Modulo Bluetooth (Opzione)
Assicurarsi che il modulo Bluetooth sia acceso prima di
iniziare il processo d'installazione del driver (utilizzare le
icone a schermo (OSD) per accendere il modulo Bluetooth -
vedere la pagina 119).

Installazione del driver Bluetooth
Seguire le seguenti istruzioni:

WLAN e Bluetooth Combo (Intel)
1. Fare clic su Option Drivers (pulsante).
2. Fare clic su 4.Install Combo BT Driver > Sì.
3. Fare clic su Avanti > Avanti.
4. Fare clic sul pulsante di accettazione dell’accordo di 

licenza, quindi fare clic su Avanti.
5. Fare clic su Avanti > Fine.

WLAN e Bluetooth 4.0 Combo (terze parti)
1. Fare clic su Option Drivers (pulsante).
2. Fare clic su 4.Install Combo BT Driver > Sì.
3. Fare clic su Avanti.
4. Fare clic su Fine per riavviare il computer.

Configurazione Bluetooth

Bluetooth in modo che il computer possa tro-
varlo
1. Accendere il proprio dispositivo Bluetooth (PDA, cellulare ecc.).

2. Rendere da trovare il dispositivo (per questo si veda la 
documentazione che accompagna il proprio dispositivo).

Per accendere il modulo Bluetooth
1. Utilizzare le icone a schermo (OSD) per accendere il modulo 

Bluetooth. 

2. Un'icona Bluetooth  apparirà nella barra di applicazioni.

3. Quindi è possibile effettuare una qualsiasi delle azioni seguenti 
per accedere al pannello di controllo Dispositivi Bluetooth.

• Fare doppio clic sull'icona  per accedere al pannello di con-
trollo Dispositivi Bluetooth.

• Fare clic/Fare clic con il pulsante destro del mouse sull'icona  
e selezionare un’opzione dal menu.

Guida per il Bluetooth
Scegliere Start e selezionare Guida in linea e supporto
quindi digitare Bluetooth nel riquadro Cerca. A questo
punto fare clic sull'icona della lente d'ingrandimento per
trovare altre informazioni sul trasferimento tramite
Bluetooth.
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TPM (Trusted Platform Module)
Prima di configurare le funzioni TPM è necessario
inizializzare la piattaforma di sicurezza.

Attivazione di TPM
1. Riavviare il computer.

2. Inserire Aptio Setup Utility premendo F2 durante il POST .

3. Utilizzare i tasti freccia per selezionare il menu Security.

4. Selezionare TPM Configuration e premere Invio.

5. Selezionare TPM Support e premere Invio. Selezionare Enable e 
premere Invio.

6. Selezionare TPM State, premere Invio e selezionare Enable 
(Attiva) per attivare lo stato TPM. Sarà necessario premere F4 per 
salvare le modifiche e riavviare il computer.

7. Quando il computer si riavvia, premere F2 per entrare di nuovo nel 
BIOS e passare al menu TPM Configuration.

8. Selezionare Pending TPM operation (Operazione TPN in 
attesa), premere Invio e selezionare l'opzione desiderata (se si sta 
inizializzando TPM occorre selezionare Enable Take Ownership 
(Attiva presa di proprietà)). Sarà necessario premere F4 per 
salvare le modifiche e riavviare il computer.

9. A questo punto è possibile installare il driver TPM e quindi 
inizializzare il TPM.

Installazione del driver TPM
1. Fare clic su Option Drivers (pulsante).
2. Fare clic su 5.Install TPM Driver > Sì.
3. Fare clic su Installa > Avanti .
4. Fare clic sul pulsante di accettazione dell’accordo di 

licenza, quindi fare clic su Avanti.
5. Fare clic su Avanti > Avanti > Installa.
6. Fare clic su Fine > Sì per riavviare il computer.
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Inizializzare TPM
1. Eseguire l'applicazione del TPM dalla voce Infineon Security 

Platform Solution > Gestione di Security Platform del menu 
Start > Programmi/Tutti i programmi.

2. Fare clic su Impostazioni dell’utente, e fare clic su Sì, oppure 
fare clic con il pulsante destro del mouse sull'icona dell'area di 
notifica  e scegliere Inizializzazione di Security Platform 
(oppure fare clic sul messaggio di notifica Stato Security 
Platform).

3. Il metodo Inizializzazione rapida è quello automaticamente 
selezionato (se occorre utilizzare le impostazioni avanzate fornite 
dall'amministratore di rete, selezionare Inizializzazione avanzata.

4. È necessario utilizzare un supporto rimovibile, ad esempio 
un'unità flash USB, per memorizzare le password e i dati 
(conservare il supporto in un luogo sicuro, se necessario).

5. Selezionare l'unità da utilizzare dal menu a discesa e fare clic su 
Avanti.

6. Scegliere le Unzioni di Security Platform per utilizzarle 
selezionando l'apposita casella di spunta.

7. Immettere una Password utente di base (e digitarla di nuovo per 
confermarla) e fare clic su Avanti.

8. Fare clic su Avanti per confermare le modifiche di configurazione 
apportate.

9. Il computer inizializza le impostazioni.

10. Fare clic su Fine.

11. Selezionare le schede e i pannelli di controllo per regolare le 
impostazioni.

12. Fare doppio clic sull'icona dell'area di notifica  per accedere al 
Tool di configurazione di Infineon Security Platform, oppure 
fare clic con il pulsante destro del mouse sull'icona dell'area di 
notifica  e selezionare una voce di menu.

Tool di configurazione di Infineon 
Security Platform 
Il Tool di configurazione di Infineon Security Platform
consente all'utente di gestire e controllare lo stato del TPM,
gestire le informazioni sulle password ed effettuare le
operazioni di backup e ripristino dei dati TPM. Dato che in
genere il TPM è amministrato all'interno delle
organizzazioni e delle imprese di grandi dimensioni,
l'amministratore di sistema dovrà assistere l'utente nella
gestione delle informazioni qui riportate.

Figura 15
Inizializza-

zione rapida 
GuidataSe-
curity Pla-

tform Figura 16
Tool di confi-
gurazione di 

Infineon Secu-
rity Platform
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Risoluzione dei problemi

Problema Possibile causa - Soluzione

Non è possibile rilevare i 
moduli LAN Wireless e 
Bluetooth.

I moduli sono disattivati.  Tenere premuto il pulsante del menu funzione per circa due secondi 
(vedere la Tabella 2 a pagina 118) per aprire la schermata. ?Controllare il menu a schermo OSD 
per vedere se attivato o disattivato.

Non si sente alcun suono 
da un dispositivo di 
visualizzazione collegato via 
HDMI.

L'uscita audio HDMI non è stata configurata. Vedere "Configurazione audio per HDMI" a
pagina 127.

I file video catturati dalla 
camera PC prendono troppo 
spazio sul disco.

Nota catturare file di video ad altra risoluzione molto spazio disco disponibile per ogni file.

Nota Windows richiede un minimo di 15GB di spazio disco libero sulla partizione del disco C:. Si 
consiglia di salvare la cattura del file video in un'ubicazione diversa dal disco C:, limitare la 
dimensione del file del video catturato o ridurne la risoluzione (Options/Opzioni > Video Capture 
Pin... > Dimensioni output).
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Specifiche tecniche


Ultimi aggiornamenti delle 

specifiche tecniche

Le specifiche tecniche elencate in que-
sta appendice sono corrette al momen-
to di andare in stampa. Alcuni elementi
(in particolare tipi di processore e velo-
cità) possono essere modificati o ag-
giornati causa la programmazione del
produttore. Per dettagli rivolgersi al pro-
prio centro di assistenza.

Opzioni di processore

Processore Intel® Core™ i7

i7-3770S (3,10GHz)

Cache L3 da 8MB, 22nm, DDR3-
1600MHz, TDP 65W

i7-3570S (3,10GHz)

Cache L3 da 6MB, 22nm, DDR3-
1600MHz, TDP 65W

Processore Intel® Core™ i5

i5-3550S (3,00GHz), i5-3475S (2,90GHz), 
i5-3470S (2,90GHz), i5-3450S (2,80GHz), 
i5-3570T (2,30GHz)

Cache L3 da 6MB, 22nm, DDR3-
1600MHz, TDP 65W

Processore Intel® Pentium™ 

G640 (2,80GHz)

Cache L3 da 3MB, 22nm, DDR3-
1066MHz, TDP 65W

Processore Intel® Celeron™

G540 (2,50GHz)

Cache L3 da 2MB, 22nm, DDR3-
1066MHz, TDP 65W

Logica del core

Chipset Intel(R) HM61

BIOS

AMI BIOS (SPI Flash ROM da 48Mb)

Memoria

Due prese SODIMM 204 pin, dotate di 
supporto per la memoria DDR3 1333/
1600MHz

Memoria espandibile fino a 8GB

Adattatore Video

GPU integrata Intel® 

(La GPU dipende dal processore)

Intel® HD Graphics

Frequenza dinamica (Intel Dynamic Video 
Memory Technology fino a 1,7GB)

Compatibile con MS DirectX® 10

Intel® HD Graphics 2500

Frequenza dinamica (Intel Dynamic Video 
Memory Technology fino a 1,7GB)

Compatibile con MS DirectX® 11

Intel® HD Graphics 4000

Frequenza dinamica (Intel Dynamic Video 
Memory Technology fino a 1,7GB)

Compatibile con MS DirectX® 11

LCD

21,5" (54,61cm) FHD

Periferiche di memorizzazione

(Opzione di fabbrica) Una unità di tipo 
ottico sostituibile da 12,7 mm (altezza) 
(modulo unità Super Multi/ modulo unità 
Combo Blu-Ray)

Un disco rigido SATA sostituibile da 2,5" di 
9,5 mm (altezza)

Un disco rigido SATA sostituibile da 2,5" di 
25 mm (altezza)

Audio

Interfaccia conforme HDA

2 altoparlanti incorporati

 Microfono incorporato
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Sicurezza

Password del BIOS

Slot blocco di sicurezza (tipo 
Kensington®)

TPM 1.2

Interfaccia

Quattro porte USB 2.0

Due porte USB 3.0

Una porta ingresso HDMI

Una porta uscita HDMI

Un jack uscita delle cuffie

Un jack ingresso del microfono 

Due porte seriali (COM)

Due porte PS/2

Un jack RJ-45 per LAN

Un jack di ingresso DC

Slot

Uno slot per il modulo Wireless LAN o 
modulo combo Bluetooth e Wireless 
LAN

Uno slot ExpressCard/54(34)

Lettore di schede

Módulo lector de tarjetas multi-en-1 

MMC (MultiMedia Card) / RS MMC

SD (Secure Digital) / Mini SD / SDHC/ 
SDXC

MS (Memory Stick) / MS Pro / MS Duo

Tastiera & periferica di puntamento

(Opzione di fabbrica) Tastiera e mouse 
USB RF con ricetrasmettitore

Comunicazione

Gigabit Ethernet LAN integrata

Opzione di fabbrica) Modulo di camera 
PC FHD (2,0M)

Moduli Half Mini-Card WLAN/ 
Bluetooth:

(Opzione di fabbrica) Intel® Centrino® 
Advanced-N 2230 Bluetooth 4.0 e 
Wireless LAN (802.11b/g/n)

(Opzione di fabbrica) Wireless LAN  
(802.11b/g/n) (terze parti)

(Opzione di fabbrica) Bluetooth 4.0 e 
Wireless LAN (802.11b/g/n) (terze parti)

Alimentazione

Adattatore AC/DC a pieno campo

Ingresso AC: 100-240V, 50-60Hz

Uscita DC: 19V, 6,3A (120W)

(Opzione di fabbrica) Pacco batteria 
Smart agli ioni di Litio a 6 celle, 62,16WH

Requisiti ambientali

Temperatura

In esercizio: 5°C - 35°C 

Non in esercizio: -20°C - 60°C

Umidità relativa

In esercizio: 20% - 80%

Non in esercizio: 10% - 90%

Dimensioni fisiche & peso

525 (l) x 49 (p) x 418 (a) mm (min)

Circa 7kg (con unità ottica)
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